<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface, Contents</td>
<td></td>
</tr>
<tr>
<td>Communication via Ethernet CPs in S7 Stations</td>
<td>1</td>
</tr>
<tr>
<td>Installing and Starting the Ethernet CP with STEP 7</td>
<td>2</td>
</tr>
<tr>
<td>SEND/RECEIVE interface</td>
<td>3</td>
</tr>
<tr>
<td>Configuring Communication Connections</td>
<td>4</td>
</tr>
<tr>
<td>Programmed Communication Connections</td>
<td>5</td>
</tr>
<tr>
<td>Programming FCs (Functions) and FBs for S7 Ethernet CPs</td>
<td>6</td>
</tr>
<tr>
<td>NCM S7 Diagnostics</td>
<td>7</td>
</tr>
<tr>
<td>Firmware loader</td>
<td>8</td>
</tr>
</tbody>
</table>

Appendix

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>References</td>
<td>A</td>
</tr>
<tr>
<td>Glossary</td>
<td>B</td>
</tr>
<tr>
<td>Linking to Other Systems with FETCH/WRITE</td>
<td>C</td>
</tr>
<tr>
<td>Document History</td>
<td>D</td>
</tr>
<tr>
<td>Index</td>
<td></td>
</tr>
</tbody>
</table>
Classification of Safety-Related Notices

This manual contains notices which you should observe to ensure your own personal safety, as well as to protect the product and connected equipment. These notices are highlighted in the manual by a warning triangle and are marked as follows according to the level of danger:

- **Danger**
  - indicates that death or severe personal injury will result if proper precautions are not taken.

- **Warning**
  - indicates that death or severe personal injury can result if proper precautions are not taken.

- **Caution**
  - with warning triangle indicates that minor personal injury can result if proper precautions are not taken.

- **Caution**
  - without warning triangle indicates that damage to property can result if proper precautions are not taken.

- **Notice**
  - indicates that an undesirable result or status can occur if the relevant notice is ignored.

- **Note**
  - highlights important information on the product, using the product, or part of the documentation that is of particular importance and that will be of benefit to the user.
Trademarks
SIMATIC®, SIMATIC HMI® and SIMATIC NET® are registered trademarks of SIEMENS AG.
Third parties using for their own purposes any other names in this document which refer to trademarks might infringe upon the rights of the trademark owners.

Safety Instructions Regarding your Product:
Before you use the product described here, read the safety instructions below thoroughly.

Qualified Personnel
Only **qualified personnel** should be allowed to install and work on this equipment. Qualified persons are defined as persons who are authorized to commission, to ground, and to tag circuits, equipment, and systems in accordance with established safety practices and standards.

Correct Usage of Hardware Products
Note the following

---

**Warning**
This device and its components may only be used for the applications described in the catalog or the technical description, and only in connection with devices or components from other manufacturers which have been approved or recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set up, and installed correctly, and operated and maintained as recommended.

Before you use the supplied sample programs or programs you have written yourself, make certain that no injury to persons nor damage to equipment can result in your plant or process.

EU Directive: Do not start up until you have established that the machine on which you intend to run this component complies with the directive 89/392/EEC.

Correct Usage of Software Products
Note the following

---

**Warning**
This software may only be used for the applications described in the catalog or the technical description, and only in connection with software products, devices, or components from other manufacturers which have been approved or recommended by Siemens.

Before you use the supplied sample programs or programs you have written yourself, make certain that no injury to persons nor damage to equipment can result in your plant or process.
Prior to Startup

Before putting the product into operation, note the following warning:

Caution

Prior to startup you must observe the instructions in the relevant documentation. For ordering data of the documentation please refer to the catalogs or contact your local SIEMENS representative.
This Manual on SIMATIC NET NCM S7 for Industrial Ethernet

...supports you when using the communication services provided by the SIMATIC NET communications processors (Industrial Ethernet CPs) for communication on SIMATIC NET with Industrial Ethernet in the management and cell areas.

The documentation on your S7 CPs and NCM S7 is in several parts that fit together as shown below:

- **S7-CP**
  - selecting
  - installing
  - commissioning
  - performance data

- **S7-CP and STEP 7 / NCM S7**
  - familiarization
  - testing interfaces
  - commissioning

- **Communication services with STEP 7 / NCM S7**
  - programming
  - configuring
  - downloading / commissioning
  - diagnostics
This Manual on SIMATIC NET NCM S7 for Industrial Ethernet

Audience

This manual is intended for personnel responsible for installing and programming STEP 7 programs and for service personnel.

Scope of this Manual

This manual applies to version 5.2 and higher of the NCM S7 configuration software for Industrial Ethernet and to version 5.2 and higher of the STEP 7 software.

This manual also includes specially marked passages that apply specifically to and require version 5.2 SP1 of the NCM S7 for Industrial Ethernet configuration software and version 5.2 SP1 of the STEP 7 software.

These include new functions for IP configuration:

- IP access protection
  Using IP access protection gives you the opportunity of restricting access to the local S7 station to partners with specific IP addresses.

- Configuring connections from the user program
  In some situations, it is an advantage to set up communication connections not over the configuration interface of STEP 7 but program-controlled by specific applications.
  As of STEP 7 V5.2 SP1, a function block is available for these applications that allows flexible transfer of data blocks with configuration data to an Ethernet CP.

The description of the configuration for FETCH / WRITE services has been extended.

Notice

Please note that the availability of new functions depends on the type of CP you are using. You can check which functions your module supports in the description in the Properties dialog in STEP 7 and in the catalog in HW Config.

The manual contains more detailed information /1/.
Symbols Used in this Manual

Unless indicated otherwise, the functions described in this manual assume the use of STEP 7. This symbol is used to indicate functions that require a specific version of STEP 7 or higher, for example Version V5.2.

This symbol appears in the margin to draw your attention to useful tips.

This symbol indicates recommended documentation.

Where you see this symbol, you should also refer to additional information in the basic help system of STEP 7.

This symbol indicates where detailed context-sensitive help is available. You can display these help texts with the F1 key or by clicking on the “Help” button in the relevant dialog.

Conventions

References to other manuals and documentation are indicated by numbers in slashes /.../. These numbers refer to the titles of manuals listed in the References section of the Appendix.
You will find additional information in the following sources:

This manual is also part of the NCM S7 for Industrial Ethernet documentation package. These documents are also on the Manual Collection CD supplied with every S7 CP and they are also available on the Internet. The following table provides you with an overview.

<table>
<thead>
<tr>
<th>Title</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-CPs for Industrial Ethernet Manual</td>
<td>The manual S7 CPs for Industrial Ethernet contains information on the characteristics of the CPs and instructions on installation and connections.</td>
</tr>
<tr>
<td>This is available on the Internet at:</td>
<td></td>
</tr>
<tr>
<td>- General Section:</td>
<td><a href="http://www4.ad.siemens.de/view/cs/de/8777865">http://www4.ad.siemens.de/view/cs/de/8777865</a></td>
</tr>
<tr>
<td>- CP 343-1:</td>
<td><a href="http://www4.ad.siemens.de/view/cs/de/8777308">http://www4.ad.siemens.de/view/cs/de/8777308</a></td>
</tr>
<tr>
<td>- CP 343-1 PN:</td>
<td><a href="http://www4.ad.siemens.de/view/cs/de/8776538">http://www4.ad.siemens.de/view/cs/de/8776538</a></td>
</tr>
<tr>
<td>- CP 343-1 IT:</td>
<td><a href="http://www4.ad.siemens.de/view/cs/de/8776544">http://www4.ad.siemens.de/view/cs/de/8776544</a></td>
</tr>
<tr>
<td>- CP 443-1:</td>
<td><a href="http://www4.ad.siemens.de/view/cs/de/8776219">http://www4.ad.siemens.de/view/cs/de/8776219</a></td>
</tr>
<tr>
<td>- CP 443-1 IT:</td>
<td><a href="http://www4.ad.siemens.de/view/cs/de/8776322">http://www4.ad.siemens.de/view/cs/de/8776322</a></td>
</tr>
<tr>
<td>NCM S7 for Industrial Ethernet Primer</td>
<td>Based on simple examples, the primer introduces you to the methods of connecting and networking SIMATIC S7 stations with CPs on Industrial Ethernet. It shows you how the communications calls are entered in the user program to allow you to use the services via the SEND/RECEIVE interface. You will learn how simple it is to create a configuration for standard applications using STEP 7 and the NCM S7 optional package. The examples described here can also be found in the project folder for sample programs after you have installed STEP 7 and the NCM S7 for Industrial Ethernet option!</td>
</tr>
<tr>
<td>This is available on the Internet at:</td>
<td><a href="http://www4.ad.siemens.de/view/cs/de/1172503">http://www4.ad.siemens.de/view/cs/de/1172503</a></td>
</tr>
<tr>
<td>NCM S7 for Industrial Ethernet Manual</td>
<td>The manual is intended as a guide and reference work for configuring and programming an Industrial Ethernet CP.</td>
</tr>
<tr>
<td>This is available on the Internet at:</td>
<td><a href="http://www4.ad.siemens.de/view/cs/de/1172423">http://www4.ad.siemens.de/view/cs/de/1172423</a></td>
</tr>
<tr>
<td>IT-CP Manual</td>
<td>The manual is intended as a guide and source of reference when working with the IT-CP. In addition to the functions provided by an Ethernet CP, the IT-CP also provides functions for Internet technology.</td>
</tr>
<tr>
<td>This is available on the Internet at:</td>
<td><a href="http://www4.ad.siemens.de/view/cs/de/1172744">http://www4.ad.siemens.de/view/cs/de/1172744</a></td>
</tr>
<tr>
<td>Advanced PC Configuration Commissioning PC Stations Manual</td>
<td>Advanced PC Configuration is the new tool with which you can commission a PC station as part of an industrial communication network. The manual supports you and helps you to make efficient use of communications with your PC applications in conjunction with the SIMATIC NET modules. It explains the steps involved in configuration with NCM S7.</td>
</tr>
<tr>
<td>This is available on the Internet at:</td>
<td><a href="http://www4.ad.siemens.de/view/cs/13542666">http://www4.ad.siemens.de/view/cs/13542666</a></td>
</tr>
</tbody>
</table>
Quick Start CD: Samples covering all aspects of communication
The Quick Start CD that can be ordered separately is a treasure-trove of sample programs and configurations.
You can order this directly over the Internet at:
http://www4.ad.siemens.de/view/cs/de/574211

Additional Information on SIMATIC S7 and STEP 7
The following documentation contains additional information about the STEP 7 standard software of the SIMATIC programmable controllers and can be obtained from your local Siemens office.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Document</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic information for technical personnel using the STEP 7 standard software for control tasks with S7-300/400 programmable controllers.</td>
<td>STEP 7 basics with</td>
</tr>
<tr>
<td></td>
<td>• Configuring hardware with STEP 7</td>
</tr>
<tr>
<td></td>
<td>• Programming with STEP 7</td>
</tr>
<tr>
<td></td>
<td>• Manual for converting from S5 to S7</td>
</tr>
<tr>
<td></td>
<td>• Primer for a fast start</td>
</tr>
<tr>
<td>The reference works describing the programming languages LAD/FBD and STL as well as the standard and system functions in addition to the STEP 7 basic knowledge.</td>
<td>STEP 7 reference manuals with</td>
</tr>
<tr>
<td></td>
<td>• Manuals for LAD/FBD/STL</td>
</tr>
<tr>
<td></td>
<td>• Standard and system functions for S7-300/400</td>
</tr>
</tbody>
</table>

You will also find information on SIMATIC programmable controllers on the Quick Start CD and from the Customer Support Online services at:
http://www.siemens.de/simatic-net General information
or
http://www.ad.siemens.de/csi/net Product information and downloads
Access to Online Help of STEP 7 and NCM S7

With the online help, you can obtain the following information:

- You can display the contents of the STEP 7 basic help system with the menu command **Help –> Contents**.

- Context-sensitive help on the selected object using the **Help –> Context-Sensitive Help** menu command, the F1 function key or the **question mark** in the toolbar. You can then access further information relating to the current topic.

- Glossary for all STEP 7 applications by clicking the “**Glossary**” button.

Please note that each STEP 7 application has its own contents and context-sensitive help.
Contents

1 Communication via Ethernet CPs in S7 Stations .............................................. 15
   1.1 Industrial Ethernet .................................................................................. 16
   1.2 SIMATIC S7 Communication with S7 Ethernet CPs ................................. 17
   1.3 PG/OP Communication via Industrial Ethernet ........................................ 21
       1.3.1 PG Communication with STEP 7 over Industrial Ethernet ............ 23
       1.3.2 OP Operation: Connecting Operator Interface Devices via Industrial Ethernet .................................................. 24
   1.4 S7 Communication on Industrial Ethernet ................................................. 25
   1.5 S5-compatible Communication (SEND/RECEIVE Interface) .................... 29
   1.6 FETCH/WRITE Services (Server) ............................................................ 32
   1.7 Networking Stations with STEP 7 .......................................................... 33
       1.7.1 Network/Project Variant: One Subnet – One Project ...................... 35
       1.7.2 Network/Project Variant: SIMATIC S5 and Non-SIMATIC Devices on the Subnet ........................................... 36
       1.7.3 Network/Project Variant: Two or More Subnets – One Project ....... 37
       1.7.4 Network/Project Variant: One Subnet – More Than One (Sub)Project .. 38
       1.7.5 Network/Project Variant: Several Subnets in Several (Sub) Projects ... 41
       1.7.6 Network/Project Variant: Connections between Subnets (TCP/IP) ... 43

2 Installing and Starting the Ethernet CP with STEP 7 ........................................ 45
   2.1 General Information About the NCM S7 for Industrial Ethernet Option .. 46
   2.2 Procedure ............................................................................................... 47
       2.2.1 Creating an Industrial Ethernet Subnet ........................................ 48
       2.2.2 Entering an Ethernet CP in the Hardware Configuration ............... 51
       2.2.3 Displaying the Network Attachments of a Station ....................... 55
       2.2.4 Setting Further CP Properties ....................................................... 57
       2.2.5 “Substitute Objects” in the STEP 7 Project .................................. 65
       2.2.6 Configuring Communication Services ......................................... 68
   2.3 Assigning Addresses for the First Time (Applies to Latest CPs) ............... 69
       2.3.1 Addressing by Selecting the Target System in the SIMATIC Manager ... 70
       2.3.2 Addressing using the Properties Dialog in HW Config or NetPro ....... 73
   2.4 Downloading the Configuration Data to the Target System .................... 74

3 SEND/RECEIVE Interface in the User Program ............................................. 77
   3.1 How the SEND/RECEIVE Interface Works on the CPU ....................... 78
   3.2 Programming the SEND/RECEIVE Interface ....................................... 79
   3.3 Data Exchange S7 CPU <-> Ethernet CP ............................................ 82
   3.4 Additional Information .......................................................................... 84
       3.4.1 Programming Data Transfer on TCP Connections ..................... 84
       3.4.2 Recommendations for Use with a High Communications Load ....... 85
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 Configuring Communication Connections</td>
<td>87</td>
</tr>
<tr>
<td>4.1 Procedure</td>
<td>88</td>
</tr>
<tr>
<td>4.2 Possible Connection Configurations</td>
<td>89</td>
</tr>
<tr>
<td>4.3 Connections</td>
<td>91</td>
</tr>
<tr>
<td>4.3.1 New Connection</td>
<td>94</td>
</tr>
<tr>
<td>4.3.2 Connections to Partners in Other Projects</td>
<td>96</td>
</tr>
<tr>
<td>4.3.3 Further Functions</td>
<td>99</td>
</tr>
<tr>
<td>4.3.4 Connections Without Assignment</td>
<td>100</td>
</tr>
<tr>
<td>4.4 Configuring ISO Transport Connections</td>
<td>103</td>
</tr>
<tr>
<td>4.4.1 Specifying the Local Connection Endpoint</td>
<td>104</td>
</tr>
<tr>
<td>4.4.2 Specifying ISO Transport Addresses</td>
<td>106</td>
</tr>
<tr>
<td>4.4.3 Specifying ISO Transport Dynamic Properties</td>
<td>109</td>
</tr>
<tr>
<td>4.4.4 Checking ISO Transport Connection Properties</td>
<td>111</td>
</tr>
<tr>
<td>4.5 Configuring ISO-on-TCP Connections Properties</td>
<td>112</td>
</tr>
<tr>
<td>4.5.1 Specifying the Local Connection Endpoint</td>
<td>113</td>
</tr>
<tr>
<td>4.5.2 Specifying ISO-on-TCP Addresses</td>
<td>115</td>
</tr>
<tr>
<td>4.5.3 Checking ISO-on-TCP Connection Properties</td>
<td>118</td>
</tr>
<tr>
<td>4.6 Configuring TCP Connection Properties</td>
<td>119</td>
</tr>
<tr>
<td>4.6.1 Specifying the Local Connection Endpoint</td>
<td>120</td>
</tr>
<tr>
<td>4.6.2 Specifying TCP Addresses</td>
<td>123</td>
</tr>
<tr>
<td>4.6.3 Checking TCP Connection Properties</td>
<td>126</td>
</tr>
<tr>
<td>4.7 Configuring UDP Connection Properties</td>
<td>127</td>
</tr>
<tr>
<td>4.7.1 Specifying the Local Connection Endpoint</td>
<td>128</td>
</tr>
<tr>
<td>4.7.2 Specifying UDP Addresses</td>
<td>130</td>
</tr>
<tr>
<td>4.7.3 UDP with Broadcast and Multicast</td>
<td>133</td>
</tr>
<tr>
<td>4.7.4 Checking the Properties of a UDP Connection</td>
<td>137</td>
</tr>
<tr>
<td>4.7.5 Free UDP Connection</td>
<td>138</td>
</tr>
<tr>
<td>4.8 FETCH/WRITE Mode</td>
<td>139</td>
</tr>
<tr>
<td>4.9 Routing to Distribute Load</td>
<td>143</td>
</tr>
<tr>
<td>5 Programmed Communication Connections</td>
<td>145</td>
</tr>
<tr>
<td>5.1 Overview</td>
<td>146</td>
</tr>
<tr>
<td>5.2 Procedure</td>
<td>148</td>
</tr>
<tr>
<td>5.3 Configuration Data Block</td>
<td>149</td>
</tr>
<tr>
<td>5.4 Parameter Field for System Data (CP Networking)</td>
<td>150</td>
</tr>
<tr>
<td>5.5 Parameter Fields for Connection Types</td>
<td>152</td>
</tr>
<tr>
<td>5.5.1 Parameter Field for TCP Connection</td>
<td>153</td>
</tr>
<tr>
<td>5.5.2 Parameter Field for a UDP Connection</td>
<td>154</td>
</tr>
<tr>
<td>5.5.3 Parameter Field for an ISO-on-TCP Connection</td>
<td>155</td>
</tr>
<tr>
<td>5.5.4 Parameter Field for an E-Mail Connection</td>
<td>156</td>
</tr>
<tr>
<td>5.5.5 Parameter field for FTP connection</td>
<td>158</td>
</tr>
<tr>
<td>5.6 Subfield types</td>
<td>159</td>
</tr>
</tbody>
</table>
### Contents

#### 6 Programming FCs (Functions) and FBs for S7 Ethernet CPs

- **6.1 General Notes on FCs / FBs** ........................................ 164
- **6.2 Setting Parameters for FC Calls** .................................... 167
  - **6.2.1 Parameters for CP and Connection Assignment (input parameters)** 167
  - **6.2.2 Parameters for Specifying a CPU Data Area (input parameters)** 169
  - **6.2.3 Status Information (output parameters)** ........................ 169
- **6.3 FCs for the SEND/RECEIVE Interface** ............................ 170
  - **6.3.1 FC5 AG_SEND / FC50 AG_LSEND** .............................. 174
  - **6.3.2 FC6 AG_RECV / FC60 AG_LRECV** .............................. 184
- **6.4 FCs for Access Coordination with FETCH/WRITE** ................. 191
  - **6.4.1 FC7 AG_LOCK** .................................................. 193
  - **6.4.2 FC8 AG_UNLOCK** .............................................. 195
- **6.5 FB55 IP_CONFIG for Programmed Communication Connections** .......... 197
- **6.6 Numeric Data / Resource Requirements of the FCs** ................ 203

#### 7 NCM S7 Diagnostics

- **7.1 Overview** ............................................................. 206
- **7.2 Functions of NCM S7 Diagnostics** ................................. 207
  - **7.2.1 Installing and Starting NCM S7 Diagnostics** .................. 208
  - **7.2.2 General Menu Commands** .................................... 210
- **7.3 Starting Diagnostics** .............................................. 212
  - **7.3.1 Establishing a Connection to the Ethernet CP** ............... 212
  - **7.3.2 Starting Diagnostics from the CP Properties Dialog** ........ 212
  - **7.3.3 Starting Diagnostics from the Windows Start Menu** .......... 213
  - **7.3.4 Using a Gateway** ............................................. 215
  - **7.3.5 Using the PC Station – Setting a Gateway with “PC Internal”** 217
  - **7.3.6 Other Ways of Starting Diagnostics** .......................... 218
- **7.4 How to Use Diagnostics** ........................................... 219
- **7.5 Starting Diagnostic Functions Explicitly** .......................... 220
  - **7.6 Checklist for “Typical Problems” in a System** ................... 222
    - **7.6.1 Checklist for General CP Functions** ........................ 223
    - **7.6.2 Communication Connections Checklist** ....................... 224

#### 8 Firmware Loader

- **8.1 Application** ....................................................... 226
- **8.2 Loading Firmware** ................................................ 227
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>References</td>
<td>229</td>
</tr>
<tr>
<td>B</td>
<td>Glossary</td>
<td>233</td>
</tr>
<tr>
<td></td>
<td>B.1 General Section</td>
<td>234</td>
</tr>
<tr>
<td></td>
<td>B.2 Industrial Ethernet</td>
<td>238</td>
</tr>
<tr>
<td></td>
<td>B.3 PROFinet</td>
<td>240</td>
</tr>
<tr>
<td>C</td>
<td>Linking to Other Systems with FETCH/WRITE</td>
<td>243</td>
</tr>
<tr>
<td>D</td>
<td>Document History</td>
<td>249</td>
</tr>
<tr>
<td></td>
<td>Index</td>
<td>251</td>
</tr>
</tbody>
</table>
The Ethernet CP for SIMATIC S7 provides a series of communications services for different tasks.

This chapter explains the following:

- The types of communication possible with the Ethernet CP on Industrial Ethernet
- The tasks handled by the Ethernet CP for the various services
- How to create the conditions for your communications requirements

You will find further information in the following sources:

- When installing the Ethernet CP, please refer to the instructions in the manual /1/ supplied with the Ethernet CP. This also contains further information about the performance of the Ethernet CP.
- For the functions and use of the STEP 7 configuration software, some of which is used to configure the CP (such as hardware configuration), please refer to /6/ and /8/.
- For using, structuring and handling Industrial Ethernet, you will find detailed information in /11/.
- For a general introduction to local area networks with TCP/IP refer to /16/ and /17/.
1.1 Industrial Ethernet

Definition

Within the open, heterogeneous SIMATIC NET communication system, Industrial Ethernet is the network for the management and cell level. Physically, Industrial Ethernet is an electrical network that uses a shielded coaxial cable or twisted pair, or an optical network with fiber-optic cables.

Industrial Ethernet is defined by the international standard IEEE 802.3 (see /11/).

All-Round Communication in the Industrial Sector

Industrial Ethernet is integrated in the SIMATIC NET concept that allows comprehensive networking of the management, cell and field levels in conjunction with PROFIBUS and the AS-interface (AS-i).

Network Access

Industrial Ethernet is accessed using the CSMA/CD (Carrier Sense Multiple Access with Collision Detection) network access technique specified in IEEE 802.3.
1.2 SIMATIC S7 Communication with S7 Ethernet CPs

Types of Communication

The Ethernet CP for SIMATIC S7 supports the following types of communication depending on the CP type:

<table>
<thead>
<tr>
<th>Possible types of communication</th>
<th>Interfaces / Services / Protocols</th>
</tr>
</thead>
<tbody>
<tr>
<td>• PG/OP communication</td>
<td>with the protocols</td>
</tr>
<tr>
<td>• S7 communication</td>
<td>- ISO</td>
</tr>
<tr>
<td></td>
<td>- TCP/IP (RFC 1006)</td>
</tr>
<tr>
<td>• S5-compatible communication</td>
<td>with the SEND / RECEIVE interface and the protocols</td>
</tr>
<tr>
<td></td>
<td>- ISO Transport</td>
</tr>
<tr>
<td></td>
<td>- ISO-on-TCP (TCP/IP with RFC 1006)</td>
</tr>
<tr>
<td></td>
<td>- TCP</td>
</tr>
<tr>
<td></td>
<td>- UDP</td>
</tr>
<tr>
<td></td>
<td>- E-mail</td>
</tr>
<tr>
<td></td>
<td>with FETCH / WRITE services and the protocols</td>
</tr>
<tr>
<td></td>
<td>- ISO Transport</td>
</tr>
<tr>
<td></td>
<td>- ISO-on-TCP</td>
</tr>
<tr>
<td></td>
<td>- TCP</td>
</tr>
<tr>
<td>• PROFinet communication</td>
<td>with the protocols</td>
</tr>
<tr>
<td></td>
<td>- TCP</td>
</tr>
<tr>
<td>• HTML process control with web browser</td>
<td>with the protocols</td>
</tr>
<tr>
<td></td>
<td>- HTTP / IP protocol</td>
</tr>
<tr>
<td>• File management and file access with FTP</td>
<td>with the protocols</td>
</tr>
<tr>
<td></td>
<td>- FTP / IP protocol</td>
</tr>
</tbody>
</table>

• PG/OP communication

PG/OP communication is used to download programs and configuration data, to run tests and diagnostic functions, and to control and monitor a plant from OPs.
• **S7 communication**

S7 communication forms a simple and efficient interface between SIMATIC S7 stations and PGs/PCs using communication function blocks.

• **S5-compatible communication with SEND/RECEIVE interface**

Depending on the CP type, the SEND/RECEIVE interface allows program-controlled communication on a configured connection from a SIMATIC S7 PLC to another SIMATIC S7 PLC, to a SIMATIC S5 PLC, to PCs/PGs, and to any other station.

Depending on the CP type, the following communications services are available on the SEND/RECEIVE interface:

- ISO Transport
  - optimized for top performance at the self-contained manufacturing level
- TCP/IP for internetwork communication with ISO-on-TCP connections (RFC 1006), TCP connections and UDP datagram service (including broadcast / multicast).
- Sending E-mail
  - The controller is capable of sending messages triggered by process events (refer to the IT-CP manual for details /5/).

• **S5-compatible communication with FETCH.WRITE services (server)**

The FETCH.WRITE services (server) allow direct access to the system memory areas on the SIMATIC S7 CPU from SIMATIC S5, SIMATIC PC stations, or from devices of other ranges.

Depending on the CP type, the following communications services are available for FETCH.WRITE access:

- ISO Transport
  - optimized for top performance at the self-contained manufacturing level
- TCP/IP for internetwork communication with ISO-on-TCP connections (RFC 1006), TCP connections.

• **PROFINet communication**

PROFINet is a standard of the PROFIBUS Users organization defining a heterogeneous communications and engineering model.

An S7-300 station equipped with a CP capable of PROFINet can be interconnected as a PROFINet component in SIMATIC iMap.

TCP connections are used for the PROFINet communication.

For more detailed information on PROFINet, refer to /23/.

• **HTML process control**

With an IT-CP, use the supplied functions and HTML pages to query important system data using a Web browser (you should also refer to the instructions on the IT-CP /5/).
File management and file access with FTP

The IT-CP (S7-400 / S7-300) provides additional functions for FTP services. You can use your S7 station both as an FTP client and as an FTP server (refer to the manual of the IT-CP /5/).

- S7 Station as FTP Client
  You can transfer data blocks from or to a file server.

- S7 Station as FTP Server
  Another station, for example, a PC transfers data blocks to or from the S7 station the file system on the IT-CP.

Possibilities for Communication between Device Types

The possible communication available with the types of communication listed above is shown in the following table:

<table>
<thead>
<tr>
<th>S7-300</th>
<th>S7-400</th>
<th>S5-115 to -155U/H</th>
<th>PC station</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7 communication SEND/RECEIVE PROFinet</td>
<td>S7 communication SEND/RECEIVE</td>
<td>SEND/RECEIVE FETCH.WRITE</td>
<td>PG/OP communication¹</td>
</tr>
<tr>
<td>S7 communication SEND/RECEIVE</td>
<td>S7 communication SEND/RECEIVE</td>
<td>SEND/RECEIVE FETCH.WRITE</td>
<td>S7 communication¹</td>
</tr>
<tr>
<td>S7 communication SEND/RECEIVE FTP services</td>
<td>S7 communication SEND/RECEIVE FTP services</td>
<td>SEND/RECEIVE FETCH.WRITE</td>
<td>PG/OP communication¹</td>
</tr>
</tbody>
</table>

¹) PC only as client
Configuration and Diagnostics

To connect and configure the Ethernet CP, you require the STEP 7 configuration software and the SIMATIC NET NCM S7 for Industrial Ethernet option.

NCM S7 for Industrial Ethernet is installed as a STEP 7 option and is therefore integrated in STEP 7.

NCM S7 for Industrial Ethernet also provides a wide range of diagnostic functions for the various types of communication.

When configuring PROFINet communication, you also use the engineering tool SIMATIC iMap; for detailed information on SIMATIC iMap, refer to the manual Component based Automation – Configuring Plants with SIMATIC iMap /23/.

Programmed Connections

In some situations, it is an advantage to set up communication connections not over the configuration interface of STEP 7 but program-controlled by specific applications.

As of STEP 7 V5.2 SP1, a function block is available for these applications that allows flexible transfer of data blocks with configuration data to an Ethernet CP.
1.3 PG/OP Communication via Industrial Ethernet

Application

PG/OP communication provides functions that are already integrated in every SIMATIC S7/M7/C7 device.

A distinction must be made between the following two types of function:

- **PG communication**
  
  PG communication with STEP 7 PLCs on Industrial Ethernet means the following:
  
  - You can use the complete range of functions of STEP 7 on Industrial Ethernet.
  
  - You can use programming, diagnostic, operating and monitoring functions on all modules in the SIMATIC S7 PLC via Industrial Ethernet.

- **OP Operation**
  
  PG/OP communication on Industrial Ethernet allows the operation and monitoring of all modules in a SIMATIC S7 PLC using operator interface systems (TD/OP).

The Ethernet CP acts as a “communications relay” that relays the PG/OP communication via Industrial Ethernet.
Create configuration data for every CP and download to the Ethernet CPs.

Figure 1-2 Configuration for PG/OP Operation
1.3.1 PG Communication with STEP 7 over Industrial Ethernet

Requirements for PG Communication

PG communication is possible when the following requirements are met:

- An Ethernet CP is installed in the PG or engineering station or there is a modem/ISDN interface for remote access.
- The Ethernet CP must have an address (default MAC address or set the IP address).

Networking the PG / Engineering Station

Depending on the configuration of the PG or Engineering Station, the following two situations are possible when using PG communication:

- PG / Engineering Station in the Configured Mode
  
  If you select this configuration when you commission the PG / engineering station, the interfaces of the communication modules you are using are already known. The option in “Set PG/PC Interface” is automatically set to “PC-internal”.

  Once you have downloaded this configuration to your PG / engineering station, you can exchange PG functions with the accessible nodes in the network with STEP 7 without requiring any further settings.

- PG / Engineering Station in PG Operation
  
  If your PG or engineering station is configured for this mode, you must specify the interface on the PG or engineering station explicitly with “Set PG/PC Interface”.

  Follow the steps outlined below:

  1. Open the “Set PG/PC Interface” dialog box in the Windows Control Panel.
  2. Set the PG/PC interface according to the CPs available on your PG and according to the bus attachment (interface parameter assignment used).

For more detailed information on the topic of PG operation and engineering station, refer to /4/. 
1.3.2 OP Operation: Connecting Operator Interface Devices via Industrial Ethernet

Requirements

Operation allowing operator interface functions is possible when the following conditions are met:

- The operator interface device has:
  - an Ethernet CP installed
  - SOFTNET S7 for Ind. Ethernet or S7-1613/ WIN 95, WIN NT, MS-DOS, Windows installed.
- The CPs in the S7 stations are supplied with a MAC/IP address (use the default MAC address or set an IP address).

Procedure

To be able to use S7 communication, address the required module in the SIMATIC S7 PLC on your operator interface system.

For more detailed information, refer to the description of your operator interface system.
1.4  S7 Communication on Industrial Ethernet

Application

S7 communication via Industrial Ethernet allows program-controlled communication using communication SFBs/FBs via configured S7 connections. Per job, up to 64 Kbytes of user data can be transmitted.

The Ethernet CP acts as an “S7 communication relay” by passing on the S7 functions via Industrial Ethernet (see /8/). Depending on the configuration of the Ethernet CP, data transfer is on the basis of the ISO transport or the ISO-on-TCP protocol (TCP/IP with RFC 1006).

From the perspective of the user, S7 communication is identical over PROFIBUS and Industrial Ethernet.

Nodes

Two situations can occur depending on device type and plant configuration:

- **Client and server functionality at both ends**
  
  S7 connections can be operated between the following nodes with the entire functionality of S7 communication:
  
  - between S7 stations S7-300 and S7-400;
  
  - between S7 stations and PC/PG stations with an Ethernet CP.

---

Figure 1-3  Nodes Communicating on S7 Connections over Industrial Ethernet
• Client and server functionality at one end only (S7 connections configured at one end)

In the following situations, write and read functions can be implemented with PUT / GET:

– S7 communication over router

PG/PC stations can access S7 stations if the PG/PC stations are connected to a different subnet or subnet type (PROFIBUS / Ethernet) via routers (for example, an IE/PB Link); in this case, S7 stations are servers.

S7 communication is possible over a gateway.

Figure 1-4 PC/PG station communicates over a gateway with S7 stations on an underlying PROFIBUS or Ethernet

For more detailed information on the features supported by your Ethernet CP, refer to the manual /1/. 
Configuring S7 Connections

Create S7 connections to use S7 communication for data exchange between two SIMATIC S7 stations.

For more detailed information, refer to the STEP 7 Description /6/ /8/.

Notice
S7 connections via routers are supported only within a STEP 7 project but not between partners in different STEP 7 projects of a multiproject!

Interface in the User Program of the S7 Station

You use SFBs (for S7-400) and FBs (for S7-300) in the user program.

<table>
<thead>
<tr>
<th>Block Type</th>
<th>Client</th>
<th>Server</th>
<th>Described in</th>
</tr>
</thead>
<tbody>
<tr>
<td>SFB / FB12</td>
<td>BSEND</td>
<td>x</td>
<td>–</td>
</tr>
<tr>
<td>SFB / FB13</td>
<td>BRCV</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>SFB / FB15</td>
<td>PUT</td>
<td>x</td>
<td>– 1)</td>
</tr>
<tr>
<td>SFB / FB14</td>
<td>GET</td>
<td>x</td>
<td>– 1)</td>
</tr>
<tr>
<td>SFB / FB8</td>
<td>USEND</td>
<td>x</td>
<td>–</td>
</tr>
<tr>
<td>SFB / FB9</td>
<td>URCV</td>
<td>–</td>
<td>x</td>
</tr>
<tr>
<td>SFC / FC62</td>
<td>CONTROL (S7-400) / C_CNTRL (S7-300)</td>
<td>x</td>
<td>x 2)</td>
</tr>
</tbody>
</table>

1) you do not need to configure a connection on the server
2) for S7-300

Notice
Please remember the following points regarding data consistency in your user program:

In the CPU of the S7 station, the read or written information is taken from the S7 user program into the operating system or copied from the operating system to the S7 user program in blocks of 8 or 32 bytes (depending on the firmware version).

If information in the word or double-word format is located across such boundaries, data inconsistency may arise during transmission using S7 communication!

For more detailed information, refer to the STEP 7 documentation /9/.
Notes on S7 Communication between PC/PG Station and S7 Station

Applications in a PC/PG station communicate with the S7 station over an OPC interface or SAPI-S7 interface for operator intervention, monitoring and control.

The S7 stations use the integrated communication SFBs/FBs (client and server functionality at both ends).

The following general requirements must be met by a PC/PG station for S7 communication:

- On the PC/PG:
  - an Ethernet CP installed
  - there is an interface for S7 communication installed: SOFTNET S7 for Ind. Ethernet or S7-1613/ WIN 95, WIN NT, MS-DOS, Windows.

- The CPs in the S7 stations are supplied with a MAC/IP address (use the default MAC address or set an IP address).

To use S7 communication with the SIMATIC S7 PLC from a PC, address the required CPU module in the SIMATIC S7 PLC that you want to communicate with in your PC application.

S7 Communication via Routers (one-sided Client and Server Functionality)

It is possible to reach the S7 station from an application (OPC server) of the PC/PG station that is attached to another subnet. The subnets must be connected over a router such as the IE/PB Link. An S7 station or a PC connected to both subnets can also serve as a router.

In this configuration, the S7 station can only be addressed by the PC/PG station as a communications server on S7 connections configured at one end.

The requirements for the configuration of the PC/PG station are identical to those for operation in the same subnet (see above); the CP in the PC/PG station must also have routing capability.

In this situation, configure a one-ended S7 connection to the PC/PG station in the other subnet for the PC/PG station in STEP 7 NetPro. You can then access data in the S7 station in your user program using the functions PUT (writing) and GET (reading).
1.5 **S5-compatible Communication (SEND/RECEIVE Interface)** \(^1\)

**Application**

Using the SEND/RECEIVE interface, your S7 user program has access to S5-compatible communication with configured transport connections.

Data transmission on a configured transport connection is suitable for

- the reliable transmission of related blocks of data between two Ethernet nodes using
  - TCP (see /17/\19//20/) with ISO-on-TCP connection (see /18/) or TCP connection;
  - ISO transport connection

- simple (unacknowledged) transfer of related blocks of data (datagram service) between two Ethernet nodes with UDP (User Datagram Protocol) on IP.

The SEND/RECEIVE interface is also suitable for sending E-mail (refer to the manual for the IT-CP /5/).

For TCP applications, there is an active network with IP protocol (see /20/).

**ISO Transport Connection**

ISO transport provides services for the reliable transfer of data on configured connections. Due to the segmentation of the data, large amounts of data can be transmitted.

Transmission reliability is extremely high due to automatic repetition and additional field check mechanisms. The communications partner confirms reception of data and the sender receives a return value on the SEND/RECEIVE interface.

ISO transport is operated only on Industrial Ethernet and is optimized for high-performance operation at the self-contained manufacturing level.

---

\(^1\) The previous name of the SEND/RECEIVE interface was S5S5 connections
IP (Internet Protocol)

For internetwork data transmission, the following services are available with suitable CPs such as the CP 443-1:

- ISO-on-TCP connection

ISO-on-TCP is intended for reliable, internetwork data transmission.

The ISO-on-TCP service corresponds to the TCP/IP standard (Transmission Control Protocol/Internet Protocol) with the RFC 1006 extension according to layer 4 of the ISO reference model (see /18/).

RFC 1006 extends the TCP protocol by allowing the transmission of blocks of data ("messages") assuming that both partners support RFC 1006.

Transmission reliability is extremely high due to automatic repetition and additional field check mechanisms. The communications partner confirms reception of data and the sender receives a return value on the SEND/RECEIVE interface.

- TCP connection

When using the SEND/RECEIVE interface on TCP connections, the Ethernet CP supports the socket interface (for example, Winsock.dll) to TCP/IP found on almost every system (PC or other system).

TCP is intended for reliable internetwork data transmission.

The TCP service complies with the TCP/IP standard (Transmission Control Protocol/Internet Protocol; see /18/).

- UDP connection

UDP is intended for simple internetwork data transmission without confirmation.

If the connection is suitably configured, broadcast and multicast frames can also be sent on UDP connections.

To avoid overload due to high broadcast load, the CP does not allow reception of UDP broadcasts. As an alternative, use the multicast function over a UDP connection. This allows you to register the CP as a node in a multicast group.

SEND/RECEIVE Interface

Data transfer is triggered by the user program. The interface to the user program in the SIMATIC S7 is formed by special SIMATIC S7 blocks of the type FC (functions).
Stations

The SEND/RECEIVE interface allows program-controlled communication on Industrial Ethernet between the SIMATIC S7 PLC and the following:

- SIMATIC S7 PLC with Ethernet CP
- SIMATIC S5 PLC with Ethernet CP
- PC/PG with Ethernet CP
- Other station with Industrial Ethernet attachment

Figure 1-5 SIMATIC S7 PLC with Possible Communications Partners on the SEND/RECEIVE Interface
1.6 FETCH/WRITE Services (Server)

Application

In addition to the SEND/RECEIVE interface, the FETCH/WRITE functionality provides further services for S5-compatible communication on configured transport connections.

The FETCH/WRITE interface is used primarily to attach SIMATIC S7 to SIMATIC S5 and to other non-S7 stations (for example PCs).

- **FETCH**
  The partner on the connection (SIMATIC S5 or non-S7 station) can read system data on the SIMATIC S7 PLC.

- **WRITE**
  The partner on the connection (SIMATIC S5 or non-S7 station) can write system data on the SIMATIC S7 PLC.

From the point of view of the SIMATIC S7 PLC, this is a passive communication function; the communications partner initiates the connection establishment.

For further information, refer to the system documentation of the SIMATIC S5 PLC or the non-S7 station you are using.

Connection Types

To access a station with FETCH or WRITE functions, a FETCH passive or WRITE passive connection must be configured. The following types are possible:

- ISO Transport
- ISO-on-TCP
- TCP

Coordinating Access Using the User Program

To coordinate access, you can use the FCs AG_LOCK and AG_UNLOCK.

With these FCs, you can coordinate access to system memory areas so that no inconsistent data are created and transferred.

SIMATIC S5

On the SIMATIC S5 station, the FETCH/WRITE services are configured and started by READ ACTIVE/PASSIVE and WRITE ACTIVE/PASSIVE.
1.7 Networking Stations with STEP 7

Configuring

To allow stations to communicate with each other the networks must be configured in the STEP 7 projects.

Configuring a network or subnet involves the following:

1. You create one or more subnets of the required subnet type in the project.
2. You select the properties of the subnet. Normally the default settings are adequate.
3. You connect the station “logically” to the subnet.
4. You set up connections for communication.

Networking in a Multiproject

STEP 7 as of Version V5.2 supports configuration in a multiproject.

Using a multiproject, for example, you can create a project for distributed editing by various editors and distribute the stations to the projects according to their editors.

To allow this, functions are available for branching and merging (sub) projects. Interproject subnets and connections can be created.

Tools

The SIMATIC Manager provides convenient tools for configuring and documenting networks (also graphically with NetPro).

The chapter describing network configuration in /6/ and the online help system also contain information about configuring SIMATIC S7 networks.
Variants

Before configuring networks with STEP 7, you should be aware of the various configurations possible in the STEP 7 project. The following configurations are typical for stations networked with CPs:

<table>
<thead>
<tr>
<th>Variant (examples)</th>
<th>Characteristics/Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1 subnet – 1 project</td>
</tr>
<tr>
<td>2</td>
<td>Additional SIMATIC S5 stations and stations with equipment of other vendors</td>
</tr>
<tr>
<td>3</td>
<td>2 or more subnets – 1 project</td>
</tr>
<tr>
<td>4</td>
<td>1 subnet – more than one project</td>
</tr>
<tr>
<td>5</td>
<td>More than one subnet – more than one project</td>
</tr>
<tr>
<td>6</td>
<td>Internetwork connections (TCP)</td>
</tr>
</tbody>
</table>

These variants will be used as a basis to illustrate how real configurations can be created in STEP 7 projects.
1.7.1 Network/Project Variant: One Subnet – One Project

Configuration of the System

In the simplest case, your system consists of SIMATIC S7 stations connected by one subnet, for example of the type Industrial Ethernet.

View in a STEP 7 Project

You create an Industrial Ethernet object in the STEP 7 project. Stations created in the same project refer to this object as soon as they are configured as network nodes.
1.7.2 Network/Project Variant: SIMATIC S5 and Non-SIMATIC Devices on the Subnet

Configuration of the System

In addition to SIMATIC S7 stations, SIMATIC S5 stations and non-SIMATIC devices can be included in your system.

View in a STEP 7 Project

SIMATIC S5 stations you intend to include in the communication can be selected directly. Non-SIMATIC devices must be entered in the configuration as Other stations.
1.7.3 Network/Project Variant: Two or More Subnets – One Project

Configuration of the System

Due to the different tasks of the stations or due to the extent of the system it may be necessary to operate more than one network.

View in a STEP 7 Project

You can create the subnets in one STEP 7 project and configure the stations for communication.

This representation illustrates the following:

- More than one subnet can be managed in one project.
- Each station is created once in the project.
- Each station can be assigned to more than one subnet by assigning its CPs to different subnets.
1.7.4 Network/Project Variant: One Subnet – More Than One (Sub)Project

Configuration of the System

In complex networked systems, during configuration it is sometimes more efficient to manage plant sections in different (sub) projects.

The situation can arise that communication takes place over an interproject subnet and that interproject connections must then also be created.

Example:

![Diagram of network configuration]

Organization in a Multiproject

User-friendly and consistent configuration of such communication is supported in STEP 7 as of Version V5.2 with the multiproject.

The functions for multiprojects in STEP 7 allow the following:

- Several projects can be managed in one multiproject and edited separately
- Projects can be branched and merged

Two different strategies can be distinguished in a multiproject:

- Several employees work at the same time on a multiproject in a networked environment. The projects of the multiproject are in different network folders. In this case, all connection partners are available for configuring connections.

- One employee manages the multiproject centrally. This person creates the structures for projects (when necessary locally) and contracts individual projects out for external editing. The central configuration engineer then returns these projects to the multiproject and synchronizes the interproject data with system support and where necessary executes the required interproject functions.
In this case, agreement is necessary, for example, regarding the assignment of connection names because it will be far easier when synchronizing the projects to bring connections with identical connection names together.

The topic of multiprojects is dealt with in detail in the STEP 7 basic help. Here, you will find information on the following topics:

- Requirements for interproject functions
- How to create multiprojects
- How to create a new project in a multiproject
- How to separate a project from a multiproject
- How to include projects in the multiproject
- How to synchronize projects in a multiproject
- Moving stations within a multiproject (when a station is moved from one project of a multiproject to another project of the same multiproject (for example using drag & drop), the interproject connections are retained)
- Possible problems in distributed projects and tips on how to avoid them

Possibilities for stations outside the current project

The addition of the multiproject functionality means that the following situations can arise:

- Connection to a partner in an unknown project
  
  The new multiproject functionality allows you to create a connection to a partner in an unknown project. In this case, you can specify a connection name as a reference in the properties dialog of the connection. When the projects are merged, STEP 7 then supports you with automatic synchronization of the separately configured connections.

  The connection remains unspecified until the projects have been merged and the connections synchronized. Only following this synchronization can the configuration data be downloaded to the local station without inconsistencies.

  You should therefore use this variant when you know that the projects will be merged in a multiproject.

- Specified connections with representative objects
  
  To allow you to create specified connections to stations in a different project (for example production 2) or that are not managed with STEP 7, you can configure these stations as other stations (example in the project production 1).

  This makes it possible to create consistent, fully specified configuration data and to download it to the local station.

  It is also possible to create specified connections between these stations in different, independent projects. The stations can then communicate immediately over the created connections after the configuration data have been downloaded.
Use this variant when you want to operate projects separately due to the complexity.

Stations of the type SIMATIC S5 function in just the same way as representative objects.

Merging Projects in the Multiproject:

If you have used the multiproject functions allowing you to use connections to a partner in an unknown project, STEP 7 will automatically attempt to synchronize two separately configured connections.

If you have configured projects with representative objects and want to merge these projects into a multiproject, you have the following options:

- You can leave the representative objects with the configured connections unchanged.
- You can reassign the connection partner and then delete the representative objects.
1.7.5 **Network/Project Variant: Several Subnets in Several (Sub) Projects**

**Configuration of the System**

If several network types need to be used and if these need to be managed in different projects due to the different tasks of the stations or due to the large span of the plant, stations can be created as follows:

- Using (sub) projects in the “multiproject”
- by configuring “**Other stations / SIMATIC S5**” in the other project.

---

**Organization in a Multiproject**

If you use a multiproject organization, follow the steps below to connect the S7-400/1 station to the PROFIBUS (1) subnet:

Create a subnet of the type PROFIBUS in both subprojects and merge these two subnets in NetPro.
Representative Objects for Stations Outside the Current Project

If you do not want to use the multiproject functions, you can fall back on the use of representative objects as used previously.

To be able to network the representative objects, you must once again create a subnet of the type PROFIBUS in both projects as shown in the example here.
1.7.6 Network/Project Variant: Connections between Subnets (TCP/IP)

Configuration of the System

If connections are required to stations on network structures connected by routers due to the differing tasks of the stations or the large span of the network, the stations in the other project can be reached by configuring “Other Stations”.

View in a STEP 7 Project

If the stations in the two networks are managed in the same project, the networking appears as shown below in NetPro.
Installing and Starting the Ethernet CP with STEP 7

To attach a SIMATIC station to Industrial Ethernet via the Ethernet CP, configure the CP with the NCM S7 configuration software. The chapter explains the following:

- How the CP is configured in the STEP 7 project
- How the various network configurations are managed (setting up access to other systems)
- How to control and supply the CP with data using NCM S7

You will find further information in the following sources:

- When installing the Ethernet CP, please refer to the instructions in the manual /1/ supplied with the Ethernet CP. This also contains further information about the performance of the Ethernet CP.
- For more information about the functions and applications of STEP 7 in which the NCM S7 option is integrated, please read the following topics:
  - For using the help functions, read the section Working with STEP 7 in /6/.
  - Configuring and assigning parameters to modules in /6/
  - Configuring networks in /6/. You will find this information in the online help with integrated in STEP 7 by selecting Help ▶ Contents.
- You will find examples of configurations in the Primer /3/.
2.1 General Information About the NCM S7 for Industrial Ethernet Option

Installation

Please follow the instructions in the README file when installing the NCM S7 for Industrial Ethernet option on your PG/PC under STEP 7.

Functions

NCM S7 consists of the following:

- CP-specific index dialogs that you call using the properties dialog box of the modules.
- Dialogs for the connection configuration
- Diagnostic functions that you obtain as follows:
  - Using the “Diagnostics” tab in the properties dialog
  - Using the standard Start menu of Windows with which you can call the SIMATIC program group
- Functions displayed with **SIMATIC > NCM...** in the Start menu of Windows:
  - Diagnostics
  - Help for functions (FCs)
  - “Readme” file with current information about NCM
  - Firmware loader

Operation

Operating and handling the software package is as explained in the STEP 7 user manual /6/.
2.2 Procedure

A CP is managed in an S7 project just as the other modules. You use STEP 7 to configure the hardware and create and manage the user software (see /6/).

Configuring a CP involves the following basic steps (the broken lines indicate options):

1. Create the Industrial Ethernet subnet (see 2.2.1)
2. Check or set the network properties
3. Enter the Ethernet CP in the hardware configuration (see 2.2.2)
4. Attach the Ethernet CP to the Ethernet subnet (see 2.2.2)
5. Display the network attachments of a station (see 2.2.3)
6. Make further CP settings (see 2.2.4)
7. Configure communication connections (Chap. 4)
   - S7 connections /6/
   - ISO transport connections
   - ISO-on-TCP connections
   - TCP connections
   - UDP
8. Programming the SEND/RECEIVE interface (see Chapter 3)
9. Alternative: Program communication connections (see Chapter 5)
10. Configuration data in the STEP 7 project
11. User programs in the STEP 7 project
12. Download the configuration to the PLC (see 2.4).
2.2.1 Creating an Industrial Ethernet Subnet

Aims

To be able to attach the SIMATIC stations to a subnet, you create the subnet in your project. This means that all the parameters for the entire subnet are managed centrally.

Procedure

It is advisable to create the subnet before you configure the stations since the assignment of the SIMATIC stations is then performed largely automatically.

It is also possible to create the subnet at a later point in time when configuring a CP. This is explained in more detail later in the chapter.

Follow the steps outlined below:

1. Select the project in the SIMATIC Manager.
2. Select Insert ➤ Subnet ➤ Industrial Ethernet.

Result: An object of the type network is created in the project. This allows all the SIMATIC stations created in the project to be attached to this subnet.

![Project with Assigned Ethernet Network](image-url)
3. If you prefer a NetPro graphic network display, select the network object “Ethernet” and confirm with Edit ▶ Open Object.

From this graphic representation, you can also activate all the functions for networking and configuring connections with the Ethernet CPs.

You can also create the subnets in NetPro! Open the catalog using the menu command Insert ▶ Network Objects.

Organization in a Multiproject

If you use the multiproject form of organization, this has the following effects when creating subnets.

You create subnets initially in the subprojects as described above. To be able to network S7 stations, you will, for example, need to create a suitable subnet of the type Industrial Ethernet in each subproject.

If this is physically a subnet that extends beyond the boundaries of the subproject, you should first merge the subnets before configuring the communication connections between the S7 stations.

If you do not merge the subnets, NetPro assumes that you are connecting the subnets via routers and displays warning messages to this effect.

Properties of Merged Subnets (Multiproject)

When you merge subnets, transferable subnet properties such as the subnet ID of the master subnet will be transferred to the other subnets of the group.

Some parameters relate specifically to a subproject and remain unchanged; these include, for example, descriptive parameters such as the name, author, and any comments.
Notice

Preserving Consistency in Merged Subnets

After merging the subnets, you should check the consistency throughout the multiproject using the menu command Network > Check Interproject Consistency in NetPro to make sure that there is consistency throughout the multiproject. This check detects, for example, S7 subnet IDs that are not unique within the multiproject.
2.2.2 Entering an Ethernet CP in the Hardware Configuration

Procedure

By installing and assigning the Ethernet CP in the rack of a SIMATIC station, you establish the logical attachment between the Internet CP and the subnet.

1. Select the station in your project that you want to attach to Industrial Ethernet using an Ethernet CP.

2. Select the CP in the hardware configuration just like any other module by selecting it in the hardware catalog and then selecting the slot in the rack.

You select CPs in the hardware catalog using a short text and the order number. Once you have installed NCM S7, the CPs are available in the catalog.

Result: The CP is assigned to the SIMATIC station.

For information about the permitted slots, refer to /1/.

How to configure a module with STEP is described in detail in /6/.
Subnet Attachment

To allow you to activate the network attachment of the Ethernet CP, the SIMATIC Manager displays the following dialog:
Note
You can open the dialog for setting the interface at any time from the Properties dialog of the CP in the "General" tab.

1. If you have not yet created a subnet in the project or have not yet created the selected subnet, you can now create a subnet. To do this, select the "New" button.

   **Result:** An object of the type network is created in the project.

2. Check the addresses and if necessary change them. The system enters the next free address automatically.

   You will find detailed information on the address ranges in the online help.
   Please note the following additional information:
   - **MAC address**
     The latest Ethernet CPs are supplied with a default MAC address (address printed on the module). To be sure that you have a unique address assignment, do not enter a MAC address in the configuration (the option is deactivated). This means that the module automatically uses the factory-set address. If you want to use ISO services, we recommend that you enter the address printed on the module in the configuration.

Note
The "IP address" and "Subnet mask" input fields have no significance for ISO transport (option "IP protocol being used").

3. Select the required subnet type in the "Subnet" list box.

4. You can display the properties dialog box for the selected subnet by clicking the Properties button.

5. Enter information specific to the subnet node in the "General" tab.

6. You must finally confirm your input with OK, otherwise the networking is not entered (refer to Point 3.).

**Result:** The CP is now configured as a network node for the corresponding S7 station.
Setting Addresses in the Configuration and Addressing for the First Time

The address settings described here are made on the CP only after you download the configuration data.

With the latest Ethernet CPs, the situation is as follows:

To be able to reach the CP using these addresses before you download the configuration data, you can address the CP using its default MAC address and then supply it with project-specific address information.

How to do this is described in Section 2.3.
2.2.3 Displaying the Network Attachments of a Station

Procedure

You can easily get an overview of the network attachment configurations of a SIMATIC station in one of the following ways:

- A graphic overview in NetPro;
- An overview in table form in the Properties dialog of the station

Graphic Overview in NetPro

The NetPro view provides you with a good overview of the networked stations:

Follow the steps below:

1. Double-click one of the network objects, for example Ethernet in your project in the SIMATIC Manager.

![NetPro View of a Subnet of the Type Industrial Ethernet](image)
Overview in Table Form

The table view in the Properties dialog of the station provides a detailed overview of the components used for network attachment.

Follow the steps below:

1. Using the SIMATIC Manager, select the station in your project that you want to check.

2. Select the **Object Properties** using the menu option **Edit ▶ Object Properties** or by double-clicking the station symbol.

3. Select the “Interfaces” tab.

   **Result:**

   ![Table View](image)

   **Figure 2-4** “Interface” Tab in the “SIMATIC 300/400” Properties Dialog Box

In the displayed dialog, you can see the subnet attachments that were configured for the SIMATIC station.
2.2.4 Setting Further CP Properties

Overview

In addition to the network attachment, you can also make further settings for the specific module or you can call functions.

1. Select the Ethernet CP in the hardware configuration.
2. Select Edit > Object Properties. Depending on your type of CP, the dialog includes other tabs in addition to the “General” tab described in Section 2.2.2:

<table>
<thead>
<tr>
<th>Tabs</th>
<th>Settings for</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Interface</td>
</tr>
<tr>
<td>Addresses</td>
<td>Interface parameters for the user program</td>
</tr>
<tr>
<td>Options</td>
<td>Time-of-day synchronization</td>
</tr>
<tr>
<td></td>
<td>Data transfer</td>
</tr>
<tr>
<td></td>
<td>Replace module without PG</td>
</tr>
<tr>
<td></td>
<td>Ethernet profile for fault-tolerant connections</td>
</tr>
<tr>
<td></td>
<td>Individual network settings</td>
</tr>
<tr>
<td></td>
<td>Send keepalives for connections</td>
</tr>
<tr>
<td></td>
<td>Multiplex OP connections / reserve internal CPU connection resources</td>
</tr>
<tr>
<td>Time-of-Day Synchronization</td>
<td>SIMATIC mode</td>
</tr>
<tr>
<td></td>
<td>NTP mode (NTP: Network Time Protocol)</td>
</tr>
<tr>
<td>User</td>
<td>Specify user permissions for IT functions</td>
</tr>
<tr>
<td>Symbols</td>
<td>Symbolic access to variables using IT functions</td>
</tr>
<tr>
<td>DNS parameters</td>
<td>Specify the address for the domain name server for E-mail services</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>Call NCM diagnostics (special diagnostics / module diagnostics)</td>
</tr>
<tr>
<td>Addressing</td>
<td>Select the station to initialize</td>
</tr>
<tr>
<td></td>
<td>Assign configured IP parameters</td>
</tr>
<tr>
<td>IP Access Protection</td>
<td>Edit the IP access list</td>
</tr>
<tr>
<td>IP Configuration</td>
<td>Set the IP address</td>
</tr>
</tbody>
</table>

Please read the description of the Properties dialog of the CP in the integrated help. The functions are explained in detail there.
Addresses Tab

The Addresses tab displays the address at which the module can be addressed by the user program. You require this address when calling the FCs for transport connections → see Chapter 6.

Notice

Please note the following notes on S7-300 stations:

If you selected the “Update OB1 process image cyclically” option in the CPU configuration (default), you must set the module base address of the Ethernet CP outside the process image (base addresses in the “Addresses” tab).

Example: If the size of the process image selected for the CPU is 1024 (0...1023), the address for the Ethernet CP must be set equal to or higher than 1024.

Options Tab

Depending on the CP type, you can make the following settings:

Table 2-1  Settings in the “Options” Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Meaning / Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Time-of-Day Synchronization</td>
<td>Here, you decide whether the CP passes on time-of-day frames or not. You require this function if you have several CPs in a station since only one CP (on the same network) is permitted to forward the time synchronization messages.</td>
</tr>
<tr>
<td>Note</td>
<td>The time-of-day synchronization function does not exist for all module types.</td>
</tr>
<tr>
<td>• Data transfer &gt; 240 bytes</td>
<td>With this option, you specify whether or not the CP will support jobs with a data length of more than 240 bytes (for S7-300 stations).</td>
</tr>
<tr>
<td>Notes</td>
<td>• The transfer of more than 240 bytes of data is supported by newer version CPs. Please note the information in the product information bulletin / manual of the Ethernet CP. Please note the information in Section 6.1 on the newer CP types.</td>
</tr>
<tr>
<td></td>
<td>• Remember that with this configuration on an S7-300, one connection resource (free connection for S7 functions) of the S7-300 CPU is used. CPU connection resources are also used, for example, by S7-300 CPs, in the FMS mode or by Pg. and Pos. For more detailed information about the maximum connection resources, refer to /13/ and /7/.</td>
</tr>
</tbody>
</table>
Table 2-1 Settings in the “Options” Tab, continued

<table>
<thead>
<tr>
<th>Option</th>
<th>Meaning / Effect</th>
</tr>
</thead>
</table>
| Replace Module without PG   | With this option, you can have the configuration data of the CP stored on the CPU. If you then replace CP, the configuration data for the new CP are downloaded automatically from the CPU when the CP is started up.  
If you select this option, the configuration data are stored long-term on the CPU instead of in the EPROM of the CP. Remember, however, that long-term storage on the CPU is only safe from power outages if the CPU is protected by battery backup or by using an S7 Memory Card.  
Note: If you store the configuration data on the CPU, please read the note below.  
The following functions do not modify the configuration data on the CPU:  
• Reset module memory  
• Resetting to factory settings  
• Assigning an IP address (using the target system selection in the SIMATIC Manager or the properties dialog in HW Config or NetPro)  
If you subsequently upload the configuration data from the CPU to a PG you will always object the configuration data that were previously on the CP (with parameters, connections, IP address).  
1) Note: You should only use the assign IP address function during commissioning; in other words, before downloading the configuration data. |
| Ethernet Profile for Fault-Tolerant Connections | Select this profile if you use fault-tolerant communication in your system. Fault-tolerant communication means that Industrial Ethernet is designed with redundancy and that you have configured fault-tolerant S7 connections.  
If you select the Ethernet profile for fault-tolerant connections here, the time response of the S7 connections is adapted. As a result, breakdowns of a connection are detected more quickly and the failover to redundant connections is faster.  
Note: Select the Ethernet profile for fault-tolerant connections only when you actually use fault-tolerant S7 connections. Otherwise you must expect your system to be more susceptible to problems since, for example, the number of transfer or connection establishment attempts is reduced compared with non-redundant systems. |
| Individual Network Settings | Here, you can make fixed network settings, when necessary. As default, “Automatic Setting” is selected and this setting generally guarantees problem-free communication in most situations.  
If problems occur in communication (for example, when connections are not established or when there are often disturbances on the network), the reason may be that the selected or automatic network settings are not suitable. You can then select a network setting to suit your network configuration. |
### Table 2-1  Settings in the “Options” Tab, continued

<table>
<thead>
<tr>
<th>Option</th>
<th>Meaning / Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Send Keepalives for Connections</strong></td>
<td>Here, you can set the interval at which keepalives are sent to the partner of a communications connection. This setting decides the latest time after which the failure of a communications partner is detected. For all connection-oriented services, the Ethernet CP is configured so that keepalives are sent. This guarantees that connections are closed if a communications partner fails and that the connection resources are released. The setting made here applies to all TCP and ISO-on-TCP connections operated via the CP; a connection-oriented setting is not possible. Possible values:</td>
</tr>
<tr>
<td>Default Setting:</td>
<td>30 seconds</td>
</tr>
<tr>
<td>Turn keepalives off</td>
<td>0 seconds</td>
</tr>
<tr>
<td>Maximum value:</td>
<td>65535 seconds</td>
</tr>
<tr>
<td>Notes / Recommendations:</td>
<td>Remember that the keepalive mechanism can keep underlying connections established (for example, an ISDN telephone connection) although no user data are actually being transmitted. If this is not required, set the interval so high that the underlying connection is closed down when no further user data are sent before a keepalive is sent.</td>
</tr>
</tbody>
</table>

| **Multiplex OP Connections / Reserve Internal CPU Connection Resources** | To attach TD/OPs or HMI devices, you can optimize the connection resources on the S7-300 CPU by having up to 16 of these devices communication on a single CPU connection resource (multiplex mode). If you do not use this option, the number of operable TD/OPs or HMI devices depends on the number of available connection resources of the CPU you are using. As default, this option is deactivated. This means that a CPU connection resource is used for multiplex only when necessary. Configured S7 connections over the CP use the same multiplex channel as you use for multiplexing the HMI connections. If you configure S7 connections, this means that one CPU connection resource is already used. Please note: PG connections do not use the multiplexer; if you use a PG, one connection resource is always occupied. Note on Programming: When you use the multiplex mode, you must specify the rack/slot assignment of the CP for addressing on TD/OP/HMI connections instead of the rack/slot assignment of the CPU! Applications (for example ProAgent) that require block-related messages (Alarm_S: SFC17-19) are not supported in the multiplex mode. |  |
Time-of-Day Synchronization Tab

In this tab, you can make the settings for one of the two synchronization modes explained below:

- **SIMATIC mode**
  
  If the CP receives MMS time-of-day frames, its local time is synchronized providing the NTP mode was not configured (MMS = Manufacturing Message Specification).
  
  The advantage of this mode is the accuracy that is generally higher than achieved with the NTP mode.

- **NTP mode (NTP: Network Time Protocol)**
  
  In the NTP mode, the CP sends time queries (in the client mode) at regular intervals to the NTP server in the subnet (LAN). Based on the replies from the server, the most reliable and most accurate time is calculated and the time of day on the station is synchronized.
  
  The advantage of this mode is that the time of day can be synchronized beyond the boundaries of the subnet.

Diagnostics Tab

In the “Diagnostics” tab, you can start NCM S7 Diagnostics.

See Chapter 7 Diagnostics for a description of the diagnostic functions themselves.

Addressing Tab

In the “Addressing” tab, you can assign the previously configured IP address and IP parameters to the CP.

This is necessary before the configuration data can be downloaded to the CP over Ethernet.

For a detailed description, refer to Section 2.3.
**IP Access Protection Tab**

Using IP access protection gives you the opportunity of restricting communication over the CP of the local S7 station to partners with specific IP addresses. Partners you have not authorized cannot access data of the S7 station over the CP using the IP protocol.

In this tab, you can activate or deactivate IP access protection and can enter IP addresses in an IP access control list (IP-ACL).

As default, IP access protection is deactivated.

- **IP access protection for configured connections with specified partners**

  If you want to restrict access to the precise set of partners you specify during connection configuration, you simply need to activate access protection. In this case, you do not need to enter IP addresses in list.

  Remember, however, on unspecified connections, all other IP addresses are unauthorized and are rejected.

  IP access protection relates to all connection types handled using the IP protocol (TCP, ISO-on-TCP, UDP)

- **IP access protection for partners with specific IP addresses**

  To allow IP access for specific IP addresses, enter these IP addresses in the IP access control list.

  The IP addresses you specify when you configure the connection always belong to the permitted IP addresses and do not, therefore, need to be entered explicitly in the IP-ACL.
**IP Configuration Tab**

In this tab, you can decide the route and the method with which the IP address of the local S7 station is obtained and assigned.

With the options available here, it is also possible to assign IP addresses dynamically outside the STEP 7 configuration.

### Table 2-2 Options in the “IP Configuration” Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Meaning / Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set IP address in the “Properties – Ethernet Interface” dialog</td>
<td>This option is the default. It means that the IP address is set during the networking of the Ethernet CP. The IP address of the CP is therefore <strong>fixed</strong> in the configuration. You must select this option if you want to configure specified connections.</td>
</tr>
<tr>
<td>Obtain an IP address from a DHCP server</td>
<td>If you select this option, the IP address is obtained from a DHCP server when the S7 station starts up. The DHCP server is informed of the MAC address of the CP or the client ID that you can enter here. Requirement / Restriction: If you select this option, it is initially not possible to create a fully specified connection in the STEP 7 project because the local IP address is not known. You must therefore select “unspecified” with passive connection establishment as the connection type. Please not the following: If the connections are configured over the interface in the user program, you must use the option “Set IP address in the user program” as described below. This also applied if the IP address is obtained from a DHCP server.</td>
</tr>
</tbody>
</table>
### Table 2-2  Options in the “IP Configuration” Tab, continued

<table>
<thead>
<tr>
<th>Option</th>
<th>Meaning / Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Set IP address in the user program</strong></td>
<td>With this option, you specify that the IP address is set over a user program interface (function block IP_CONFIG). This allows the IP address to be supplied dynamically during operation. In this situation, communication connections are created only over the user program interface; configuring connections using STEP 7 is not possible (relates to connections over IP: TCP, ISO-on-TCP, UDP). This setting does not preclude the IP address being obtained from a DHCP server. It is possible for the user program to instruct the module to obtain an IP address in this way. Further information: Read the section “Programmed Communication Connections” and refer to the example in the appendix of the manual.</td>
</tr>
<tr>
<td>• <strong>Set IP address using a different method</strong></td>
<td>With this option, you specify that the IP address is set by other services outside STEP 7. In this situation, configuring connections using STEP 7 is not possible (relates to connections over IP: TCP, ISO-on-TCP, UDP).</td>
</tr>
</tbody>
</table>

**Note**

You can query the IP address actually being used with NCM S7 Diagnostics.
2.2.5 “Substitute Objects” in the STEP 7 Project

Overview

Communication connections can be configured fully when the communications partners are available in the current project. For the stations on the Ethernet subnet, whose configuration data were not created in STEP 7 or whose configuration data are not managed in the currently active project, the following substitute objects can be created in the project:

- SIMATIC S5 stations
- PG/PC
- Other stations
  - for devices of other manufacturers
  - for SIMATIC S7 stations in another project (not necessary in a multiproject)

Note

Instead of creating substitute objects, you can also configure unspecified connections for connections to the stations listed above.

In the Properties dialog of these connections, you must then specify the full partner address. These partners do not appear in the NetPro plant view.
Procedure

To enter a substitute object in the project, following the steps below:

1. Select the project in the SIMATIC Manager.
2. Select the menu command **Insert ▶ Station ▶** and then as necessary **Other Station, PG/PC or SIMATIC S5**.

**Possible result:** the selected object is created in the project.

![SIMATIC Manager - PROJECT-ETHERNET - CStandard Hierarchy Of...](image)

**Figure 2-5  Project With Substitute Objects Configured**

**Attaching Non-S7 Stations to the Subnet**

The next step is to assign the substitute objects to the subnet, as follows:

1. Select the required object in the project and select **Edit ▶ Object Properties**.
2. In the Properties dialog box that is displayed select the “Interfaces” tab and click the “New” button (for example “Other Station”).

**Result:** The New Interface – Type Selection dialog box is displayed.
3. Select a subnet.

**Result:** The “Properties – Ethernet Interface” dialog is displayed. Here, you can select the subnet, connect the station to the network and set the address (MAC, IP). All the SIMATIC stations in the project can establish communication relationships to this substitute object.

The addresses (MAP/IP) configured for the substitute object here must also be set on the station using the appropriate tool, for example COM 1430.
2.2.6 Configuring Communication Services

Setting Up Connections

You must set up connections for the connection-oriented services supported by the Industrial Ethernet CP, see also the Table in Section 1.2.

- S7 connections
  see the STEP 7 user manual /6/
- ISO transport connections
  see Section 4.4
- ISO-on-TCP connections
  see Chapter 4.5.
- TCP connections
  see Section 4.6
- Connections for UDP
  see Section 4.7.
- Interconnections for PROFINet communication
  see manual Component based Automation – configuring plants with SIMATIC iMap /23/

The information in the STEP 7 user manual /6/ in the chapter “Creating Communication Connections Between Two Programmable Modules” also applies to the additional types of connection possible with the CPs.

You will find this information in the online help with integrated in STEP 7 by selecting Help » Contents. Select the topic “Configuring Connections and Data Exchange.”
2.3 Assigning Addresses for the First Time (Applies to Latest CPs)

Meaning of the Address Assignment – MAC Address and IP Address

The CP ships with a factory-set MAC address. Without further configuration, the device can only be accessed over the Ethernet port using this MAC address.

In its original state, you can already use the following functions via the CP using the ISO protocol and the factory-set MAC address:

- Download the defined configuration to the CP or CPU
- Run diagnostics on the CP or CPU

Before you can download defined configuration data to the device using an IP address, you must first assign an IP address to the CP.

Assigning the Address – Options and Recommendations

There are three ways of assigning this address in STEP 7:

- Addressing by selecting the target system in the SIMATIC Manager
  This option allows you to assign the address without having to set up a STEP 7 project. This is useful, for example, if you want to download defined configuration data you created offline to the S7 station.
  This is described in Section 2.3.1.

- Addressing using the properties dialog in HW Config or NetPro
  This option assumes that the CP was networked in STEP 7. The advantage of this method is that the IP parameters set during configuration in STEP 7 / NetPro can be used.
  In the “Addressing” tab, you assign the previously configured IP address and IP parameters to the CP.
  This is necessary before the configuration data can be downloaded to the CP over Ethernet.
  This is described in Section 2.3.2.

- Downloading configuration data using the ISO protocol
  Another option is to download configuration data with a defined IP address using the ISO protocol (see above).
Requirements

Before you can use the addressing described here, the CP must be obtainable online, which means:

- An attachment to the Ethernet LAN must already exist; there must be no routers between subnets in the path.
- The Ethernet port of your PG/PC must be accessible to STEP 7.

Notice

The options for assigning an address as described here are available only if you have a module that can be reached using the default MAC address; such modules must support the PST (Primary Setup Tool) function. Please refer to the information in the relevant manual /1/.

2.3.1 Addressing by Selecting the Target System in the SIMATIC Manager

Follow the steps below to assign the IP address the first time:

1. Open the SIMATIC Manager
2. Select the menu command PLC ▶ Assign Ethernet Address.

![Assign Ethernet Address](image-url)
3. Start a network search for available modules by selecting the “Browse...” button.

4. Select the CP with the matching MAC address from the components listed.

5. Enter the required IP parameters and assign them to the CP.

```
Assign Ethernet Address

Select station to initialize

MAC address: 08.00.06.00.00.20

Modules accessible online

Assign IP parameters

IP address: 140.90.221.1

Gateway
- Do not use router
- Use router

Subnet mask: 255.255.0.0

Address: 

Assign Address
```

Result:
The CP is now accessible on Industrial Ethernet using the IP address.

**Note**
You will find further detailed information on this procedure in the STEP 7 online help.
Alternative Procedure

You can also follow the steps outlined below in the SIMATIC Manager:

1. Use the menu command **PLC> Display Accessible Nodes** to display the nodes that you can access over Industrial Ethernet.

2. Select the required node in the list displayed.

3. Then select the menu command **PLC> Ethernet Address**.
   
   Result: The previously selected node is entered directly into the “Addressing” dialog. You cannot modify the MAC address of the node.

4. Enter the required IP parameters and assign them to the CP (see above under STEP 5.).

Result:
The CP is now accessible on Industrial Ethernet using the IP address.
2.3.2 Addressing using the Properties Dialog in HW Config or NetPro

Follow the steps below to assign the IP address the first time:

1. Open the SIMATIC Manager.
2. Define the configuration of your S7 station with the appropriate components in HW Config in an existing or newly created project.
3. When you create the CP, network it with an Industrial Ethernet subnet.

   When you create the CP in HW Config, the necessary dialog is displayed in which you can network the device and assign the IP address.
4. Select the “Addressing” tab in the properties dialog of the CP you want to address.

   The tab displayed is identical to the dialogs illustrated in Section 2.3.1.
5. Start a network search for available modules by selecting the “Browse...” button.
6. Select the CP with the matching MAC address from the components listed.
7. Assign the IP parameters taken from the networking to the CP by clicking the relevant button.

Result:
The CP is now accessible on Industrial Ethernet using the IP address.

---

Note
You will find further detailed information on this procedure in the STEP 7 online help.
2.4 Downloading the Configuration Data to the Target System

Principle
The configuration data of the Ethernet CP are downloaded from the hardware configuration. All the configuration data of the S7 station are downloaded including the central configuration, all relevant DP master systems and all parameter settings.

The data of the configured connections must also be downloaded, see below.

Type of Interface
You can download the configuration data to the S7 station on the following paths (interfaces):

- MPI interface
  You can use this interface to download configuration data or when assigning a MAC/IP address for the first time (node initialization – for details, refer to the manual /1/ “Assigning Addresses for the First Time”).

- Industrial Ethernet
  Here, you use the PG mode of the Ethernet CP in the S7 station (see also Section 1.3).

Depending on the PG/PC interface used by the station on which you create your configuration, you can download the defined configuration data to the S7 station over the TCP/IP interface or over the ISO interface of STEP 7.

- When you download over the IP interface, the CP must already have been assigned an IP address; refer to Chapter 2.3.
- When you download over the ISO interface, you can use the preset MAC address. However, please note the following:

Note
If you want to download the configuration data over the ISO interface to a CP with an unchanged, factory-set MAC address and you have configured a different MAC address in your STEP 7 project, you must start the download in NetPro or HW Config; this is the only way you will be prompted to enter the current MAC address. The SIMATIC Manager, on the other hand, aborts the download if the target station cannot be reached.
Procedure

To download the configuration data to the S7 station, follow the steps outlined below:

1. Open the “Set PG/PC Interface” dialog box in the Windows Control Panel.
2. Set the PG/PC interface according to the CPs available on your PG and according to the bus attachment (interface parameter assignment used).
   For more detailed information, refer to the integrated help system.
3. Change the CPU to the STOP mode (regardless of the type of interface – see above).
4. Select the menu command PLC ▶ Download to Module.
   STEP 7 then guides you through dialog boxes. Note the additional information in the “STEP 7 User Manual”, Chapter “Configuring and Assigning Parameters to Modules” /6/.

Deactivating the MAC Address in the Configuration

If you deactivate the use of the MAC address when you are configuring the CP, the CP can be reached via the preset MAC address, however you cannot define any ISO transport connections or S7 connections over ISO connections in your configuration.

Saving the Configuration Data in Non-Volatile Memory

You can download the configuration data step-by-step or all at once. If you download step-by-step, you will be prompted to start the download function separately for each module. You must select this method if you want to save the configuration data in non-volatile memory on the Ethernet CP. In this case, select the “Copy to ROM” button in the “Download” dialog for the CP.

Downloading the Configured Connections

To download configured connections, you use a corresponding download function in the connection configuration (NetPro).

Notice

If you have assigned a new address to the Ethernet CP or have configured connections, you must always download the connection configuration again.

Remember that you also make suitable address adaptations for the other stations or “substitute objects”.

F1
Relocating the CP in the Hardware Configuration

If you are using communication services with configured connections, the connection IDs also identify the slot of the CP. If you “drag” a CP you have already configured to a different slot, note the following:

Notice

If you drag the CP to a different slot, the data of the connection configuration are automatically updated. The data of the connection configuration must, however, be downloaded again!
SEND/RECEIVE Interface in the User Program

This chapter explains the following:

- How to send and receive data.
- Which data areas can be used on the S7 CPU.
- How to program the SEND/RECEIVE interface in the user program.

You will find further information in the following sources:

- For programming and configuring nodes for connections (for example a SIMATIC S5 PLC with the CP 1430 TCP, PC with CP 1613), please refer to the appropriate manuals.
- The FCs for programming connections are described in Section 6.3.
- Configuring the Ethernet CP with NCM S7 is described in Chapter 4.
- Programming communication connections over the interface in the user program is described in Chapter 5.

Sample programs:

Sample configurations and programs are available for the SEND/RECEIVE interface described here:

- In the sample project PROJECT_ETHERNET that you can start immediately after installing NCM S7; for a description, refer to the Primer /2/.
- On the Internet as downloadable sample projects; refer to the information in Appendix C “Support and Training”.

The Quick Start CD that can be ordered separately is a treasure-trove of sample programs and configurations.

You can order this directly over the Internet at:

http://www4.ad.siemens.de/view/cs/de/574211
3.1 How the SEND/RECEIVE Interface Works on the CPU

Functions (FCs)

The following functions (FCs) are available for handling communication on connections:

- **AG_SEND/AG_LSEND**
  This block takes the user data from the specified user data area and transfers it to the Ethernet CP.

- **AG_RECV/AG_LRECV**
  This block transfers received user data to the user data area specified in the call.

The diagram below illustrates the situation. Using the FCs AG_SEND/AG_LSEND and AG_RECV/AG_LRECV, the user program instructs the Ethernet CP to send or receive data on the configured connection.

![Diagram of CPU and Ethernet CP interaction](image)

**Figure 3-1** Interaction of the CPU and Ethernet CP on Connections

Amounts of Data

The Ethernet CP can transfer the amounts of data shown in the table below per job on one connection:

<table>
<thead>
<tr>
<th></th>
<th>ISO Transport</th>
<th>ISO-on-TCP</th>
<th>TCP</th>
<th>UDP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sending</td>
<td>8192 bytes</td>
<td>8192 bytes</td>
<td>8192 bytes</td>
<td>2048 bytes</td>
</tr>
<tr>
<td>Receiving</td>
<td>8192 bytes</td>
<td>8192 bytes</td>
<td>8192 bytes</td>
<td>2048 bytes</td>
</tr>
</tbody>
</table>
3.2 Programming the SEND/RECEIVE Interface

Principle of Job and Data Transfer
The user program triggers the transfer of the user data areas with FC calls and monitors the transfer by evaluating the return codes of the FCs.

The following parameters are transferred when the FCs are called:
- The number of the connection (ID)
- The location of the user data area in the CPU

For detailed information about the call interface see Chapter 6.

Purpose of the FCs
Calling the function blocks has the following effects:
- The user data area is transferred to the Ethernet CP or received from the Ethernet CP.
- The execution of the job is confirmed positively or negatively in a status message.

Procedure
Program the SEND/RECEIVE interface in the user program as follows:

1. Use the following functions (FCs) for data transmission on connections:
   - AG_SEND / AG_LSEND for transferring the user data area to the Ethernet CP
   - AG_RECV / AG_LRECV for entering data received from the Ethernet CP in the user data area

2. Evaluate the following bits in the FCs:
   - for AG_SEND / AG_LSEND the parameters DONE, ERROR, STATUS
   - for AG_RECV / AG_LRECV the parameters NDR, ERROR, STATUS

Notice
Connection numbers (IDs) must be taken from the configuration when programming.
To ensure correct parameter settings for the block calls, the LAD/STL/FBD editor in STEP 7 provides you with the option of accepting all the relevant parameters from the hardware configuration (HW Config) and from the connection configuration. For more information, refer to Section 6.2
Calling FCs in the CPU Program

One possible sequence for FCs in conjunction with the organization and program blocks in the CPU cycle is illustrated in the following diagram.

The following points are illustrated by the diagram:

- The user program consisting of any number of blocks (OBs, FBs or FCs — see also /6/ accesses several connections (Figure 3-2 illustrates three connections).
- At various points (event and program-controlled) the user program sends data.
on a connection using the AG_SEND call.

- At various points in the CPU cycle, the user program accepts the data received on the connection using an AG_RECV call.

**Note**

The blocks can also be called more than once in a cycle for the **same** communication connection.
3.3 Data Exchange S7 CPU <-> Ethernet CP

The Ethernet CP processes the send and receive jobs independent of the CPU cycle and requires one transmission time. The interface to the user program with the FCs is synchronized by an acknowledgment. Two situations must be distinguished:

- The CPU cycle is faster than the transmission time.
- The CPU cycle is slower than the transmission time.

Note

Please refer to the sequence charts for the FCs in Chapter 6. These charts show how to handle the SEND/RECEIVE interface in the user program for problem-free data exchange.

Remember the points below about the CPU cycle and transmission time.

FC Calls Faster than the Transmission Time

If a block is called again in the user program before data were transferred or received, the procedure is as follows on the interface of the FCs:

- AG_SEND/AG_LSEND:
  No further job is accepted until the transmission of the data on the connection has been acknowledged by the Ethernet station. During this time, the user program receives the message “job active” until the Ethernet CP can accept the next job on the same connection.

- AG_RECV/AG_LRECV:
  The job is acknowledged with the message “no data available yet” if there are no received data on the Ethernet CP. The user program receives this message in the CPU cycle until the Ethernet CP has received data again on the connection.
FC Calls Slower than the Transmission Time

If a block is called again before the data were completely transferred or received, the procedure is as follows on the interface of the FC blocks:

- **AG_SEND/AG_LSEND:**
  The job is positively acknowledged. The Ethernet CP is ready to receive a new send job (at the earliest however with the next call).

- **AG_RECV/AG_LRECV:**
  The job is acknowledged with “New Data Received” when the data have been transferred to the user program. Following this, the FC call can be repeated.

**Notice**

Remember that resource shortages can occur if the processing speeds on the sender and receiver are not the same (sender faster than receiver).

The sender receives a message from the FCs if problems occur (“No resources on the destination station”).
3.4 Additional Information

3.4.1 Programming Data Transfer on TCP Connections

Purpose of TCP Connections

TCP connections should be used above all for connections to systems of a different type if they do not support RFC1006.

For communication between devices of the SIMATIC family, you should use the more convenient ISO-on-TCP connections! The following sections explain certain special points to note.

Special Features

- **Block types (FC calls)**

  Use only the following functions (FCs) for data transmission:
  - With the S7-CPs for S7-400, you must use FCs AG_LSEND (FC 50) and AG_LRECV (FC 60) on TCP connections!
  - With the latest S7-CPs for S7-300, you also use FCs AG_SEND (FC 5) and AG_RECV (FC 6) for TCP connections.

- **Frame length**

  On the TCP connections, the protocol contains no information about the end of a message and start of a new message.

  The receiving station must therefore know how many bytes belong to a message and transfer an ANY pointer corresponding exactly to this length when FC AG_LRECV is called. (Example: if 100 bytes of data are always transferred, the ANY pointer could appear as: P#DB100.DBX 0.0 Byte 100)

  If you want to receive data with a variable length, follow the steps below:

  Include information on the length of the user data in the frame before the actual user data. Initially, you should only evaluate the length information on the receiving station. Fetch the appropriate length of user data in another receive job by specifying an ANY pointer of the required length on the FC interface for fetching the actual user data.
3.4.2 Recommendations for Use with a High Communications Load

Overview

The points below will help you to avoid overload situations on your CPU when using the Ethernet CPs.

In particular when you replace an older CP with a newer CP and are then confronted with overload problems, you should check your application for the pitfalls outlined below.

Known Problems

- The functions for sending and receiving (FC5/FC6 or FC50/60) are often called cyclically in OB1. This leads to constant communication between the CPU and CP. As a result, other types of communication such as PG functions cannot be executed or only very slowly.

- HMI systems access data of the CPU too often using S7 functions. This slows down communication generally and there may be a lack of resources when SEND/RECEIVE FCs are called cyclically in OB1.

Remedy

The recommendations below will help to avoid these situations:

- Do not call communication blocks cyclically in OB1!
  Communication should be called time-controlled in a suitable cyclic-interrupt OB. The call interval of this OB should be significantly higher than the average cycle time of your program.

- You should set a minimum cycle time that is higher than the average runtime of OB1. This frees resources for communication on the CPU. This is, for example, a remedy for existing applications when communication already takes place cyclically in OB1.

- If necessary, reduce the time taken for communication processing on the CPU by changing the parameters set for “cyclic load due to communication” in the properties dialog of the CPU.
Configuring Communication Connections

This chapter explains the following:

- The general aspects of configuring communication connections
- How to configure ISO transport connections, ISO-on-TCP and TCP connections
- How to use the connection configuration functions to specify communication partners that exchange data via UDP

You will find a description of the connection-specific properties dialogs in the following sections:

- ISO transport connections see Section 4.4
- ISO-on-TCP connections see Section 4.5
- TCP connections see Section 4.6
- UDP see Section 4.7

You will find further information in the following sources:

- For the properties of the configurable connection types, refer to Section 1.5
- There are situations in which communication connections are not set up over the configuration interface of STEP 7 but program-controlled by certain applications; see also Chapter 5.
- For the properties of the configurable connection type E-mail, refer to /5/.
- You will find information on the numbers of connections and amounts of data in Section 3.1.
- For information on configuring connections, refer to the online help of STEP 7 by selecting Help ▶ Contents.
4.1 Procedure

Initial Situation

The steps described here assume the following:

1. You have created the local S7 station and the required partner stations in your STEP 7 projects (refer to the description in Chapter 2).
2. You have clarified the other station types with which connections must be established. You create substitute objects for these station types in your STEP 7 projects.

Setting up Connections and Using Them in the User Program

The following steps are necessary to operate connections on the SIMATIC S7 PLC with the Ethernet CP:

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Programming</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create new connections.</td>
<td>Program SEND/RECEIVE</td>
</tr>
<tr>
<td>(see Section 4.3.1)</td>
<td>interface in the user program.</td>
</tr>
<tr>
<td></td>
<td>(Refer to Section 3.2 and the detailed FC description in Chapter 6).</td>
</tr>
<tr>
<td>Configure connection properties.</td>
<td>Download connection configurations and user programs to the S7 station.</td>
</tr>
<tr>
<td>(see Sections 4.4 to 4.4)</td>
<td></td>
</tr>
</tbody>
</table>

Legend: _______ necessary steps
         ———— optional steps
4.2 Possible Connection Configurations

Communication connections are possible between the communication partners shown in the diagram below.

The communication partners can be in the same project or distributed in the subprojects of a multiproject.

Connections to communication partners outside a project are configured using the STEP 7 object “Partner other project” or using substitute objects such as “Other stations” or SIMATIC S5.

Figure 4-1 Possible Connections
Organization in a Multiproject

If interproject subnets are configured, you can also configure connections over such subnets using STEP 7 V5.2. The endpoints of these connections can be located in different projects.

STEP 7 supports you both when creating interproject connections within a multiproject as well as when synchronizing connections that were configured without a multiproject context.
4.3 Connections

Characteristics of a Connection

A communication connection allows program-controlled communication between two nodes on Industrial Ethernet with the following characteristics:

- The data transfer is bi-directional, in other words, it is possible to transmit and receive on the connection simultaneously.
- Both stations have the same rights, in other words, each station can trigger the send and receive procedures in response to events.
- The address of the communication partner is specified in the configuration. Exceptions to this are:
  - free UDP connections
    Here, the address is specified at the FC interface in the user program.
  - programmed communication connections (see Chapter 5)

![Diagram](image)

Figure 4-2 Sending and Receiving via one Communication Connection

Note

The term “connection” is also used here for UDP. Reason: During configuration (just as in TCP) the communication partners are assigned to each other and therefore logically “connected”. In actual fact, with UDP there is no explicit connection establishment between communication partners.
Amounts of Data

Refer to the manual /1/ supplied with the Ethernet CP for the number of communication connections supported by the Ethernet CP. The number of connections per station can be increased by adding more CPs.

The Ethernet CP can transfer the amounts of data shown in the table below per job on one connection:

<table>
<thead>
<tr>
<th>Task</th>
<th>ISO Transport</th>
<th>ISO-on-TCP</th>
<th>TCP</th>
<th>UDP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sending</td>
<td>8192 bytes</td>
<td>8192 bytes</td>
<td>8192 bytes</td>
<td>2048 bytes</td>
</tr>
<tr>
<td>Receiving</td>
<td>8192 bytes</td>
<td>8192 bytes</td>
<td>8192 bytes</td>
<td>2048 bytes</td>
</tr>
</tbody>
</table>

**Notice**

The transfer of more than 240 bytes of data is supported by newer version CPs. Please note the information in Section 6 and in the manual of the Ethernet CP.

Tasks of the Ethernet CP

When handling the data transfer on a connection, the Ethernet CP has the following tasks:

- When receiving
  
  Receiving data from Ethernet and transferring it to the user data area on the CPU.

- When sending
  
  Taking data from the user data area on the CPU and sending the data via Ethernet.

The connection is established automatically as soon as the partner is obtainable.

For a free UDP connection, the following functions are also necessary in addition to those above:

- When receiving
  
  Entry of the sender of the message in the job header.

- When sending
  
  Evaluation of the job header and addressing the partner.
Requirements for Configuring Connections

The Ethernet CP was entered in the hardware configuration and connected to the subnet.

As a bus node, the Ethernet CP has an address.

Notice

All stations not in the STEP 7 project must be configured with substitute objects (for example as “SIMATIC S5” or “Other stations”).

or

Use the “unspecified” partner type when you create the connection.
4.3.1 New Connection

Principle

When you create new connections, you start from entered and networked stations. A connection is then configured starting from a station or CPU in the current S7 project and then selecting a destination station.

Due to the networking, the node addresses (MAC or IP addresses) of the two stations are already decided. The local/remote TSAPs (Transport Service Access Point) or ports at both ends of the connection are automatically assigned default values.

If the partner station is a station outside the current project or a non-S7 station, the remote TSAPs (Transport Service Access Point) or ports must be specified in the Properties dialog of the connection.

The endpoint of the connection to a SIMATIC S7 station is always a CPU. A separate connection table is created for each CPU and displays the connection partner and types of connections.

Creating a New Connection

To configure a new connection, the stations and their CPs must be configured and networked in the S7 project. To create a new connection, follow the steps below:

In NetPro, follow the steps below:

1. In NetPro, select the station or the CPU in the station from which you want to establish the connection.

2. Select the menu command Insert ▶ New Connections (also available with the right mouse button!)

Result: The following dialog appears on the screen.
3. Select the partner station to which you want to establish a connection (if several CPUs exist, please select the required CPU).

4. Select the connection type you want to use (for example ISO transport connection) in the “Type” box.

When you confirm your input with **Apply**, the new connection is created and the “New Connection” dialog box remains open. This allows you to create further connections without needing to reopen the dialog box. The connection table is updated at the same time.

When you click **OK**, the connection is entered in the list, the dialog is terminated and the display in the main dialog is updated.

If you click **Cancel**, the dialog is terminated and the connection is not entered in the list.
Handling Connections in a Multiproject

Interproject connections to a specified partner (for example, a CPU) are created in the same way as connections within a project (identical procedure). The dialog for selecting the connection partner has been extended and allows you not only to select the endpoint (module) but also the project within a multiproject to which the endpoint belongs.

The consistency of interproject connections is retained when you work with the projects of the multiproject:

- Interproject connections within a multiproject are implicitly broken when a project is taken out of the multiproject for distributed editing and the connection partner is located in the removed project.
- When the removed project is returned to the multiproject, STEP 7 automatically merges the broken connections consistently.

Connections to Non-S7 Stations using Substitute Objects

If you want to configure connections to devices or stations that are not S7 stations, select a station of the type “SIMATIC S5”, “PC/PG” or “Other Station” as the destination station.

By creating these stations in NetPro and networking them, you have already specified the node addresses (MAC or IP addresses) of the two stations. You must specify the TSAP (Transport Service Access Point) for the destination station.

**Notice**

Connections to non-S7 stations (for example SIMATIC S5) are generated as incompletely specified connections; in other words, the remote TSAP or port is empty. These connections must be specified in the Properties dialog.

4.3.2 Connections to Partners in Other Projects

There are various ways of creating connections to partners configured in other STEP 7 projects or with other tools outside the current STEP 7 project:

- Connections using substitute objects such as “SIMATIC S5”, “PC/PG”, “SIMATIC PC Station” or “Other Station”.
  
  This method is described in the section above.

- Unspecified connections

- STEP 7 object “Partner in other project” (multiproject)

  With this method, a connection is reserved in both subprojects that can be synchronized later by the system when the partner project is included in the multiproject.
In both projects, the same connection name must be configured in the properties of the connection. The connection name is used as a textual reference when the projects are merged. Based on the connection name it is possible to assign the connection partner and synchronize the connection properties.

Before the projects are merged, such connections are "unspecified connections" in terms of addressing; in other words, the partner addresses remain empty.

**Unspecified Connections**

Connections to an as yet unknown device (for example a diagnostic unit) are configured as “unspecified” connections. They can be specified later in the Properties dialog.

You can create an unspecified connection simply by selecting station “unspecified” for the connection partner when you create the connection. The unspecified connection can be used in three ways (explained below based on the example of an ISO-on-TCP connection (ISO transport and TCP connections are analogous):

- **Declare readiness for communication – passive connection establishment**
  
  The connection establishment is then set to passive (see settings in the General tab).
  
  The address setting for the ISO-on-TCP connection is then as follows: The remote IP address and the remote TSAP are empty, in other words, they are not relevant for the CP. When the connection is established, any partner is accepted (partner = connection name that addresses the CP with the correct IP address and TSAP).

  It is also possible to use a partial specification; in other words, communication is permitted with any partner that matches the specified TSAP.

- **Connection to a specific station in any project**

  The address setting for the ISO-on-TCP connection is then as follows: You can specify the remote IP address and the port of any destination station. The destination station can be in the current STEP 7 project or in another project.

  Use this method if you have not created a substitute object for the partner station, for example SIMATIC S5, in the current project.

- **IP Address Assignment over DHCP**

  If you select the option to obtain the IP address from a DHCP server, it is initially not possible to create a fully specified connection in the STEP 7 project because the local IP address is not known. You must therefore select "unspecified" with passive connection establishment as the connection type.
The following table lists the possible options.

Table 4-2

<table>
<thead>
<tr>
<th>Meaning for Connection Establishment</th>
<th>IP Address / MAC Address</th>
<th>TSAP / Port</th>
<th>Possible Connection Establishment</th>
</tr>
</thead>
<tbody>
<tr>
<td>by any partner</td>
<td>empty</td>
<td>empty</td>
<td>passive</td>
</tr>
<tr>
<td>by any partner via specific TSAP</td>
<td>empty</td>
<td>specified</td>
<td>passive</td>
</tr>
<tr>
<td>to or by a specific partner</td>
<td>specified</td>
<td>specified</td>
<td>active / passive</td>
</tr>
</tbody>
</table>

The free UDP connection is another variant. With this type of connection, the address of the connection partner is left open during configuration. The communication nodes are identified by address information in the communication job in the user program.

For further information, refer to the sections dealing with specific connections.

Notice

The number of connections possible per Ethernet CP can be found in the manual /1/supplied with the CP. If several CPs are installed in one station, the next CP is automatically selected if the limit is exceeded. The connections can be routed in the Properties dialog of the connection.
4.3.3 Further Functions

Toolbar

In the toolbar of the connection configuration dialog the following functions are available:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>To save the configured connection, select the Save function or click the save button.</td>
</tr>
<tr>
<td>Print</td>
<td>You can print the entire connection table or individual sections of it by selecting the Print function or clicking the print button.</td>
</tr>
<tr>
<td></td>
<td>The following print options are available:</td>
</tr>
<tr>
<td></td>
<td>• Overview of all connections (complete connection table)</td>
</tr>
<tr>
<td></td>
<td>• Overview of the selected connections (selected area)</td>
</tr>
<tr>
<td></td>
<td>• Detailed printout of all connections (details of all connections)</td>
</tr>
<tr>
<td></td>
<td>• Detailed printout of the selected connections (details of the selected area)</td>
</tr>
<tr>
<td>Change Connection Partners</td>
<td>You assign a new partner station to the selected connection.</td>
</tr>
<tr>
<td></td>
<td>Important! Remember that this also changes the partner ID on connections of the SEND/RECEIVE interface. You may need to adapt your user program.</td>
</tr>
<tr>
<td>Insert Connection</td>
<td>You create a new entry in the connection table.</td>
</tr>
<tr>
<td>Download</td>
<td>You download the connection table to the PLC. For more detailed information call up the integrated help function.</td>
</tr>
<tr>
<td>Help</td>
<td>If you require help or more information, select the Help function or click the help button. The help button provides you with context-related help. Using the help function you call a help dialog familiar from other Windows applications.</td>
</tr>
</tbody>
</table>

Print Function in the “Overview” Tab

An additional function for printing the configured connections and configuration status is available in the “Overview” tab of the properties dialog of the connection.
4.3.4 Connections Without Assignment

Overview

This section explains the actions that can lead to a configured connection losing its assignment to the CP or being deleted.

Caution

Remember that in contrast to the S7 connections, the connections of the SEND/RECEIVE interface are assigned a CP-dependent ID. The actions below may require the ID to be modified so that the interface information in the user program must also be adapted.

Notice

If you replace one CP with another, this must provide at least the same services and have at least the same version. This is the only way to ensure that the connections configured over the CP remain consistent and can be used.

Table 4-3 Actions That Can Cause Changes to Configured Connections

<table>
<thead>
<tr>
<th>Action</th>
<th>Consequences for the Connections</th>
<th>How to Establish the Connection Again</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CP (module) is moved to a different location in the hardware</td>
<td>The connections are retained. The connection IDs are automatically updated.</td>
<td>1. Adapt the module start address LADDR in the user program.</td>
</tr>
<tr>
<td>configuration (drag and drop)</td>
<td></td>
<td>2. Download the connection configuration to the CP again.</td>
</tr>
<tr>
<td>The CP (module) is deleted in the hardware configuration. You receive</td>
<td>The connections remain without assignment to a CP in the connection table. In the “Overview” tab</td>
<td>Once you have placed a CP in the hardware configuration and networked it:</td>
</tr>
<tr>
<td>the message “CP has n connections; the assignment will be lost in the</td>
<td>of the Properties dialog, the connections are identified with “!”.</td>
<td>1. Assign the CP in the connection properties dialog in the “Addresses” tab.</td>
</tr>
<tr>
<td>connection table”</td>
<td></td>
<td>or Reassign the connection using the menu option Edit ▶ Connection Partner....</td>
</tr>
<tr>
<td>Deleting the SIMATIC S7 station.</td>
<td>All the connections to this station are deleted within the project. Note:</td>
<td>2. Adapt the connection ID in the user program.</td>
</tr>
<tr>
<td></td>
<td>The does not apply to connections to a partner that uses a router.</td>
<td>3. Download the connection configuration to the CP again.</td>
</tr>
</tbody>
</table>

Reconfigure the station and connections.
<table>
<thead>
<tr>
<th>Action</th>
<th>Consequences for the Connections</th>
<th>How to Establish the Connection Again</th>
</tr>
</thead>
</table>
| Deleting a remote station.         | The connections of the stations in the project to remote stations remain **without assignment** in the connection table. In the “Overview” tab of the Properties dialog, the connections are identified with “!”.
Note:
The does not apply to connections if a router is used. | Reassign a remote station (or even a local station) using the menu option **Edit ▶️ Connection Partner...** |
| Changing the subnet assignment of the CP. | The connections that were assigned via the CP remain without an assignment in the connection table. In the “Overview” tab of the Properties dialog, the connections are identified with “!”.
Note: | Reassign the connections using the menu option **Edit ▶️ Connection Partner...** or in the “Addresses” tab of the properties dialog for the connection. |
Display (Example)

The status of connections is displayed in the “Properties ISO Transport Connection” dialog in the “Overview” tab.

![Figure 4-4 Status of the Connections in the “Overview” Tab (Example of ISO Transport Connections)]
4.4 Configuring ISO Transport Connections

Introduction
When you create a connection in the New dialog, you specify the connection type and, as far as possible, the connection partner.

When necessary, you can adapt other connection partners that are set as default when you create a new connection as described below.

Opening the Dialog
To call the dialog for special connection properties, follow the steps outlined below:

1. Select the required connection in the connection table.
2. Select the menu option Edit ▶ Object Properties

Result: The “Properties ISO Transport Connection” dialog appears.

Tabs
The following tabs are available for ISO transport connections:

- **General**
  Displays parameters that identify the connection.

- **Addresses**
  Displays the local and remote address information.

- **Dynamics**
  Displays the relevant timers and counters.

- **Options**
  Here, you can decide whether or not you want to use the connection for one of the access types FETCH or WRITE.

- **Overview**
  This is an overview of all the configured ISO transport connections of the selected station with their parameters and the status of the connection.

- **Status Information**
  This tab displays the current status information for the connection (valid at the time the dialog is opened). This information corresponds to the NCM Diagnostics display and is only available when the station can be reached online.
4.4.1 Specifying the Local Connection Endpoint

General Tab

This tab of the Properties dialog displays general connection parameters that identify the local connection endpoint.

![Properties Dialog for the "General" Tab (ISO Transport Connections)](image)

Figure 4-5 Layout of the Properties Dialog for the "General" Tab (ISO Transport Connections)
<table>
<thead>
<tr>
<th>Attributes</th>
<th>Description</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Local Endpoint</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID</td>
<td>The entry is identical to the Local ID parameter in the connection table.</td>
<td>Selectable</td>
</tr>
<tr>
<td>Name</td>
<td>When you create the connection, a name is proposed here for the connection endpoint along with a connection number as suffix. With unspecified connections, use this box to identify the partner.</td>
<td>Modifiable</td>
</tr>
</tbody>
</table>
| Via CP                             | If the station contains more than one CP of the same type connected to the same subnet, you can select the connection route.  
  -> “Route” button see Section 4.9.  
  If no CP is assigned (for example because the CP was previously deleted) “none” is displayed here.                                         | Display only |
| Active Connection Establishment    | With this option, you specify whether the connection is established by this S7 station. This is the default setting when the address of the partner is specified.  
  **ON**: the connection is established actively.  
  **OFF**: the connection is established by the partner.  
  If you selected partner “unspecified” when you created the connection, the option is deselected as default.  
  If you activate the option, you must also specify the address of the partner in the “Addresses” tab.  
  **Note**:  
  Please note the effects on the mode. If you want to use the FETCH or WRITE mode (refer to the “Options” tab), the mode must be set to “Passive” for the S7 station. | Modifiable |
| **Block Parameters**               |                                                                                                                                                                                                              |         |
| ID                                 | This value must be entered as a block call parameter ID for calling the FC in the user program to identify the connection. The ID changes if the local ID is changed.                                          | Display only |
| LADDR                              | This value must be entered as a block call parameter ID for calling the FC in the user program to identify the connection.                                                                                     | Display only |

**Connection Name (Reference) – Only in Multiproject**

If you create a connection to a partner in another project that has not yet been merged with the current multiproject, you must specify a connection name as a reference (not to be confused with the name of the connection endpoint described above). Interproject connections can then be joined up based on this reference. As soon as the connections have been joined, the connection name (reference) is no longer relevant and is no longer displayed.
### 4.4.2 Specifying ISO Transport Addresses

#### Address Parameters

An ISO transport connection is specified by the local and remote connection endpoint.

- **Local addresses:**
  - Local MAC address and local TSAP (Transport Service Access Point)
- **Remote addresses:**
  - Remote MAC address and remote TSAP

![Diagram of ISO Transport Connection](image)

**Figure 4-6** Sending and Receiving on One ISO Transport Connection

---

**Notice**

The TSAPs of an ISO transport connection must match as follows:

- Remote TSAP (on Ethernet CP) = local TSAP (in destination station);
- Local TSAP (on Ethernet CP) = remote TSAP (in destination station);
Addresses Tab

The addresses tab displays proposed values for the relevant local and remote address information. When connecting to non-S7 stations, you can set the TSAP addresses individually.

![Properties - ISO Transport Connection](image)

**Figure 4-7** Layout of the “Addresses” Tab of the Properties Dialog with Default TSAPs

TSAP Format

ISO transport connections have a TSAP length of 1 to 16 bytes. When you are entering values, the current length is displayed automatically (visible display: 16 ASCII characters). Local and remote TSAPs can be input as hexadecimal values or as ASCII strings. If you make your entries in ASCII, the characters you enter are also displayed in hexadecimal format. If you make your entries in hexadecimal, printable characters are displayed in ASCII (8 hexadecimal values are visible). If you enter nonprintable characters, the ASCII display is gray (no further ASCII entries possible) and the nonprintable characters are displayed as periods.

Local and Remote TSAPs

Remote and local TSAPs can be identical since the connection is uniquely identified by the different MAC addresses. If you require more than one connection between two stations, the TSAPs must also be different.
Default TSAPs

When configuring the local and remote TSAPs, there is a default value “ISO-1” for the first connection between the two partners (can be changed). For a new connection between the two partners, the default value “ISO-2” is proposed. With a new connection to a new partner, the value ISO-1 is used again.

Addresses Tab – Unspecified ISO transport connection

If you select the partner type as “unspecified”, depending on your task, you can enter address information about the communication partner here. The options available to you are explained in detail in Section 4.3.1.

The Addresses tab shown here illustrates the situation in which the MAC address and the remote TSAP were not specified. If you do not make any further settings, this means that you are willing to accept a connection establishment request from any communication partner.
4.4.3 Specifying ISO Transport Dynamic Properties

Dynamics Tab

The Dynamics tab displays the relevant timers and counters of this connection. You can normally accept these default values.

If necessary, for example with connections to non-Simatic systems, you can set the timers and counters individually and influence the dynamic response of the connection.

![Properties - ISO Transport Connection](image)

Figure 4-9 Layout of the “Dynamics” Tab of the Properties Dialog

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Description</th>
<th>Access</th>
</tr>
</thead>
</table>
| Connection Establishment | The retransmission time specifies the interval after which an unsuccessful connection establishment attempt can be triggered again (1–60 s, default 5 s)  
– if connection establishment is active  
– if connection establishment is passive (→ irrelevant) | Modifiable |
| Retransmission Time |                                                                                                                                                                                                             |          |
| Data Transfer       | This parameter specifies the interval after which an unsuccessful transmission attempt can be triggered again (100–30000 ms, default 1000 ms).                                                               | Modifiable |
Configuring Communication Connections

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Description</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max. CMax. Count</td>
<td>The number of attempted transmissions including the first (1–100, default 5).</td>
<td>Modifiable</td>
</tr>
<tr>
<td>Inactivity Time</td>
<td>The inactivity time specifies the interval after which the connection is terminated if no sign of life is received from the partner (6–180 s, default 30 s).</td>
<td>Modifiable</td>
</tr>
<tr>
<td>Window Time</td>
<td>The window time specifies the interval at which sign of life frames are sent. For SIMATIC NET CPs, the window time is set to 1/3 of the inactivity time (2–60 s, default 10 s). Sign of life frames are sent to check the connection when there is no data traffic.</td>
<td>Display only</td>
</tr>
</tbody>
</table>

**Notice**

Window Time and Inactivity Time

The partner responds to a sign of life frame with a frame. They are therefore sent to the partner at the intervals of the window time. To avoid unwanted connection termination, the inactivity time should be at least three times as long as the window time.
4.4.4 Checking ISO Transport Connection Properties

Overview Tab

The Overview tab displays all previously configured ISO transport connections and their parameters for this station (information only).

For an example of this display, refer to Section 4.3.4.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local ID</td>
<td>S7 Station: This is the connection ID of the ISO transport connection; PC Station: Identification number for the connection.</td>
</tr>
<tr>
<td>Name</td>
<td>Name entered for the connection endpoint.</td>
</tr>
<tr>
<td>CPU / Applications</td>
<td>If you display all the ISO transport connections being operated in this station in the multiprocessor mode (with PC stations: multiple applications), the CPU/application that is the endpoint of the particular connection is specified here.</td>
</tr>
<tr>
<td>R/S or via CP</td>
<td>With S7-CPs: Rack/slot of the local CP via which the connection is established. With PC stations: Display of the CP over which the connection is maintained.</td>
</tr>
<tr>
<td>Remote address</td>
<td>Specifies the remote MAC address of the connection on the Ethernet subnet.</td>
</tr>
<tr>
<td>Local TSAP</td>
<td>Transport Service Access Point for the local connection endpoint.</td>
</tr>
<tr>
<td>Partner TSAP</td>
<td>Transport Service Access Point for the remote connection endpoint.</td>
</tr>
<tr>
<td>Mode</td>
<td>Displays the mode configured in the “Options” tab.</td>
</tr>
<tr>
<td>Status</td>
<td>Indicates the current configuration of the connection. “Connections without assignment” are indicated by “No local CP/No remote CP” in the status column and a “!” character at the end of the “Local ID” (for example: 0002 A000!). Connections you are currently editing are also indicated by “!” at the end of the local ID.</td>
</tr>
</tbody>
</table>

You can set the column widths in the “Overview” tab individually.

Connection Overview with Multiple CPUs in an S7 Station

If you operate more than one CPU in your S7 station, you can click the button to extend the overview to the connections on all CPUs.
4.5 Configuring ISO-on-TCP Connections Properties

Introduction

When you create a connection in the New dialog, you specify the connection type and, as far as possible, the connection partner.

When necessary, you can adapt other connection partners that are set as default when you create a new connection as described below.

Opening the Dialog

To call the dialog for special connection properties, follow the steps outlined below:

1. Select the required connection in the connection table.
2. Select the menu option Edit ▶ Object Properties

Result: The “Properties ISO-on-TCP Connection” dialog appears.

Tabs

The following tabs are available for ISO-on-TCP connections:

- **General**
  Displays parameters that identify the connection.

- **Addresses**
  Displays the local and remote address information.

- **Options**
  Here, you can decide whether or not you want to use the connection for one of the access types FETCH or WRITE.

- **Overview**
  This is an overview of all the configured ISO-on-TCP connections of the selected S7 station with their parameters and the status of the connection.

- **Status Information**
  This tab displays the current status information for the connection (valid at the time the dialog is opened). This information corresponds to that displayed by NCM diagnostics.
4.5.1 Specifying the Local Connection Endpoint

General Tab

This tab of the Properties dialog displays general connection parameters that identify the local connection endpoint.

![Figure 4-10 Layout of the “General” Tab in the Properties Dialog for ISO-on-TCP Connections](image-url)
### Configuring Communication Connections

#### Local Endpoint

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>The entry is identical to the Local ID parameter in the connection table.</td>
<td>Selectable</td>
</tr>
<tr>
<td>Name</td>
<td>When you create the connection, a name is proposed here along with a connection number as suffix. With unspecified connections, use this box to identify the partner.</td>
<td>Modifiable</td>
</tr>
</tbody>
</table>
| Via CP                | If the station contains more than one CP of the same type connected to the same subnet, you can select the connection route.  
  → “Route” button see Section 4.9.  
  If no CP is assigned (for example because the CP has been deleted) “none” is displayed here.                                                   | Display only  |
| Active Connection     | With this option, you specify whether the connection is established by this S7 station. This is the default setting when the address of the partner is specified.  
  ON: the connection is established actively.  
  OFF: the connection is established by the partner.  
  If you selected partner “unspecified” when you created the connection, the option is deselected as default. If you activate the option, you must also specify the address of the partner in the “Addresses” tab.  
  Note:  
  Please note the effects on the mode. If you want to use the FETCH or WRITE mode (refer to the “Options” tab), the mode must be set to “Passive” for the S7 station. | Modifiable    |
| Block Parameters      |                                                                                                                                                                                                             |               |
| ID                    | This value must be entered as a block call parameter ID for calling the FC in the user program to identify the connection.  
  The ID changes if the local ID is changed.                                                                                                         | Display only  |
| LADDR                 | This value must be entered as a block call parameter ID for calling the FC in the user program to identify the connection.                                                                                 | Display only  |

#### Connection Name (Reference) – Only in Multiproject

If you create a connection to a partner in another project, that has not yet been merged with the current multiproject, you must enter a connection name as reference. Interproject connections can then be joined up based on this reference. As soon as the connections have been brought together, the connection name (reference) can no longer be entered.
### 4.5.2 Specifying ISO-on-TCP Addresses

**Address Parameters**

A connection is specified by the local and remote connection endpoint.

- **Local addresses:**
  - Local IP address and local TSAP
  - (Transport Service Access Point)

- **Remote addresses:**
  - Remote IP address and remote TSAP

![Diagram of ISO-on-TCP Connection](image)

**Figure 4-11** Sending and Receiving on One ISO-on-TCP Connection

The address parameters are configured with NCM S7 and saved in the CP database. Modifications and extensions to the Industrial Ethernet network topology do not therefore have any effect on the CPU user program.

---

**Notice**

When you configure the Ethernet CP and the Ethernet destination station, the TSAPs of an ISO-on-TCP connection must cross match:

- Remote TSAP (in Ethernet CP) = local TSAP (in destination station)
- Local TSAP (in Ethernet CP) = remote TSAP (in destination station)
Addresses Tab

The addresses tab displays proposed values for the relevant local and remote address information. If necessary, you can set the TSAP addresses individually.

![Figure 4-12 Layout of the “Addresses” Tab of the Properties Dialog with Default TSAPs for ISO-on-TCP Connections](image)

**TSAP Format**

ISO-on-TCP connections have a TSAP length of 1 to 16 bytes. When you are entering values, the current length is displayed automatically (visible display: 16 ASCII characters). Local and remote TSAPs can be input as hexadecimal values or as ASCII strings. If you make your entries in ASCII, the characters you enter are also displayed in hexadecimal format. If you make your entries in hexadecimal, printable characters are displayed in ASCII (8 hexadecimal values are visible). If you enter nonprintable characters, the ASCII display is gray (no further ASCII entries possible) and the nonprintable characters are displayed as periods.

**Local and Remote TSAPs**

Remote and local TSAPs can be identical since the connection is uniquely identified by the different MAC addresses. If you require more than one connection between two stations, the TSAPs must also be different.
Default TSAPs

When configuring the local and remote TSAPs, there is a default value “TCP-1” for the first connection between the two partners (can be changed). For a new connection between the two partners, the default value “TCP-2” is proposed. With a new connection to a new partner, the value TCP-1 is used again.

Addresses Tab – Unspecified ISO-on-TCP Connection

If you select the partner type as “unspecified”, depending on your task, you can enter address information about the communication partner here. The options available to you are explained in detail in Section 4.3.1.

The Addresses tab shown here illustrates the situation in which the remote IP address and the remote TSAP were not specified. If you make no further entries, you are accepting connection establishment from any communication partner.

![Properties - ISO-on-TCP Connection](image)

Figure 4-13  Layout of the “Addresses” Tab of the Properties Dialog for an Unspecified Connection
4.5.3 Checking ISO-on-TCP Connection Properties

Overview Tab

The overview shows all the configured ISO-on-TCP connections and their parameters (cannot be modified here).
You can adjust the width of the columns in the table.

For an example of this display, refer to Section 4.3.4 (the ISO transport connection).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local ID</td>
<td>This is the connection ID of the ISO-on-TCP connection (STEP 7 connection configuration; DWORD)</td>
</tr>
<tr>
<td>Name (loc. endpoint)</td>
<td>Entered connection name. This identifies the ISO-on-TCP connection.</td>
</tr>
<tr>
<td>CPU / Applications</td>
<td>If you display all the ISO transport connections being operated in this station in the multiprocessor mode (with PC stations: multiple applications), the CPU/application that is the endpoint of the particular connection is specified here.</td>
</tr>
<tr>
<td>R/S or via CP</td>
<td>With S7-CPs: Rack/slot of the local CP via which the connection is established. With PC stations: Display of the CP over which the connection is maintained.</td>
</tr>
<tr>
<td>Partner address</td>
<td>Specifies the remote IP address of the connection.</td>
</tr>
<tr>
<td>Local TSAP</td>
<td>Local Transport Service Access Point (8 characters default)</td>
</tr>
<tr>
<td>Remote TSAP</td>
<td>Remote transport service access point (8 characters default).</td>
</tr>
<tr>
<td>Mode</td>
<td>Indicates the current configuration of the connection. “Connections without assignment” are indicated by “No local CP/No remote CP” in the status column and a “!” character at the end of the “Local ID” (for example: 0002 A000!). Connections you are currently editing are also indicated by “!” at the end of the local ID.</td>
</tr>
<tr>
<td>Status</td>
<td>Displays the mode configured in the “Options” tab.</td>
</tr>
</tbody>
</table>

Connection Overview with Multiple CPUs in an S7 Station

If you operate more than one CPU in your S7 station, you can click the button to extend the overview to the connections on all CPUs.
4.6 Configuring TCP Connection Properties

Introduction

When you create a connection in the New dialog, you specify the connection type and, as far as possible, the connection partner.

When necessary, you can adapt other connection partners that are set as default when you create a new connection as described below.

Opening the Dialog

To call the dialog for special connection properties, follow the steps outlined below:

1. Select the required connection in the connection table.
2. Select the menu option **Edit > Object Properties**

**Result:** The “Properties – TCP Connection” dialog appears.

Tabs

The following tabs are available for TCP connections:

- **General**
  Displays parameters that identify the connection.

- **Addresses**
  Displays the local and remote address information.

- **Options**
  Here, you can decide whether or not you want to use the connection for one of the access types FETCH or WRITE.

- **Overview**
  This is an overview of all the configured TCP connections of the selected S7 station with their parameters and the status of the connection.

- **Status Information**
  This tab displays the current status information for the connection (valid at the time the dialog is opened). This information corresponds to that displayed by NCM diagnostics.
4.6.1 **Specifying the Local Connection Endpoint**

**General Tab**

This tab of the Properties dialog displays general connection parameters that identify the local connection endpoint.

![General Tab](image)

Figure 4-14  Layout of the “General” Tab in the Properties Dialog for TCP Connections
### Configuring Communication Connections

#### Attributes

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Description</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Local Endpoint</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID</td>
<td>The entry is identical to the Local ID parameter in the connection table.</td>
<td>Selectable</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>When you create the connection, a name is proposed here along with a connection number as suffix. With unspecified connections, use this box to identify the partner.</td>
<td>Modifiable</td>
</tr>
<tr>
<td><strong>Via CP</strong></td>
<td>If the station contains more than one CP of the same type connected to the same subnet, you can select the connection route —&gt; “Route”, see Section 4.9. If no CP is assigned (for example because the CP has been deleted) “none” is displayed here.</td>
<td>Display only</td>
</tr>
<tr>
<td><strong>Active Connection Establishment</strong></td>
<td>With this option, you specify whether the connection is established by this S7 station. This is the default setting when the address of the partner is specified. If you selected partner “unspecified” when you created the connection, the option is deselected as default. If you activate the option, you must also specify the address of the partner in the “Addresses” tab. ON: the connection is established actively. OFF: the connection is established by the partner.</td>
<td>Modifiable</td>
</tr>
<tr>
<td><strong>Use for FTP protocol</strong></td>
<td>Selecting the option has the following effects:</td>
<td>Modifiable</td>
</tr>
<tr>
<td></td>
<td>• The TCP connection is now used as an FTP connection.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• “Addresses” tab: The addresses are specified automatically (Port=21)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• “Options” tab: The mode is set permanently to FTP.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The “Active connection establishment” option is irrelevant and cannot be set.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Configuration limits: see /1/ Precondition: The option can only be selected for an unspecified TCP connection.</td>
<td></td>
</tr>
<tr>
<td><strong>Block Parameters</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID</td>
<td>This value must be entered as a block call parameter ID for calling the FC in the user program to identify the connection. The ID changes if the local ID is changed.</td>
<td>Display only</td>
</tr>
<tr>
<td>LADDR</td>
<td>This value must be entered as a block call parameter ID for calling the FC in the user program to identify the connection.</td>
<td>Display only</td>
</tr>
</tbody>
</table>
Connection Name (Reference) – Only in Multiproject

If you create a connection to a partner in another project, that has not yet been merged with the current multiproject, you must enter a connection name as reference. Interproject connections can then be joined up based on this reference. As soon as the connections have been brought together, the connection name (reference) can no longer be entered.
4.6.2 Specifying TCP Addresses

Address Parameters and Connection Types

With TCP, the communication partners are addressed by the local and remote endpoints as follows:

- Local addresses:
  - Local IP address and local port
- Remote addresses:
  - Remote IP address and remote port

![Diagram showing sending and receiving on one TCP connection](image)

Depending on the required connection type, the remote address parameters are either specified or left open during configuration.

- Specified TCP connection
  - You specified a destination station when you created the connection.
- Unspecified TCP connection
  - You entered “unspecified” for the connection partner when you created the connection.
Addresses Tab – Specified TCP Connection

The addresses tab displays proposed values for the relevant local and remote address information. You can change the port settings individually.

![Properties - TCP Connection](image)

**Figure 4-16** Layout of the Properties Dialog in the “Addresses” tab with DEFAULT Ports for TCP Connections

Ports

The ports or port addresses define the access point to the user program within the station / CPU. They must be unique within the station / CPU!

The following table shows the range of values:

<table>
<thead>
<tr>
<th>Application / Note</th>
<th>Port Addresses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed, must not be used!</td>
<td>0</td>
</tr>
<tr>
<td>Assigned as default, should not be used (well-known ports)</td>
<td>1 to 1024</td>
</tr>
<tr>
<td>Range used by NCM in which a free port address is searched for and assigned.</td>
<td>from 2000 to 5000</td>
</tr>
<tr>
<td>You can set any port address within this range.</td>
<td></td>
</tr>
<tr>
<td>Port addresses higher than 5000 are used by the system!</td>
<td>from 5000...65535</td>
</tr>
<tr>
<td>Note: If you want to use these port addresses, please contact your system administrator.</td>
<td></td>
</tr>
</tbody>
</table>
Addresses Tab – Unspecified TCP Connection

If you select the partner type as “unspecified”, depending on your task, you can enter address information about the communication partner here. The options available to you are explained in detail in Section 4.3.1.

The Addresses tab shown here illustrates the situation in which the remote port but not the IP address was specified. If you make no further entries, you are accepting connection establishment with any communication partner that uses the specified port.

Figure 4-17
4.6.3 Checking TCP Connection Properties

Overview Tab

The overview shows all the previously configured TCP connections and their parameters (cannot be modified here).
You can adjust the width of the columns in the table.

For an example of this display, refer to Section 4.3.4 (the ISO transport connection).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>This is the connection ID of the TCP connection (STEP 7 connection configuration; DWORD).</td>
</tr>
<tr>
<td>Name (loc. endpoint)</td>
<td>Entered connection name. It identifies the TCP connection (8 character double width).</td>
</tr>
<tr>
<td>CPU / Applications</td>
<td>If you display all the ISO transport connections being operated in this station in the multiprocessor mode (with PC stations: multiple applications), the CPU/application that is the endpoint of the particular connection is specified here.</td>
</tr>
<tr>
<td>R/S or via CP</td>
<td>With S7-CPs: Rack/slot of the local CP via which the connection is established. With PC stations: Display of the CP over which the connection is maintained.</td>
</tr>
<tr>
<td>Partner address</td>
<td>Specifies the remote IP address of the connection.</td>
</tr>
<tr>
<td>Local port</td>
<td>Local port (8 characters default length)</td>
</tr>
<tr>
<td>Remote port</td>
<td>Remote port (8 characters default width)</td>
</tr>
<tr>
<td>Mode</td>
<td>Displays the mode configured in the &quot;Options&quot; tab.</td>
</tr>
<tr>
<td>Status</td>
<td>Indicates the current configuration of the connection.</td>
</tr>
<tr>
<td></td>
<td>&quot;Connections without assignment&quot; are indicated by &quot;No local CP/No remote CP&quot; in the status column and a “!” character at the end of the &quot;Local ID&quot; (for example: 0002 A000!). Connections you are currently editing are also indicated by “!” at the end of the local ID.</td>
</tr>
</tbody>
</table>

Connection Overview with Multiple CPUs in an S7 Station

If you operate more than one CPU in your S7 station, you can click the button to extend the overview to the connections on all CPUs.
4.7 Configuring UDP Connection Properties

Introduction
When you create a connection in the New dialog, you specify the connection type and, as far as possible, the connection partner.
When necessary, you can adapt other connection partners that are set as default when you create a new connection as described below.

Opening the Dialog
To call the dialog for special connection properties, follow the steps outlined below:
1. Select the required connection in the connection table.
2. Select the menu option Edit ▶ Object Properties
Result The “Properties – UDP Connections” dialog appears.

Tabs
The following tabs are available for UDP connections:

- **General**
  Displays parameters that identify the connection.

- **Addresses**
  Displays the local and remote address information.

- **Overview**
  Overview of all configured UDP connections of the selected S7 station with corresponding parameters and the status of the connection.

- **Status Information**
  This tab displays the current status information for the connection (valid at the time the dialog is opened). This information corresponds to that displayed by NCM diagnostics.
4.7.1 Specifying the Local Connection Endpoint

General Tab

This tab of the Properties dialog displays general connection parameters that identify the local connection endpoint.

![Properties - UDP Connection](image)

Figure 4-18 Layout of the “General” Tab in the Properties Dialog for UDP Connections
Attributes | Description | Access
--- | --- | ---
Local Endpoint | | |
ID | The entry is identical to the Local ID parameter in the connection table. | Selectable
Name | When you create the connection, a name is proposed here along with a connection number as suffix. With unspecified connections, use this box to identify the partner. | Modifiable
Via CP | If the station contains more than one CP of the same type connected to the same subnet, you can select the connection route → “Route”, see Section 4.9. If no CP is assigned (for example because the CP has been deleted) “none” is displayed here. | Display only
Block Parameters | | |
ID | This value must be entered as a block call parameter ID for calling the FC in the user program to identify the connection. The ID changes if the local ID is changed. | Display only
LADDR | This value must be entered as a block call parameter ID for calling the FC in the user program to identify the connection. | Display only

Connection Name (Reference) – Only in Multiproject

If you create a connection to a partner in another project, that has not yet been merged with the current multiproject, you must enter a connection name as reference. Interproject connections can then be joined up based on this reference. As soon as the connections have been brought together, the connection name (reference) can no longer be entered.
4.7.2 Specifying UDP Addresses

Address Parameters and Connection Types

With UDP, the communication partners are addressed using the local and remote endpoint, as follows.

- **Local addresses:**
  - Local IP address and local port

- **Remote addresses:**
  - Remote IP address and remote port

**Note**

The term “connection” is also used here for UDP. Reason:
During configuration (just as in TCP) the communication partners are assigned to each other and therefore logically “connected”. In actual fact, with UDP there is no explicit connection establishment between communication partners.

![UDP connection diagram](image)

**Figure 4-19** Sending and Receiving on One UDP Connection

Depending on the required connection type, the remote address parameters are either specified or left open during configuration.

- **Specified UDP connection**
  - You specified a destination station when you created the connection.
  - Configuring broadcast or multicast provides you with a further option (see Section 4.7.3 below).

- **Unspecified UDP connection**
  - You entered “unspecified” for the connection partner when you created the connection.
Addresses Tab – Specified UDP Connections

The addresses tab displays proposed values for the relevant local and remote address information. You can make the settings for the ports individually.

![Properties - UDP Connection](image)

**Figure 4-20** Layout of the Properties Dialog in the “Addresses” tab with DEFAULT Ports for UDP Connections

Ports

The ports or port addresses define the access point to the user program within the station / CPU. They must be unique within the station / CPU!

The following table shows the range of values:

<table>
<thead>
<tr>
<th>Application / Note</th>
<th>Port Addresses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed, must not be used!</td>
<td>0</td>
</tr>
<tr>
<td>Assigned as default, should not be used (well-known ports)</td>
<td>1 to 1024</td>
</tr>
<tr>
<td>Range used by NCM in which a free port address is searched for and assigned.</td>
<td>2000... onwards</td>
</tr>
</tbody>
</table>
Addresses Tab – Unspecified UDP Connection

An unspecified UDP connection can be used in two ways:

- **Free UDP Connection**
  
  To configure a free UDP connection, select the “Address assignment in block” check box. The input boxes for the remote IP address and the remote port are then deactivated since the destination addresses are now specified by the user program.

- **Connection to a remote station in a different project**
  
  You can specify the remote IP address and the port for any destination station. The destination station can be in the current STEP 7 project or in another project.

  Please note:
  Since no connection is actually established with UDP (datagram service), communication on the configured UDP connection is only possible when the partner addresses (IP address and port) are specified.

![](image)

Figure 4-21 Layout of the Properties Dialog in the “Addresses” Tab for the “Free UDP Connection” Mode
4.7.3 UDP with Broadcast and Multicast

Application

When you select the connection partner, you have the following two extra options on UDP connections:

- Connection to all Broadcast Nodes
  - If you select the “all broadcast nodes”, you specify that UDP frames are sent to all obtainable broadcast nodes.

Notice

When using broadcast, you can only send with S7-CPs; reception is not possible (see below)!

- Connection to all Multicast Nodes
  - If you select “all multicast nodes” as the partner, you specify that UDP frames are sent to all nodes of a multicast group and that multicast frames can be received.

  Multicast is a special, configurable connection option that is supported by Industrial Ethernet CPs only on UDP connections.

The frames are sent without acknowledgment because the UDP protocol has no provision for acknowledgments. This is designed to avoid floods of data resulting from the acknowledgments. If, for example, frames are sent to 100 partners, 100 acknowledgments (1 per partner) will arrive at the same time. The sending module would not be able to evaluate such a flurry of data.

When to Use Multicast instead of Broadcast?

To allow the simultaneous transmission of a frame to a number of partners, the connection option Multicast for UDP connections was introduced.

In contrast to the broadcast connection option, it is also possible to receive frames sent to several nodes in the multicast circle on this connection type.

By specifying a particular group of recipients (multicast circle), load on recipients for which the message is not intended is prevented. Multicast therefore represents a better solution than broadcast when frames are sent to groups of partner stations.
Why Does an S7-CP Prevent Reception on Broadcast Connections?

It is often necessary for one station to send frames to a number of partner stations. It is important that the frames are sent at the same time and arrive and practically the same time. Sending and receiving broadcast frames is always required. A broadcast message is received by all nodes in the network.

A typical application is the sending of broadcast frames to find a MAC address for an IP address (ARP request).

For this reason, a communications module must accept broadcast frames and evaluate them in its software. The major disadvantage of this is that network performance sinks significantly if there are too many broadcast frames because each individual module needs to process all the broadcast frames to find out whether the frames were intended for it.

To avoid these disadvantages, S7-CPs handle broadcast as follows:

- Following reception, the broadcast frames are filtered out with high priority by all Ethernet CPs. This means that frames that cannot be interpreted are discarded immediately. Only frames that can be interpreted, for example an ARP request, are passed on over the LAN controller and evaluated. This prevents a negative influence on the other connections by broadcast frames.

- For the application, this means that the S7-CP cannot receive broadcast frames intended for the transfer of user data. It is, however, possible for the module to send broadcast frames within the network.
Addresses Tab – Connection to all Broadcast Nodes

If you select “all broadcast nodes” as the connection partner, you specify that UDP frames are sent to all obtainable broadcast nodes.

In the “Addresses” tab, a valid broadcast address in the network is proposed for the partner under the IP address (IP).

You must enter a PORT address suitable for all partners you want to reach under PORT.

![Properties - UDP connection screenshot](image)

Figure 4-22 Layout of the Properties Dialog “Addresses” Tab for the “Broadcast” Mode
Addresses Tab – Connection to all Multicast Nodes

By selecting “all multicast nodes” as the connection partner, you specify that

- sent UDP frames are delivered to all multicast nodes of the multicast group;
- the local device receives multicast frames in the specified multicast group.

In the “Addresses” tab, a valid multicast address in the network is proposed for the partner under the IP address (IP). When using multicast, the partner is always a group of receivers (multicast group).

You must enter a PORT address suitable for all partners you want to reach under PORT.

IP addresses from 224.0.0.0 to 239.255.255.255 can be used for IP multicast.

Since the IP addresses up to 224.0.0.255 are reserved for special purposes, we recommend that you use IP addresses starting at 224.0.1.0 (default) for IP multicast.
4.7.4 Checking the Properties of a UDP Connection

Overview Tab

At the overview level, all the configured UDP connections and their parameters in this station are displayed (cannot be modified). You can adjust the width of the columns in the table.

For an example of this display, refer to Section 4.3.4 (the ISO transport connection).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local ID</td>
<td>This is the connection ID of the UDP connection (STEP 7 connection configuration; DWORD).</td>
</tr>
<tr>
<td>Name (loc. endpoint)</td>
<td>Entered connection name. This identifies the UDP connection (8 characters default length).</td>
</tr>
<tr>
<td>CPU / Applications</td>
<td>If you display all the ISO transport connections being operated in this station in the multiprocessor mode (with PC stations: multiple applications), the CPU/application that is the endpoint of the particular connection is specified here.</td>
</tr>
<tr>
<td>R/S</td>
<td>Rack/slot of the local CP via which the connection is established.</td>
</tr>
<tr>
<td>Partner address</td>
<td>Specifies the remote IP address of the connection.</td>
</tr>
<tr>
<td>Local port</td>
<td>Local port (8 characters default length)</td>
</tr>
<tr>
<td>Remote port</td>
<td>Remote port (8 characters default width)</td>
</tr>
<tr>
<td>Status</td>
<td>Indicates the current configuration of the connection.</td>
</tr>
<tr>
<td></td>
<td>&quot;Connections without assignment&quot; are indicated by &quot;No local CP/No remote CP&quot; in the status column and a &quot;!&quot; character at the end of the&quot;Local ID&quot; (for example: 0002 A000!).</td>
</tr>
<tr>
<td></td>
<td>Connections you are currently editing are also indicated by &quot;!&quot; at the end of the local ID.</td>
</tr>
</tbody>
</table>

Connection Overview with Multiple CPUs in an S7 Station

If you operate more than one CPU in your S7 station, you can click the button to extend the overview to the connections on all CPUs.
4.7.5 Free UDP Connection

Program-Controlled Addressing

A free UDP connection allows program-controlled addressing of the communication partner. Communication between two nodes on Industrial Ethernet has the following properties:

- Data transfer is bi-directional; in other words it is possible to send and receive on the UDP connection at the same time.
- The local node is specified in the configuration. The remote node is entered in the job header of the job buffer by the user program when it calls AG_SEND. This allows any node on Ethernet/LAN/WAN to be reached.
- The IP address and the port of the sender can be read from the job header of AG_RECV.

Amounts of Data

Refer to the manual /1/ supplied with the Ethernet CP for the number of UDP connections supported by the Ethernet CP. The number of connections per station can be increased by adding more CPs.

Up to 2042 bytes of user data can be transferred per job buffer. The job header uses an additional 6 bytes.
4.8 FETCH/WRITE Mode

FETCH/WRITE

The FETCH/WRITE services allow direct access to the system memory areas on the SIMATIC S7 CPU from SIMATIC S5, SIMATIC PC stations, or from devices of other ranges.

- FETCH: Read data directly
- WRITE: Write data directly

Connection Types

The FETCH/WRITE services can be configured and used in SIMATIC S7 on the following connection types:

- ISO transport connections
- ISO-on-TCP connections
- TCP connections

Configuration

Depending on the station type, the following modes can be configured for the connection endpoint:

- SIMATIC S7 Station: FETCH PASSIVE / WRITE PASSIVE

  If you select the FETCH PASSIVE or WRITE PASSIVE mode for the ISO transport connection, you can access the system areas on a SIMATIC S7 PLC from a SIMATIC S5 station or other non-S7 station (unspecified connection).
The connection can then only be used for this mode; sending or receiving with the FCs AG_SEND/AG_LSEND or AG_RECV/AG_LRECV is then no longer possible.

The connection is established passively; in other words, only the partner station (SIMATIC S5 station, a PC station, or a non-SIMATIC station) can establish the connection. The setting is made automatically in the “General” tab and cannot be changed.

**Notice**

Remember that with this configuration on an S7-300, one connection resource (free connection for S7 functions) of the S7-300 CPU is used. CPU connection resources are also used, for example, by S7-300 CPs, in the FMS mode or by PGs and OPs. For more detailed information about the maximum connection resources, refer to /13/ and /7/.

- **SIMATIC PC Station: FETCH ACTIVE / WRITE ACTIVE**

If you select the FETCH ACTIVE or WRITE ACTIVE mode for the ISO transport connection, you can access the system areas on a SIMATIC S7 PLC or a SIMATIC S5 station from the PC station.

The connection establishment is active; in other words, the partner station must wait for connection establishment (passive connection establishment on the partner).
“S7 Addressing Mode” Option

When you configure the FETCH ACTIVE / WRITE ACTIVE modes, you can select the addressing mode. This specifies how the addresses will be interpreted in the FETCH/WRITE call in the SIMATIC S7 station:

- S7 addressing mode: byte address
- S5 addressing mode: word address

This makes it possible for applications to access S5 or S7 stations without needing to adapt the addresses. This is particularly interesting for existing S5 applications than can be used unchanged to access S7 stations.

As default, the addressing mode for access to SIMATIC S7 is set (option selected).

System Memory

You can access the following address areas in the system memory on the SIMATIC S7 PLC using FETCH or WRITE:

- Data blocks (DB)
  (When accessing DBs, remember that the highest DB number is 255.)
- Bit memory (M, MB, MW, MD)
- Process image input table (I, IB, IW, ID)
- Process image output table (Q, QB, QW, QD)
- I/O area inputs (PIW, PID, PIB)
- I/O area outputs (PQW, PQD, PQB)
- Counters (C)
- Timers (T)

Links to Other Systems

The FETCH and WRITE modes supported on ISO transport connections and ISO-on-TCP or TCP connections can be used with any other device to access the S7 system memory areas.

To be able to use this type of access, for example for PC applications, you need to know the PDU structure of the jobs. The required S7 or S5 headers for request and response frames are 16 bytes long and their structure is described in the Appendix.
Messages in the Diagnostic Buffer

As a result of FETCH/WRITE access, negative acknowledgments from the S7 CPU are possible. This then leads to corresponding connection-oriented entries in the diagnostic buffer that you can read out with NCM Diagnostics (see Section 7.5).
4.9 Routing to Distribute Load

Routing to Distribute Load

If more than one CP of the same type exists in a station and is connected to the same subnet, the route can be selected.

Click the “Route” button in the “General” tab to display the route dialog:

![Route dialog image]

If you have configured a load distribution on two or more Ethernet CPs at the local or remote end, you can assign the connection to the required route via the CP.
### Parameter | Description
--- | ---
Via CP / Local | If more than one Ethernet CP exists in the station via which connections operated you can select route here. The CPs are only displayed for selection if they are networked. If no CP is assigned (for example because the CP was deleted previously) “(None)” is displayed here. If there is only one CP plugged into the station, no selection is possible.
Via CP / Partner (remote) | Depending on the local selection, the possible remote CPs are displayed. All the CPs connected to the same subnet (networked) and the local CP can be selected. **Alternatives** are only available when a connection is established to a remote station configured in the same project and the remote station has two or more CPs. If there is no CP assigned on the partner (for example because the CP was deleted previously) “None” is displayed here. If there is only one CP in the remote station, no selection is possible. If the partner is an “other station” or SIMATIC S5 PLC, one or more attachments are displayed for selection depending on the configuration and networking of the station.
Programmed Communication Connections

In some situations, it is an advantage to set up communication connections not over the configuration interface of STEP 7 but program-controlled by a specific application.

Typical users who will find this useful are, for example, mass producers of machines who want to offer their customers a simple user interface but need to adapt the communication services to the operator input. The end user should not need knowledge of STEP 7.

As of STEP 7 V5.2 SP1, a function block is available for these applications that allows flexible transfer of data blocks with configuration data to an Ethernet CP.

You will find further information in the following sources:

- For the properties of the configurable connection types, refer to Section 4.
- For the properties of the configurable connection types E-mail connection and FTP connection, refer to /5/.
- After installing STEP 7 and the NCM S7 for Industrial Ethernet option, you will find a programmed example in the "Sample projects" tab of the SIMATIC Manager. This example is described in the appendix.
- You will find information on the numbers of connections and amounts of data in Section 3.1.

Notice

Please remember that the functions described here depend on the characteristics of the CP type you are using /1/.
5.1 Overview

Area of Application

Communication connections can be freely configured controlled by the program.

Interplay between Programming and Configuration

Connections are either configured using STEP 7 or configured by the user program while the S7 station is running. Mixing these variants on a CP is not possible!

Principle

Configuration data for communication connections can be transferred to the CPU using the function block called in the user program.

The configuration DB can be loaded on the CP at any time. The previously valid connections are then overwritten.

Based on the configuration data, the Ethernet CP recognizes that the communication connections must be set up by the user program.

As soon as the user program transfers the connection data via FB55 IP_CONFIG, the CPU switches the CP briefly to STOP. The CP receives the system data (including the IP address) and the new connection data and processes them during startup (RUN).

Configuration Limits

A maximum of 64 connections can be specified in FB55 CP_CONFIG. The most important factor, however, is the maximum number of connections supported by the CP type you are using (see /1/).


**Special Features / Restrictions**

- **Consistency check only with STEP 7**
  
  The connection configuration in STEP 7 involves consistency checks that are not possible or only possible with restrictions when using the programmed configuration!

- **Connection configuration required on the partner**
  
  When configuring specified connections in STEP 7, you implicitly create the connection for the partner; with a programmed configuration, this is not possible! In this case, you must configure suitable connections for the partner.

- **DHCP / DNS is supported**
  
  IP address assignment is also possible using DHCP/DNS even if you choose programmed configuration.

- **No ISO transport connections**
  
  The configuration of ISO transport connections over the program interface is not supported.

- **No connection information when uploading**
  
  When you upload the S7 station data in STEP 7, this does not contain the data of the programmed configuration.
5.2 Procedure

Initial Situation

The steps described here assume the following:

1. You have created the local S7 station and the required partner stations in your STEP 7 projects (refer to the description in Chapter 2).

2. You have clarified the other station types with which connections must be established. You create substitute objects for these station types in your STEP 7 projects.

Setting up Connections and Using Them in the User Program

Follow the steps outlined below to set up connections on the SIMATIC S7 PLC using the user program:

- **Configuring**
  - Set the CP Properties in the “IP Configuration” tab:
    - Select the “Set IP address in user program” option.

- **Programming**
  - Create system data and connections in the configuration DB.
  - Specify the connection characteristics in the Configuration DB.
  - Program the SEND/RECEIVE interface in the user program.
    (Refer to Section 3.2 and the detailed FC description in Chapter 6).
  - Download configurations and user programs to the S7 station.

Legend:  
- necessary steps  
- optional steps
5.3 Configuration Data Block

Meaning

The configuration data block (CONF_DB) contains all the connection data for an Ethernet CP. The configuration data block is transferred to the CP with function block FB55.

Block and Data Structure

The graphic below shows the following:

- Structure resulting from parameter fields and subfields
  - The connections and specific system data are described by an identically structured parameter field.
  - Individual parameters are characterized by subfields.
- Offset range
  The CONF_DB can start at any point within a data block as specified by an offset range.
5.4 Parameter Field for System Data
(CP Networking)

Meaning

Below, you can see the subfields that are relevant for networking the CP. These must be specified in the parameter field for system data.

Some applications do not require all the subfield types – refer to the table for details.

Structure

<table>
<thead>
<tr>
<th>ID</th>
<th>Type *)</th>
<th>Parameter</th>
<th>Special Features / Notes (Please refer also to the general description in Table 5-7 Page 159)</th>
<th>Use (mandatory / optional)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SUB_IP_V4</td>
<td>Local IP address</td>
<td></td>
<td>m</td>
</tr>
<tr>
<td>2</td>
<td>SUB_NETMASK</td>
<td>–</td>
<td></td>
<td>m</td>
</tr>
<tr>
<td>8</td>
<td>SUB_DEF_ROUTER</td>
<td>–</td>
<td></td>
<td>m</td>
</tr>
<tr>
<td>4</td>
<td>SUB_DNS_SERV_ADDR</td>
<td>This subfield can occur from 0 to 4 times. The first entry is the primary DNS server.</td>
<td></td>
<td>o</td>
</tr>
<tr>
<td>14</td>
<td>SUB_DHCP_ENABLE</td>
<td>0: No DHCP 1: DHCP</td>
<td></td>
<td>o</td>
</tr>
<tr>
<td>15</td>
<td>SUB_CLIENT_ID</td>
<td>–</td>
<td></td>
<td>o</td>
</tr>
</tbody>
</table>

*) The general properties of the subfield types are described below in Section 5.6.
### Example

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Type</th>
<th>Initial Value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>STRUCT</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>+0.0</td>
<td>DB_TYP</td>
<td>WORD</td>
<td>W#16#1</td>
<td>Identifier</td>
</tr>
<tr>
<td>+2.0</td>
<td>FIELD_1</td>
<td>STRUCT</td>
<td></td>
<td>// Field 1 (here system data field)</td>
</tr>
<tr>
<td>+0.0</td>
<td>Type</td>
<td>INT</td>
<td>0</td>
<td>Type of data to be transferred 0 .. 5</td>
</tr>
<tr>
<td>+2.0</td>
<td>ID</td>
<td>INT</td>
<td>0</td>
<td>Connection ID (with system parameters 0)</td>
</tr>
<tr>
<td>+4.0</td>
<td>Subfield_Cnt</td>
<td>INT</td>
<td>3</td>
<td>Number of subfields belonging to this field</td>
</tr>
<tr>
<td>+6.0</td>
<td>Sub_field_1</td>
<td>STRUCT</td>
<td></td>
<td>// Subfield 1 SUB_IP_V4</td>
</tr>
<tr>
<td>+0.0</td>
<td>Sub_field_ID</td>
<td>INT</td>
<td>1</td>
<td>// Number of the subfield</td>
</tr>
<tr>
<td>+2.0</td>
<td>Sub_field_len</td>
<td>INT</td>
<td>8</td>
<td>// Length of the subfield in bytes</td>
</tr>
<tr>
<td>+4.0</td>
<td>STAT9</td>
<td>STRUCT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+0.0</td>
<td>STAT10</td>
<td>BYTE</td>
<td>B#16#C0</td>
<td></td>
</tr>
<tr>
<td>+1.0</td>
<td>STAT11</td>
<td>BYTE</td>
<td>B#16#FF</td>
<td></td>
</tr>
<tr>
<td>+2.0</td>
<td>STAT12</td>
<td>BYTE</td>
<td>B#16#DE</td>
<td></td>
</tr>
<tr>
<td>+3.0</td>
<td>STAT13</td>
<td>BYTE</td>
<td>B#16#6A</td>
<td></td>
</tr>
<tr>
<td>=4.0</td>
<td>END_</td>
<td>STRUCT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>=8.0</td>
<td>END_</td>
<td>STRUCT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+14.0</td>
<td>Sub_field_2</td>
<td>STRUCT</td>
<td></td>
<td>// Subfield 2 SUBNET_MASK</td>
</tr>
<tr>
<td>+0.0</td>
<td>Sub_field_ID</td>
<td>INT</td>
<td>2</td>
<td>// Number of the subfield</td>
</tr>
<tr>
<td>+2.0</td>
<td>Sub_field_len</td>
<td>INT</td>
<td>8</td>
<td>// Length of the subfield in bytes</td>
</tr>
<tr>
<td>+4.0</td>
<td>Parameter</td>
<td>STRUCT</td>
<td></td>
<td>SUBNET_MASK</td>
</tr>
<tr>
<td>+0.0</td>
<td>Value_1</td>
<td>BYTE</td>
<td>B#16#FF</td>
<td></td>
</tr>
<tr>
<td>+1.0</td>
<td>Value_2</td>
<td>BYTE</td>
<td>B#16#FF</td>
<td></td>
</tr>
<tr>
<td>+2.0</td>
<td>Value_3</td>
<td>BYTE</td>
<td>B#16#FF</td>
<td></td>
</tr>
<tr>
<td>+3.0</td>
<td>Value_4</td>
<td>BYTE</td>
<td>B#16#0</td>
<td></td>
</tr>
<tr>
<td>=4.0</td>
<td>END_</td>
<td>STRUCT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>=8.0</td>
<td>END_</td>
<td>STRUCT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+22.0</td>
<td>Sub_field_3</td>
<td>STRUCT</td>
<td></td>
<td>// Subfield 3 default router</td>
</tr>
<tr>
<td>+0.0</td>
<td>Sub_field_ID</td>
<td>INT</td>
<td>8</td>
<td>// Number of the subfield</td>
</tr>
<tr>
<td>+2.0</td>
<td>Sub_field_len</td>
<td>INT</td>
<td>8</td>
<td>// Length of the subfield in bytes</td>
</tr>
<tr>
<td>+4.0</td>
<td>STAT9</td>
<td>STRUCT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+0.0</td>
<td>STAT10</td>
<td>BYTE</td>
<td>B#16#C0</td>
<td></td>
</tr>
<tr>
<td>+1.0</td>
<td>STAT11</td>
<td>BYTE</td>
<td>B#16#FF</td>
<td></td>
</tr>
<tr>
<td>+2.0</td>
<td>STAT12</td>
<td>BYTE</td>
<td>B#16#DE</td>
<td></td>
</tr>
<tr>
<td>+3.0</td>
<td>STAT13</td>
<td>BYTE</td>
<td>B#16#6A</td>
<td></td>
</tr>
<tr>
<td>=4.0</td>
<td>END_</td>
<td>STRUCT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>=8.0</td>
<td>END_</td>
<td>STRUCT</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
5.5 Parameter Fields for Connection Types

General

Below, you will see which values need to be entered in the parameter fields and which subfields are used for the various connection types.

Some applications do not require all the subfield types – refer once again to the table for details.

---

Note

Please read the explanations of the configurable connection properties for the individual connection type in Chapter 4!

---

Connection ID

The ID parameter that precedes each connection parameter field beside the type ID is particularly important.

On programmed connections, you can assign this ID freely within the permitted range of values. You must then use this ID on the call interface of the FCs for the SEND/RECV interface to identify the connection.

Range of values for the connection ID:

- S7-400: 1, 2 through 64
- S7-300: 1, 2 through 16
5.5.1 Parameter Field for TCP Connection

Structure

<table>
<thead>
<tr>
<th>Subfield</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type = 1</td>
<td>Identifier for the connection type</td>
</tr>
<tr>
<td>ID = connection ID</td>
<td>Freely assignable connection reference; must be specified in AG_SEND / AG_RECV.</td>
</tr>
<tr>
<td>No_of_subfields = n</td>
<td>Range of values for the connection ID:</td>
</tr>
<tr>
<td>Subfield 1</td>
<td>• S7-400: 1, 2 through 64</td>
</tr>
<tr>
<td>Subfield 2</td>
<td>• S7-300: 1, 2 through 16</td>
</tr>
<tr>
<td>Subfield n</td>
<td></td>
</tr>
</tbody>
</table>

Usable Subfields

Table 5-2

<table>
<thead>
<tr>
<th>Subfield</th>
<th>Parameter</th>
<th>Special Features / Notes</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SUB_IP_V4</td>
<td>IP address of the partner</td>
<td>m</td>
</tr>
<tr>
<td>9</td>
<td>SUB_LOC_PORT</td>
<td>–</td>
<td>m</td>
</tr>
<tr>
<td>10</td>
<td>SUB_REM_PORT</td>
<td>–</td>
<td>m</td>
</tr>
<tr>
<td>18</td>
<td>SUB_CONNECT_NAME</td>
<td>–</td>
<td>o</td>
</tr>
<tr>
<td>19</td>
<td>SUB_LOC_MODE</td>
<td>–</td>
<td>o</td>
</tr>
<tr>
<td>21</td>
<td>SUB_KBUS_ADR</td>
<td>This value is always set to 0 for CPs for the S7-300 and does not need to be specified.</td>
<td>m (for S7-400)</td>
</tr>
<tr>
<td>22</td>
<td>SUB_CON_ESTABL</td>
<td>–</td>
<td>m</td>
</tr>
</tbody>
</table>

*) The general properties of the subfield types are described below in Section 5.6.

Note

Please read the description of the configurable connection properties for the TCP connection in Section 4.6!
5.5.2 Parameter Field for a UDP Connection

Structure

<table>
<thead>
<tr>
<th>Type = 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID = connection ID</td>
</tr>
<tr>
<td>No_of_subfields = n</td>
</tr>
<tr>
<td>Subfield 1</td>
</tr>
<tr>
<td>Subfield 2</td>
</tr>
<tr>
<td>Subfield n</td>
</tr>
</tbody>
</table>

Identifier for the connection type

Freely assignable connection reference; must be specified in AG_SEND / AG_RECV.

Range of values for the connection ID:
- S7-400: 1,2 through 64
- S7-300: 1,2 through 16

Usable Subfields

Table 5-3

<table>
<thead>
<tr>
<th>Subfield</th>
<th>Parameter</th>
<th>Special Features / Notes (Please refer also to the general description in Table 5-7 Page 159)</th>
<th>Use (mandatory / optional)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Type *)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>SUB_IP_V4</td>
<td>IP address of the partner</td>
<td>m</td>
</tr>
<tr>
<td>9</td>
<td>SUB_LOC_PORT</td>
<td>–</td>
<td>m</td>
</tr>
<tr>
<td>10</td>
<td>SUB_REM_PORT</td>
<td>–</td>
<td>m</td>
</tr>
<tr>
<td>18</td>
<td>SUB_CONNECT_NAME</td>
<td>–</td>
<td>o</td>
</tr>
<tr>
<td>19</td>
<td>SUB_LOC_MODE</td>
<td>–</td>
<td>o</td>
</tr>
<tr>
<td>21</td>
<td>SUB_KBUS_ADR</td>
<td>This value is always set to 0 for CPs for the S7-300 and does not need to be specified.</td>
<td>m (for S7-400)</td>
</tr>
<tr>
<td>22</td>
<td>SUB_CON_ESTABL</td>
<td>–</td>
<td>m</td>
</tr>
<tr>
<td>23</td>
<td>SUB_ADDR_IN_DATABLOCK</td>
<td>If the “Free UDP connection” is selected for this parameter, the parameters SUB_IP_V4, SUB_LOC_PORT, SUB_REM_PORT are omitted.</td>
<td>o</td>
</tr>
</tbody>
</table>

*) The general properties of the subfield types are described below in Section 5.6.

Note

Please read the description of the configurable connection properties for the for the UDP connection in Section 4.7!
5.5.3 Parameter Field for an ISO-on-TCP Connection

Structure

<table>
<thead>
<tr>
<th>Type</th>
<th>ID = connection ID</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Freely assignable connection reference; must be specified in AG_SEND / AG_RECV.</td>
</tr>
<tr>
<td></td>
<td>Range of values for the connection ID:</td>
</tr>
<tr>
<td></td>
<td>• S7-400: 1,2 through 64</td>
</tr>
<tr>
<td></td>
<td>• S7-300: 1,2 through 16</td>
</tr>
</tbody>
</table>

Usable Subfields

Table 5-4

<table>
<thead>
<tr>
<th>Subfield</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Type *)</td>
</tr>
<tr>
<td>1</td>
<td>SUB_IP_V4</td>
</tr>
<tr>
<td>11</td>
<td>SUB_LOC_TSAP</td>
</tr>
<tr>
<td>12</td>
<td>SUB_REM_TSAP</td>
</tr>
<tr>
<td>18</td>
<td>SUB_CONNECT_NAME</td>
</tr>
<tr>
<td>19</td>
<td>SUB_LOC_MODE</td>
</tr>
<tr>
<td>21</td>
<td>SUB_KBUS_ADR</td>
</tr>
<tr>
<td>22</td>
<td>SUB_CON_ESTABL</td>
</tr>
</tbody>
</table>

*) The general properties of the subfield types are described below in Section 5.6.
5.5.4 Parameter Field for an E-Mail Connection

Meaning

To send E-mails, you must always set up one E-mail connection per IT-CP. The E-mail connection specifies the mail server, over which all the E-mails sent by the IT-CP are delivered.

You will find a detailed description of how to use the E-mail function with IT-CPs in /5/.

Structure

Table 5-5

<table>
<thead>
<tr>
<th>Subfield</th>
<th>Parameter</th>
<th>Special Features / Notes (Please refer also to the general description in Table 5-7 Page 159)</th>
<th>Use (mandatory / optional)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Type *)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUB_IP_V4</td>
<td>IP address of the mail server, over which the E-mails are sent. The IP address can be specified in absolute or symbolic form. The symbolic form assumes that the IT-CP knows the address of the domain name server (DNS). This must be entered during configuration of the IT-CP in HW Config, for more detailed information, refer to the online help of HW Config.</td>
<td>m / o **)</td>
<td></td>
</tr>
<tr>
<td>SUB_DNS_NAME</td>
<td>DNS name of the E-mail server</td>
<td>m / o **)</td>
<td></td>
</tr>
<tr>
<td>SUB_EMAIL_SENDER</td>
<td>E-mail address of the sender</td>
<td>m</td>
<td></td>
</tr>
<tr>
<td>SUB_CONNECT_NAME</td>
<td>--</td>
<td>o</td>
<td></td>
</tr>
</tbody>
</table>
Table 5-5, continued

<table>
<thead>
<tr>
<th>Subfield</th>
<th>Parameter</th>
<th>Special Features / Notes (Please refer also to the general description in Table 5-7 Page 159)</th>
<th>Use (mandatory / optional)</th>
</tr>
</thead>
<tbody>
<tr>
<td>21 SUB_KBUS_ADR</td>
<td></td>
<td>This value is always set to 0 for CPs for the S7-300 and does not need to be specified.</td>
<td>m (for S7-400)</td>
</tr>
<tr>
<td>22 SUB_CON_ESTABL</td>
<td></td>
<td></td>
<td>m</td>
</tr>
</tbody>
</table>

*) The general properties of the subfield types are described below in Section 5.6.

**) The parameters SUB_IP_V4 and SUB_DNS_NAME are mutually exclusive; one or the other must be specified.

Note

Mail server ports are well-known ports and do not need to be specified.
5.5.5 **Parameter field for FTP connection**

**Meaning**

To handle an FTP job sequence between the S7 station as FTP client and an FTP server, the IT-CP must set up a connection to the S7-CPU. This connection is known in this context as an FTP connection.

FTP connections are TCP connections, with the parameter SUB_LOC_MODE set to the “FTP” mode.

You will find a detailed description of how to use the FTP function with IT-CPs in /5/.

**Structure**

<table>
<thead>
<tr>
<th>Type = 1</th>
<th>Identifier for the connection type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID = connection ID</td>
<td>Freely assignable connection reference; must be specified in the FC FTP_**.</td>
</tr>
<tr>
<td>No_of_subfields = n</td>
<td>Range of values for the connection ID:</td>
</tr>
<tr>
<td>Subfield 1</td>
<td>• S7-400: 1,2 through 64</td>
</tr>
<tr>
<td>Subfield 2</td>
<td>• S7-300: 1,2 through 16</td>
</tr>
<tr>
<td>Subfield n</td>
<td></td>
</tr>
</tbody>
</table>

**Usable Subfields**

<table>
<thead>
<tr>
<th>Subfield</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Type</td>
</tr>
<tr>
<td>18</td>
<td>SUB_CONNECT_NAME</td>
</tr>
<tr>
<td>19</td>
<td>SUB_LOC_MODE</td>
</tr>
<tr>
<td>21</td>
<td>SUB_KBUS_ADR</td>
</tr>
</tbody>
</table>

*) The general properties of the subfield types are described below in Section 5.6.
5.6 Subfield types

Different parameters are required depending on the parameter field. Each parameter is described by a subfield. Which subfields are required is explained in the descriptions of the system data and the connection types in the previous sections.

Each subfield consists of the specific parameter section and the header (4 Byte).

Example

The following excerpt from a CONF_DB illustrates the structure of a subfield based on the example of the SUBNET_MASK subfield type.

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Type</th>
<th>Initial Value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>+14.0</td>
<td>Sub_field_2</td>
<td>STRUCT</td>
<td></td>
<td>// Subfield 2 type SUBNET_MASK</td>
</tr>
<tr>
<td>+0.0</td>
<td>Sub_field_ID</td>
<td>INT</td>
<td>2</td>
<td>// Subfield ID</td>
</tr>
<tr>
<td>+2.0</td>
<td>Sub_field_len</td>
<td>INT</td>
<td>8</td>
<td>// Total length of the subfield in bytes</td>
</tr>
<tr>
<td>+4.0</td>
<td>Parameter</td>
<td>STRUCT</td>
<td></td>
<td>Parameter range of SUBNET_MASK</td>
</tr>
<tr>
<td>+0.0</td>
<td>Value_1</td>
<td>BYTE</td>
<td>B#16#FF</td>
<td></td>
</tr>
<tr>
<td>+1.0</td>
<td>Value_2</td>
<td>BYTE</td>
<td>B#16#FF</td>
<td></td>
</tr>
<tr>
<td>+2.0</td>
<td>Value_3</td>
<td>BYTE</td>
<td>B#16#FF</td>
<td></td>
</tr>
<tr>
<td>+3.0</td>
<td>Value_4</td>
<td>BYTE</td>
<td>B#16#0</td>
<td></td>
</tr>
<tr>
<td>+4.0</td>
<td>END_SYS</td>
<td>STRUCT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+8.0</td>
<td>END_SYS</td>
<td>STRUCT</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In total, the following subfield types are available:

Table 5-7

<table>
<thead>
<tr>
<th>Subfield ID 1)</th>
<th>Subfield type</th>
<th>Subfield length (in bytes)</th>
<th>Meaning of the Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SUB_IP_V4</td>
<td>4 + 4</td>
<td>IP address according to IPv4</td>
</tr>
<tr>
<td>2</td>
<td>SUB_NETMASK</td>
<td>4 + 4</td>
<td>Subnet mask</td>
</tr>
<tr>
<td>3</td>
<td>SUB_DNS_NAME</td>
<td>Length of DNS name + 4</td>
<td>DNS name</td>
</tr>
<tr>
<td>4</td>
<td>SUB_DNS_SERV_ADDR</td>
<td>4 + 4</td>
<td>DNS server address</td>
</tr>
<tr>
<td>8</td>
<td>SUB_DEF_ROUTER</td>
<td>4 + 4</td>
<td>IP address of default router</td>
</tr>
<tr>
<td>9</td>
<td>SUB_LOC_PORT</td>
<td>2 + 4</td>
<td>Local port</td>
</tr>
<tr>
<td>10</td>
<td>SUB_REM_PORT</td>
<td>2 + 4</td>
<td>Remote port, also for E-mail connections</td>
</tr>
</tbody>
</table>
Table 5-7, continued

<table>
<thead>
<tr>
<th>Subfield ID 1)</th>
<th>Subfield type</th>
<th>Subfield length (in bytes)</th>
<th>Meaning of the Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>SUB_LOC_TSAP</td>
<td>TSAP length + 4</td>
<td>Local TSAP</td>
</tr>
<tr>
<td>12</td>
<td>SUB_REM_TSAP</td>
<td>TSAP length + 4</td>
<td>Remote TSAP</td>
</tr>
<tr>
<td>13</td>
<td>SUB_EMAIL_SENDER</td>
<td>Length of the sender E-mail address + 4</td>
<td>E-mail address of the sender</td>
</tr>
<tr>
<td>14</td>
<td>SUB_DHCP_ENABLE</td>
<td>1 + 4</td>
<td>Obtain an IP address from a DHCP server</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Possible values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 = no DHCP</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 = DHCP (optional)</td>
</tr>
<tr>
<td>15</td>
<td>SUB_CLIENT_ID</td>
<td>Length of the client ID + 4</td>
<td>(optional)</td>
</tr>
<tr>
<td>18</td>
<td>SUB_CONNECT_NAME</td>
<td>Length of the name + 4</td>
<td>Name of the connection</td>
</tr>
<tr>
<td>19</td>
<td>SUB_LOC_MODE</td>
<td>1 + 4</td>
<td>Local mode of the connection</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Possible values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0x00 = SEND/RECV</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0x01 = FTP protocol (TCP connection only)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0x10 = S5 addressing mode for FETCH/WRITE *)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0x80 = FETCH *)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0x40 = WRITE *)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If you do not set the parameter, the default setting is SEND/RECV.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>*) Note:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The specified codings can be combined by ORing them.</td>
</tr>
<tr>
<td>20</td>
<td>SUB_REM_MODE</td>
<td>1 + 4</td>
<td>Setting the mode on the communication partner.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(not currently supported)</td>
</tr>
<tr>
<td>22</td>
<td>SUB_CON_ESTABL</td>
<td>1 + 4</td>
<td>Type of connection establishment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>With this option, you specify whether the connection is established by this S7 station.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Possible values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 = passive</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 = active</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Refer also to Chapter 4 under “Specifying the local connection endpoint” for the individual connection types.</td>
</tr>
</tbody>
</table>
Table 5-7, continued

<table>
<thead>
<tr>
<th>Subfield ID</th>
<th>Subfield type</th>
<th>Subfield length (in bytes)</th>
<th>Meaning of the Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>23</td>
<td>SUB_ADDR_IN_DATABLOCK</td>
<td>1 + 4</td>
<td>Select free UDP connection. The remote node is entered in the job header of the job buffer by the user program when it calls AG_SEND. This allows any node on Ethernet/LAN/WAN to be reached.</td>
</tr>
</tbody>
</table>

- Possible values:
  - 1 = free UDP connection.
  - 0 = otherwise

The parameter is practical only for a UDP connection.

See also Section 4.7.5

1) Note: ID numbers not listed are not currently used.
Programming FCs (Functions) and FBs for S7 Ethernet CPs

The interface to several communication services is implemented by ready-made program blocks (FCs and FBs). This chapter includes a detailed description of these blocks.

The description of each FC / FB includes the following sections that may be extended by specific information:

- **Meaning**
- **Call Interface**
- **How the Block Works**
- **Explanation of the Formal Parameters**
- **Condition Codes**

This chapter provides you with information over and above the general information available in the online help for the FCs when programming in STEP 7.

You will find further information in the following sources:

- The communication FBs (BSEND, BRCV, PUT, GET, USEND, URCV, C_CNTRL) for programming S7 communication are described in the STEP 7 Documentation /9/.
- Sample configurations and programs are available for the SEND/RECEIVE interface described here:
  - In the sample project PROJECT_ETHERNET that you can start immediately after installing NCM S7; for a description, refer to the Primer /3/.
  - On the Internet as downloadable sample projects; refer to the information in Appendix C “Support and Training”.

The Quick Start CD that can be ordered separately is a treasure-trove of sample programs and configurations.

You can order this directly on the Internet at:
http://www.ad.siemens.de/csi/net
6.1 General Notes on FCs / FBs

Block Library

The functions (FCs) and function blocks (FBs) described here are supplied with the STEP 7 basic package unless indicated otherwise.

The following list shows the numbers of the FCs as they are supplied with the configuration tool. You can change these numbers.

Under SIMATIC_NET_CP, you can also see which folders contain blocks after installing the NCM S7 for Industrial Ethernet option (default setting in STEP 7 Setup). Please note that you must use different FCs for the S7-300 and S7-400 (separate libraries).

<table>
<thead>
<tr>
<th>Communication Service / Functional Area</th>
<th>Block Type</th>
<th>SIMATIC Manager Library</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>SIMATIC_NET_CP</td>
</tr>
<tr>
<td>SEND/RECEIVE (S5-compatible communication)</td>
<td>FC5 AG_SEND</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>FC6 AG_RECV</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>FC50 AG_LSEND</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>FC60 AG_LREC</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>FC7 AG_LOCK</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>FC8 AG_UNLOCK</td>
<td>x</td>
</tr>
<tr>
<td>Programmed Communication Connections</td>
<td>FB55 IP_CONFIG</td>
<td>x</td>
</tr>
<tr>
<td>S7 communication</td>
<td>FB12 BSEND</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>FB13 BRCV</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>FB15 PUT</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>FB14 GET</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>FB8 USEND</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>FB9 URCV</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>FC62 C_CNTRL</td>
<td>x</td>
</tr>
</tbody>
</table>
### Which Block Version Should I Use?

The following descriptions also include information on differences between the various block versions. Please take note of the version identifiers of the blocks you are using.

The SIMATIC Manager block libraries installed with STEP 7 / NCM S7 contain the block versions that were current at the time of the STEP 7 release.

#### Note

We recommend that you always use the latest block versions for all module types. You will find information on the current block versions and the current blocks to download from the Internet in our customer support.

http://www4.ad.siemens.de/view/cs/de/8797900

Entry ID: 8797900

With the older module types, this recommendation assumes that you are using the latest firmware for the particular block type.

<table>
<thead>
<tr>
<th>Communication Service / Functional Area</th>
<th>Block Type</th>
<th>SIMATIC Manager Library</th>
<th>Described in</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Block Type</td>
<td>SIMATIC_NET_CP</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CP 300</td>
<td>CP 400</td>
</tr>
<tr>
<td>FTP (IT-CPs)</td>
<td>FC40 FTP_CONNECT</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>FC41 FTP_STORE</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>FC42 FTP_RETRIEVE</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>FC43 FTP_DELETE</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>FC44 FTP.Quit</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>PROFInet</td>
<td>FB88 1) PN_InOut 1)</td>
<td>x</td>
<td></td>
</tr>
</tbody>
</table>

1) FB88 supplied along with the engineering tool SIMATIC iMap.
2) Not to be used for current CPs
Notice
At various points in this chapter, you will find information on the different CP versions. These passages are highlighted with the following symbol:

Newer CP types are CPs / module types with the following versions or higher:
CP 343-1 / CP 343-1 EX20
6GK 343-1EX11-0XE0 version 1 or higher / firmware version V2.0 or higher
6GK 343-1EX20-0XE0 version 1 or higher / firmware version V1.0 or higher
CP 343-1 PN
6GK 343-1HX00-0XE0 version 1 or higher / firmware version V1.0 or higher
CP 343-1 IT / CP 343-1 IT GX20
6GK 343-1GX11-0XE0 version 1 or higher / firmware version V2.0 or higher
6GK 343-1GX20-0XE0 version 1 or higher / firmware version V1.0 or higher

FCs and Module Replacement (Spares)
Module replacement in this sense means the replacement of a module with another module that may be a more recent version.

Notice
Please remember that if you replace a module, you must only use the blocks permitted for the configured CP type in the user program.
This means:
- If you replace the module without adapting the configuration data to the possibly newer module type, you do not need to make any changes to the blocks used.
- If you replace the module and you do adapt the configuration data to the newer module type, you must use the block versions approved for this module type.

We recommend that you always use the latest block versions for all module types. With the older module types, this recommendation assumes that you are using the latest firmware for the particular block type.
You will find more information on replacing blocks in our Customer Support on the Internet.

The manuals /1/ contain information on the compatibility of the S7-CPs and the corresponding blocks (FCs / FBs).
6.2 Setting Parameters for FC Calls

Before describing the FCs in detail, a few general comments on calling and setting parameters for FCs will be useful in this point.

It is possible to make the following general statements about the following parameter groups that occur in all FCs:

- Parameters for CP and connection assignment (input parameters)
- Parameters for specifying a CPU data area (input parameters)
- Status information (output parameters)

Calling Communication Blocks for an S7-300

Caution

The communication blocks for S7-300 (SIMATIC NET block libraries for S7-300 in STEP 7) must not be called in more than one priority class! If, for example, you call a communication block in OB1 and in OB35, block execution could be interrupted by the higher-priority OB.

If you call blocks in more than one OB, you must write your program so that a communication block that is currently executing cannot be interrupted by another communication block (for example by disabling/enabling SFC interrupts).

6.2.1 Parameters for CP and Connection Assignment (input parameters)

When you call an FC, you transfer the module start address of the Ethernet CP in the CPLADDR or LADDR parameter. The module start address of the Ethernet CP can be found in the properties dialog of the CP in the "Address/Input" tab (can be selected in the SIMATIC Manager or in HW Config).

With connection-oriented jobs, you must also reference the connection to be used by its connection ID. You will find this in the properties dialog of the connection under "Block parameters" (refer to the information in NetPro).
Setting Block Parameters Automatically\(^1\)

To ensure correct parameter settings for the block calls, the LAD/STL/FBD editor in STEP 7 provides you with the option of accepting all the relevant parameters from the hardware configuration (HW Config) and from the connection configuration (NetPro).

When assigning the parameters for the block in the user program, follow the steps outlined below:

1. Select the block call and its block parameters;
2. Right-click and select the menu command “Connections...”.
3. Depending on the block type, you can now select the connection and/or module intended for the block from a list.
4. Confirm your selection; as far as possible, the available parameter values are entered in the block call.

Response to Incorrect Addresses

If the S7 CPU cannot communicate with the Ethernet CP using the specified module base address, the errors described below occur.

<table>
<thead>
<tr>
<th>Cause</th>
<th>Reaction / Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>No module can be addressed or identified at the specified CP address.</td>
<td>The CPU remains in the stop with system error state; in this case, evaluate the diagnostic buffer of the CPU.</td>
</tr>
<tr>
<td>The CP address points to a different module type.</td>
<td>Possible error code in the STATUS parameter of the communication block:</td>
</tr>
<tr>
<td></td>
<td>8184H System error</td>
</tr>
<tr>
<td></td>
<td>80B0H Module does not recognize data record.</td>
</tr>
<tr>
<td></td>
<td>80C0H Data record cannot be read.</td>
</tr>
<tr>
<td></td>
<td>80C3H Resources occupied (memory).</td>
</tr>
<tr>
<td></td>
<td>80D2H Logical base address wrong.</td>
</tr>
</tbody>
</table>

Notice

If you inadvertently address not a CP but another module type, errors occur that cannot be indicated by the error messages of the FCs themselves.

---

\(^1\) This function is possible only with the block library \(.V5.0\ SP3 or later.\)
6.2.2 Parameters for Specifying a CPU Data Area (input parameters)

Specifying the Data Area on the CPU

When you call an FC, you transfer the address and length of the data area on the CPU in which the user data are available or will be stored or which can contain further parameter information.

The ANY pointer data type is used to address this area. For more detailed information on this data type, refer to the STEP 7 online help under the topic “Format of the Parameter Type ANY”. You will also find a detailed description of the ANY point in /21/.

6.2.3 Status Information (output parameters)

For status evaluation, the following parameters must be evaluated in the user program:

- DONE or NDR
  These parameters (DONE with send jobs and NDR with receive jobs) signal (successful) completion of the job.
- ERROR
  This indicates that the job could not be executed error-free.
- STATUS
  This parameter supplies detailed information about the execution of the job. Status codes can be returned during execution of the job (DONE=0 and ERROR=0).

Evaluating Status Codes

Remember that the status codes DONE, NDR, ERROR, STATUS are updated at each block call.

Status Codes during CP Startup

With a startup or restart of the Ethernet CP (after activating a switch on the module), the output parameters of the FC are reset as follows:

- DONE = 0
- NDR = 0
- ERROR = 0
- STATUS = 8180\text{H} for AG_RECV / AG_LRECV or 8181\text{H} for AG_SEND / AG_LSEND
6.3 FCs for the SEND/RECEIVE Interface

Overview

The following FCs are available for transferring data on the SEND/RECEIVE interface:

<table>
<thead>
<tr>
<th>FC</th>
<th>Can be used with</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>S7 – 300</td>
<td>S7 – 400</td>
</tr>
<tr>
<td>AG_SEND (FC5)</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>AG_RECV (FC6)</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>AG_LSEND (FC50)</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>AG_LRECV (FC60)</td>
<td>x</td>
<td></td>
</tr>
</tbody>
</table>

1) Notes on the FCs in FCs for an S7-300 and S7-400

- S7-300:
  
  With older versions of the Ethernet CPs, the data length per job is restricted to <=240 bytes (applies up to block version V3.0 of AG_SEND / AG_RECV); with later versions, longer data records (up to 8192 bytes) can be transferred with FCs AG_LSEND or AG_LRECV.

  With the latest versions of the Ethernet CPs, only FCs AG_SEND and AG_RECV are used; due to a new and more efficient internal protocol, the data up to 8192 bytes can be transferred.

- S7-400:
  
  With FCs AG_SEND / AG_RECV the data length per job is restricted to <=240 bytes.

  Longer data records (up to 8192 bytes) can be transferred with FCs AG_LSEND or AG_LRECV.

Please check the manual /3/ of the S7-CP you are using for the data areas supported. You will find an overview of the versions of the FCs/FBs in the documentation and block history.

Application

The following diagram illustrates the use of the FCs described here for bi-directional data transfer on one configured connection.
Note
Unless specifically stated otherwise, the information on this and the following pages refers to AG_SEND / AG_LSEND or AG_RECV / AG_LRECV.

Specifying the Data Area on the CPU
When you call an FC, you transfer the address and length of the data area in the CPU. Remember, that the maximum length of the data area depends on the block type and block version being used.

- **AG_SEND** and **AG_RECV**
  
  Up to version V3.0 of these blocks, a maximum of 240 bytes could be sent or received. The current block versions allow a data area of up to 8192 bytes for an S7-300. With an S7-400, the FCs AG_LSEND / AG_LRECV must still be used for larger data areas.

- **AG_LSEND** / **AG_LRECV**
  
  Using the CPs of the S7-400 and with earlier versions of the S7-300, larger data areas can only be transferred with the FCs AG_LSEND or AG_LRECV. Please check the length of the data area in the product information.

The following table shows the limit values of the various connection types.
Table 6-1

<table>
<thead>
<tr>
<th>FC</th>
<th>ISO Transport</th>
<th>ISO-on-TCP</th>
<th>TCP</th>
<th>UDP</th>
</tr>
</thead>
<tbody>
<tr>
<td>AG_LSEND (S7-400)</td>
<td>8192 bytes</td>
<td>8192 bytes</td>
<td>8192 bytes</td>
<td>2048 bytes</td>
</tr>
<tr>
<td>AG_SEND (S7-300)</td>
<td>8192 bytes</td>
<td>8192 bytes</td>
<td>8192 bytes</td>
<td>2048 bytes</td>
</tr>
<tr>
<td>AG_LRECV (S7-400)</td>
<td>8192 bytes</td>
<td>8192 bytes</td>
<td>8192 bytes</td>
<td>2048 bytes</td>
</tr>
<tr>
<td>AG_RECV (S7-300)</td>
<td>8192 bytes</td>
<td>8192 bytes</td>
<td>8192 bytes</td>
<td>2048 bytes</td>
</tr>
</tbody>
</table>

**Note**

For information on the length of the data area you can transfer with older versions of the Ethernet CPs, refer to the product information bulletin / manual of the Ethernet CP you are using /1/.

**Working without the Job Header**

On specified connections, the address and job parameters are specified by the connection configuration. The user program only provides the user data in the UDP data area when sending with AG_SEND / AG_LSEND or receives the data with AG_RECV / AG_LRECV.
Working with the Job Header

Free UDP connections require a job header in the user data area.

The following schematic illustrates the structure of the job buffer and the meaning and location of the parameters in the job header.

![Job Header Diagram](image)

Figure 6-1  Sending and Receiving on a Free UDP Connection with Programmed Addresses

- In the picture (entries in hexadecimal) the following IP address is assumed: 142.11.40.35 (example only);
- For the port address 1003, the following would be entered: for high byte: 03H; for low byte: EBH;
- The user data area can be up to 2048 bytes long. Up to 2042 bytes of user data can be transferred. 6 bytes are reserved for the job header.

Please note that the data length specified in the block call (LEN parameter) must include the header and the user data!
6.3.1  FC5 AG_SEND / FC50 AG_LSEND

Meaning of the Block

The FCs AG_SEND / AG_LSEND pass data to the Ethernet CP for transfer over a configured connection.

The selected data area can be a process image area, a memory bit area or a data block area.

Error-free execution of the function is indicated when the entire user data area could be sent on Ethernet.

The way in which the FC functions depends on the CP type you are using. Please note the differences in the following section.

Note:
Unless otherwise stated, all the following information applies to both the FCs AG_SEND and AG_LSEND.

Call

Call interface in LAD representation

<table>
<thead>
<tr>
<th>AG_SEND / AG_LSEND</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL ACT</td>
</tr>
<tr>
<td>INT ID</td>
</tr>
<tr>
<td>WORD LADDR</td>
</tr>
<tr>
<td>ANY SEND</td>
</tr>
<tr>
<td>INT LEN</td>
</tr>
<tr>
<td>BOOL DONE</td>
</tr>
<tr>
<td>BOOL ERROR</td>
</tr>
<tr>
<td>WORD STATUS</td>
</tr>
</tbody>
</table>

Example in STL representation

<table>
<thead>
<tr>
<th>STL</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>call fc 5</td>
<td>//AG_SEND / AG_LSEND block call</td>
</tr>
<tr>
<td>ACT := M 10.0</td>
<td>//Job triggered by memory bit</td>
</tr>
<tr>
<td>ID := MW 12</td>
<td>//Connection ID acc. to configuration</td>
</tr>
<tr>
<td>LADDR := W#16#0100</td>
<td>//LADDR 256 dec. in hw configuration</td>
</tr>
<tr>
<td>SEND := P#db99.dbx10.0 byte 240</td>
<td>//Buffer with send data</td>
</tr>
<tr>
<td>LEN := MW 14</td>
<td>//Length for send data</td>
</tr>
<tr>
<td>DONE := M 10.1</td>
<td>//Execution code</td>
</tr>
<tr>
<td>ERROR := M 10.2</td>
<td>//Error code</td>
</tr>
<tr>
<td>STATUS := MW 16</td>
<td>//Status code</td>
</tr>
</tbody>
</table>
Notice

Please note the following special feature on TCP connections:

With the S7-CPs for S7-400, you must use FC AG_LSEND on TCP connections!

With the latest S7-CPs for S7-300, you must also use FC AG_SEND for TCP connections.

How the Block Works

The following diagrams illustrate the normal sequence of data transmission triggered in the user program using AG_SEND.

The way in which the FC functions depends on the CP type you are using.

- Case a: Sequence with older CP types
  
  With older CP types, the transfer of the entire data area regardless of its length is started after the first block call by the CP.

- Case b: Sequence with newer CP types (S7–300 only !)

  With the newer CP types, data transfer has been optimized. In particular with longer data records, this allows a much higher data throughput on the interface between the CPU and CP.
Case a: Sequence with older CP types

The send job is executed as soon as the parameter ACT = 1 is passed. Following this, the parameter ACT = 0 must be passed in at least one further call.

The status code in the output parameters DONE, ERROR and STATUS is updated in each block call and can be evaluated. To update the status code without starting a new send job, start a new block call with the parameter ACT = 0.

Refer to the sample program at the end of Section 6.3.1.

Legend:
1) parameter transfer DONE, ERROR, STATUS
• Case b: Sequence with newer CP types (S7–300 only !)

The send job is started as soon as the parameter ACT = 1 is passed.

In contrast to case a, the protocol used here to transfer the data segments (each 240 bytes of user data) requires the FC to be called again for each segment.

Depending on the length of the user data, you must therefore continue to call the FC with ACT = 0 until transfer of the entire data record is indicated; at least one call with ACT = 0 is always necessary. The data is transferred to the communication partner in segments of 240 bytes.

The status code in the output parameters DONE, ERROR and STATUS is updated in each block call and can be evaluated.

Legend:
1) parameter transfer DONE, ERROR, STATUS
Note

In principle, it is possible to call the FC more than once within the CPU cycle to speed up the handling of the job. Do not forget, however, that this increases the load during the CPU cycle (the load differs depending on the CPU type).

Explanation of the Formal Parameters

The following table explains all the formal parameters for the AG_SEND / AG_LSEND functions.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>Type</th>
<th>Possible Values</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACT</td>
<td>INPUT</td>
<td>BOOL</td>
<td>0, 1</td>
<td>If an FC is called with ACT=1, LEN bytes are sent from the ISO transport data area specified with the SEND parameter. If an FC is called with ACT = 0, the status codes DONE, ERROR and STATUS are updated.</td>
</tr>
<tr>
<td>ID</td>
<td>INPUT</td>
<td>INT</td>
<td>1, 2...64</td>
<td>The connection number of the connection is specified in the parameter ID. (see Configuration Section 4.3.1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(S7-400)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1, 2...16</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(S7-300)</td>
<td></td>
</tr>
<tr>
<td>LADDR</td>
<td>INPUT</td>
<td>WORD</td>
<td></td>
<td>Module base address When you configure the CP with STEP 7 hardware configuration, the module base address is displayed in the configuration table. Specify this address here.</td>
</tr>
<tr>
<td>SEND</td>
<td>INPUT</td>
<td>ANY</td>
<td></td>
<td>Specifies the address and length. The address of the data area refers to one of the following: – Process image area – Bit memory – Data block area</td>
</tr>
</tbody>
</table>
### Parameter | Declaration | Type | Possible Values | Remarks
--- | --- | --- | --- | ---
LEN | INPUT | INT | On ISO Transport and ISO-on-TCP / TCP: 1.2, to 32767 (or up to “length specified for SEND parameter”) On UDP: 1.2,...2048 (or up to “length specified for SEND parameter”) | Number of bytes to be sent from the data area with this job. The possible values range from 1 to length specified for the SEND parameter.  
- Note the block type:  
  - S7-300  
    With older versions of FC AG_SEND (up to V3.0), the data area is always restricted to a maximum of 240 bytes.  
    The current versions allow up to 8192 bytes (2048 bytes for UDP).  
  - S7-400  
    With FC AG_SEND, the data area is restricted to a maximum of 240 bytes.  
  
- Note on the S7-400:  
  Data transfer may be restricted to LEN<=240 bytes with older versions of the CP firmware!  
  For further information, see /1/  
- Improved performance with shorter data records:  
  Transfer of data records up to 240 bytes results in better performance regardless of the block type used. |
DONE | OUTPUT | BOOL | 0: Job active 1: done | This parameter indicates whether or not the job was completed without errors.  
As long as DONE = 0, no further job can be triggered. DONE is set to 0 by the CP when it accepts a new job.  
For the meaning of this parameter in conjunction with the ERROR and STATUS parameters, refer to the following table. |
ERROR | OUTPUT | BOOL | 0: – 1: error | For the meaning of this parameter in conjunction with the DONE and STATUS parameters, refer to the follow table. |
STATUS | OUTPUT | WORD | see following table | Status code  
The following table shows the condition codes formed by the DONE and ERROR parameters. |

### Condition Codes
The following table shows the condition codes formed by the DONE, ERROR and STATUS parameters that must be evaluated by the user program.
Note

For entries coded with 8FxxH in STATUS, refer to the information in the STEP 7 Standard and System Functions reference manual. The chapter describing error evaluation with the RET_VAL output parameter contains detailed information.

To find out which SFCs are used and are relevant for error evaluation, display the properties dialog of the FC described here in the “Calls” tab.

Table 6-2 AG_SEND / AG_LSEND Codes

<table>
<thead>
<tr>
<th>DONE</th>
<th>ERROR</th>
<th>STATUS</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0000H</td>
<td>Job completed without error.</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0000H</td>
<td>No job being executed.</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>8181H</td>
<td>Job active.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>7000H</td>
<td>This code is possible only with the S7-300: the FC was called with ACT=0; the job has not yet been processed.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8183H</td>
<td>No configuration or the ISO/TCP service has not yet started on the Ethernet CP.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8184H</td>
<td>System error.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8185H</td>
<td>LEN parameter longer than SEND source area.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8186H</td>
<td>ID parameter invalid. ID!=1,2 to 64.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8302H</td>
<td>No receive resources on the destination station; the receiving station cannot process received data quickly enough or has not prepared any receive resources.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8304H</td>
<td>The connection is not established. The send job should only be attempted again after waiting for at least 100 ms.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8311H</td>
<td>The destination station cannot be obtained under the specified Ethernet address.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8312H</td>
<td>Ethernet error on the CP.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F22H</td>
<td>Source area invalid, for example: Area does not exist in the DB LEN parameter &lt; 0</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F24H</td>
<td>Area error reading a parameter.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F28H</td>
<td>Alignment error reading a parameter.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F32H</td>
<td>Parameter contains a DB number that is too high.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F33H</td>
<td>DB number error.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F3AH</td>
<td>Area not loaded (DB).</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F42H</td>
<td>Timeout reading a parameter from the I/O area.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F44H</td>
<td>Address of the parameter to be read is disabled in the access track.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F7FH</td>
<td>Internal error, e.g. illegal ANY reference. e.g. parameter LEN=0</td>
</tr>
<tr>
<td>DONE</td>
<td>ERROR</td>
<td>STATUS</td>
<td>Meaning</td>
</tr>
<tr>
<td>------</td>
<td>-------</td>
<td>--------</td>
<td>---------</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8090H</td>
<td>No module with this address exists or the CPU is in the STOP mode.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8091H</td>
<td>Logical base address not at a double word boundary.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8092H</td>
<td>In the ANY reference, a type other than BYTE is specified. (S7-400 only)</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80A4H</td>
<td>The communication bus connection between the CPU and CP is not established. (Only with newer CPU versions)</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80B0H</td>
<td>The module does not recognize the data record.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80B1H</td>
<td>The specified length (in the LEN parameter) is incorrect.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80B2H</td>
<td>The communication bus connection between the CPU and CP is not established.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80C0H</td>
<td>The data record cannot be read.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80C1H</td>
<td>The specified data record is currently being processed.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80C2H</td>
<td>There are too many jobs pending.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80C3H</td>
<td>CPU resources (memory) occupied.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80C4H</td>
<td>Communication error (occurs temporarily and a repetition in the user program will often remedy the problem).</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80D2H</td>
<td>Module base address incorrect.</td>
</tr>
</tbody>
</table>
Example of AG_SEND

Below you will find an executable example of an FC5 (AG_SEND) call and parameter evaluation.

The OB100 listed below belongs to the FC100 selected here in which the send call takes place; OB100 sets the ACT bit correctly when the CPU starts up.

To function correctly, a DB100 with a size of at least 240 bytes must be loaded.

The program requires a CP at address 256 and a configured connection of the type ISO Transport / ISO-on-TCP / TCP with ID=1 (please adapt your configuration where necessary!).

```plaintext
//––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
FUNCTION FC 100: VOID
TITLE = SENDE_DEMO
AUTHOR : Tester
FAMILY : S7300
NAME : FC5_Demo
VERSION : 1.0
//––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
BEGIN
CALL FC 5 ( ACT := M100.0, ID := 1, LADDR := W#16#100, SEND := P#DB100.dbx0.0 BYTE 240, LEN := 240, DONE := M100.1, ERROR := M100.2, STATUS := MW102 );

R M100.0; // Reset parameter ACT for all further FC5 calls;
SET;
A M100.1; // Test whether DONE = TRUE
JC done;
SET;
A M100.2; // Test whether ERROR = TRUE
JC err;

BEU; // Neither DONE nor ERROR is set, the job is still running.

done S M100.0; // Job completed without error. Set ACT = TRUE so that the next call can trigger the new job.

//––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
```
err: NOP 1; // An error occurred. The status word can be evaluated here. Set ACT to TRUE in any case, so that a new send job can be triggered if the error disappears.

//--->org
END_FUNCTION

ORGANIZATION_BLOCK OB100
TITLE = Init_for_FC100
FAMILY: S7300
NAME: SENDE_DEMO_INIT
VERSION: 1.0

VAR_TEMP

OB1_System: array [1..20] of byte;

END_VAR

BEGIN //

SET //
S M100.0 // Initialize ACT parameter

END_ORGANIZATION_BLOCK
6.3.2 FC6 AG_RECV / FC60 AG_LRECV

Meaning of the Block

The AG_RECV / AG_LRECV function receives the data transferred on a configured connection from the Ethernet CP.

The data area specified for the receive data can be a process image area, a bit address area or a data block area.

Error-free execution is indicated when the data could be received from the Ethernet CP.

Note:
Unless otherwise stated, all the following information applies to both the FCs AG_RECV and AG_LRECV.

Call

Call interface in LAD representation

```
AG_RECV / AG_LRECV

call fc 6
ID := MW 40
LADDR := W#16#0100
RECV := P#M 0.0 BYTE 100
NDR := DB 110.DBX 0.6
ERROR := DB 110.DBW 2
STATUS := DB 110.DBW 4
LEN := DB 110.DBW 4
```

Example in STL representation

```
//AG_RECV/AG_LRECV block call
```

STL Explanation

<table>
<thead>
<tr>
<th>STL</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>call fc 6</td>
<td>//AG_RECV/AG_LRECV block call</td>
</tr>
<tr>
<td>ID := MW 40</td>
<td>//Connection ID acc. to configuration</td>
</tr>
<tr>
<td>LADDR := W#16#0100</td>
<td>//LADDR 256 dec. in hardware configuration</td>
</tr>
<tr>
<td>RECV := P#M 0.0 BYTE 100</td>
<td>//Buffer for received data</td>
</tr>
<tr>
<td>NDR := DB 110.DBX 0.6</td>
<td>//Receive code</td>
</tr>
<tr>
<td>ERROR := DB 110.DBW 2</td>
<td>//Execution code</td>
</tr>
<tr>
<td>STATUS := DB 110.DBW 2</td>
<td>//Error code</td>
</tr>
<tr>
<td>LEN := DB 110.DBW 4</td>
<td>//Status code</td>
</tr>
</tbody>
</table>
Notice

Please note the following special feature on TCP connections:

With the S7-CPs for S7-400, you must use FC AG_LRECV on TCP connections!

With the latest S7-CPs for S7-300, you must also use FC AG_RECV for TCP connections.

How the Block Works

The following diagram illustrates the normal sequence of data acceptance triggered by an AG_RECV in the user program.

Each AG_RECV job in the user program is acknowledged by the Ethernet CP with an entry in the output parameters NDR, ERROR and STATUS.

The way in which the FC functions depends on the CP type you are using.

- **Case a: Sequence with older CP types**
  
  With older CP types, the transfer of the entire data area regardless of its length is started after the first block call by the CP.

- **Case b: Sequence with newer CP types (S7–300 only !)**
  
  With the newer CP types, optimized data transfer on the SEND/RECEIVE interface is available. In particular with longer data records, this allows a much higher data throughput on the interface between the CPU and CP.
• Case a: Sequence with older CP types

When the FC is called, the user program prepares the buffer for the received data and instructs the CP to enter the received data there.

As soon as a data record has been entered fully and consistently in the receive buffer, this is indicated by the parameter NDR = 1 in one of the next FC calls.

The status code in the output parameters NDR, ERROR, and STATUS is updated in each block call and can be evaluated.

Legend:
1) Parameter transfer NDR, ERROR, STATUS
Case b: Sequence with newer CP types (S7–300 only!)

When the FC is called, the user program prepares the buffer for the received data and instructs the CP to enter the received data there.

In contrast to case a, the protocol used here to transfer the data to the receive buffer requires the FC to be called again for each data segment (240 bytes of user data).

Depending on the length of the user data, you must therefore continue to call the FC until transfer of the entire data record is indicated by the parameter NDR = 1.

The status code in the output parameters NDR, ERROR, and STATUS is updated in each block call and can be evaluated.

Legend:
1) Parameter transfer NDR, ERROR, STATUS
Explanation of the Formal Parameters

The following table explains all the formal parameters for the AG_RECV / AG_LRECV function.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>Type</th>
<th>Possible Values</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>INPUT</td>
<td>INT</td>
<td>1,2...64</td>
<td>The connection number of the ISO transport connection is specified in the ID parameter (see Configuration Section 4.3.1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(S7-400)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1,2...16</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(S7-300)</td>
<td></td>
</tr>
<tr>
<td>LADDR</td>
<td>INPUT</td>
<td>WORD</td>
<td>Module base address</td>
<td>When you configure the CP with STEP 7 hardware configuration, the module base address is displayed in the configuration table. Specify this address here.</td>
</tr>
<tr>
<td>RECV</td>
<td>INPUT</td>
<td>ANY</td>
<td>Specifies the address and length.</td>
<td>The address of the data area refers to one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>– Process image area</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>– Bit memory</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>– Data block area</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Note on length:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Performance is improved in transfer of data records up to $2^{12}$ bytes if you also restrict the length to $2^{12}$ with the RECV parameter.</td>
</tr>
<tr>
<td>NDR</td>
<td>OUTPUT</td>
<td>BOOL</td>
<td>0: –</td>
<td>This parameter indicates whether new data were received.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1: new data</td>
<td>For the meaning of this parameter in conjunction with the ERROR and STATUS parameters, refer to the following table.</td>
</tr>
<tr>
<td>ERROR</td>
<td>OUTPUT</td>
<td>BOOL</td>
<td>0: –</td>
<td>Error code</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1: error</td>
<td>For the meaning of this parameter in conjunction with the DONE and STATUS parameters, refer to the following table.</td>
</tr>
<tr>
<td>STATUS</td>
<td>OUTPUT</td>
<td>WORD</td>
<td>see following table</td>
<td>Status code</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>For the meaning of this parameter in conjunction with the NDR and ERROR parameters, refer to the following table.</td>
</tr>
</tbody>
</table>
Parameter Declarations Possible Values Remarks
LEN OUTPUT INT On ISO Transport and ISO-on-TCP: 1,2...8192
On UDP: 1,2...2048 Specifies the number of bytes accepted from the Ethernet CP and entered in the data area.
- Note the block type:
  - S7-300
    With older versions of FC AG_RECV (up to V3.0), the data area is always restricted to a maximum of 240 bytes.
    The current versions allow up to 8192 bytes (2048 bytes for UDP).
  - S7-400
    With FC AG_RECV, the data area is restricted to a maximum of 240 bytes.

Condition Codes

The following table shows the codes formed by the DONE, ERROR and STATUS parameters that must be evaluated by the user program.

Note

For entries coded with 8FxxH in STATUS, refer to the information in the STEP 7 Standard and System Functions reference manual. The chapter describing error evaluation with the RET_VAL output parameter contains detailed information.

To find out which SFCs are used and are relevant for error evaluation, display the properties dialog of the FC described here in the “Calls” tab.

<table>
<thead>
<tr>
<th>NDR</th>
<th>ERROR</th>
<th>STATUS</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0000H</td>
<td>New data accepted.</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>8180H</td>
<td>There are not yet any data available.</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>8181H</td>
<td>Job active.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8183H</td>
<td>No configuration or the ISO transport service has not yet started on the Ethernet CP.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8184H</td>
<td>System error (the source data area is incorrect).</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8185H</td>
<td>Destination buffer (RECV) is too short.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8186H</td>
<td>ID parameter invalid.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ID ! = 1,2,...,16 (S7-300).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ID ! = 1,2,...,64,(S7-400)</td>
</tr>
<tr>
<td>NDR</td>
<td>ERROR</td>
<td>STATUS</td>
<td>Meaning</td>
</tr>
<tr>
<td>-----</td>
<td>-------</td>
<td>--------</td>
<td>---------</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8304H</td>
<td>The connection is not established. The send job should only be attempted again after waiting for at least 100 ms.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F23H</td>
<td>Source area invalid, for example: Area does not exist in the DB.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F25H</td>
<td>Area error writing a parameter.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F29H</td>
<td>Alignment error writing a parameter.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F30H</td>
<td>Parameter is in the write-protected first current data block.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F31H</td>
<td>Parameter is in the write-protected second current data block.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F32H</td>
<td>Parameter contains a DB number that is too high.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F33H</td>
<td>DB number error.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F3AH</td>
<td>Destination area not loaded (DB).</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F43H</td>
<td>Timeout writing a parameter to the I/O area.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F45H</td>
<td>Address of the parameter to be read is disabled in the access track.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F7FH</td>
<td>Internal error, e.g. illegal ANY reference.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8090H</td>
<td>No module with this address exists or the CPU is in the STOP mode.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8091H</td>
<td>Logical base address not at a double word boundary.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8092H</td>
<td>In the ANY reference, a type other than BYTE is specified. (S7-400 only)</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80A0H</td>
<td>Negative acknowledgment reading from the module.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80A4H</td>
<td>The communication bus connection between the CPU and CP is not established.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80B0H</td>
<td>The module does not recognize the data record.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80B1H</td>
<td>Destination area invalid.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80B2H</td>
<td>The communication bus connection between the CPU and CP is not established.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80C0H</td>
<td>The data record cannot be read.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80C1H</td>
<td>The specified data record is currently being processed.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80C2H</td>
<td>There are too many jobs pending.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80C3H</td>
<td>CPU resources (memory) occupied.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80C4H</td>
<td>Communication error (occurs temporarily and a repetition in the user program will often remedy the problem).</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80D2H</td>
<td>Module base address incorrect.</td>
</tr>
</tbody>
</table>
6.4 FCs for Access Coordination with FETCH/WRITE

Overview

The following FCs are available for FETCH/WRITE function to coordinate access:

<table>
<thead>
<tr>
<th>FC</th>
<th>can be used with:</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>S7 - 300</td>
<td>S7 - 400</td>
</tr>
<tr>
<td>AG_LOCK (FC7)</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>AG_UNLOCK (FC8)</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

Caution when Configuring

If you use FCs AG_LOCK and AG_UNLOCK, you must specify the following information for S7-400 stations in the configuration:

- in HW Config
  In the “Addresses” tab, the option “Address setting for LOCK/UNLOCK” must be selected.

How the Block Works

With these FCs, you can coordinate access to system memory areas so that no inconsistent data are created and transferred. The control is from the user program in the S7 CPU that can, if necessary disable an external FETCH/WRITE access using an AG_LOCK call. After a certain time or after the local write/read access is completed, an AG_UNLOCK job can be used to enable external access again.

Another advantage is that this access lock only applies to the FETCH/WRITE connection specified in the call. If more than one FETCH/WRITE connections are configured, these can, for example, be used for certain specific system areas and a selective access coordination can be implemented.

The following diagram illustrates the usual chronological sequence of memory access coordination controlled in the user program with AG_LOCK and AG_UNLOCK.
The lock job must first be monitored in the user program using the code in the return parameter LOCKED. As long as LOCKED=0 is indicated, it must be assumed that there is still a FETCH/WRITE access active.

If LOCKED=1 is indicated, this shows that the lock is active; data can now be modified by the user program.

The status code is updated at each block call.
6.4.1 FC7 AG_LOCK

Meaning of the Block

Using the AG_LOCK block the data exchange using FETCH or WRITE on the connection selected with the parameter ID is disabled. The LOCKED output indicates whether or not the lock was successful. If the lock was not successful, the job must be triggered again in a later CPU cycle.

The STATUS output indicates the status of the CP for this connection.

Call

Representation of the AG_LOCK Function

Example in STL representation

<table>
<thead>
<tr>
<th>STL</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>call fc 7</td>
<td>//Block call</td>
</tr>
<tr>
<td>ID := DB 100.DBW 2</td>
<td>//Connection ID acc. to configuration</td>
</tr>
<tr>
<td>LADDR := W#16#0100</td>
<td>//LADDR 256 dec. in hardware configuration</td>
</tr>
<tr>
<td>STATUS := DB 100.DBW 4</td>
<td>//Status code</td>
</tr>
<tr>
<td>LOCKED := DB 100.DBX 0.6</td>
<td>//Status code of access disable</td>
</tr>
</tbody>
</table>

Explanation of the Formal Parameters

The following table explains all the formal parameters for the AG_LOCK function:
Parameter | Declaration | Type | Possible Values | Remarks
---|---|---|---|---
ID | INPUT | INT | 1...16 for S7-300 1...64 for S7-400 | The connection number of the connection is specified in the parameter ID. (see Configuration Section 4.3.1)
LADDR | INPUT | WORD | Module base address | When you configure the CP with STEP 7 hardware configuration, the module base address is displayed in the configuration table. Specify this address here.
LOCKED | OUTPUT | BOOL | 0: not (yet) locked 1: locked | Shows the status of the access lock requested on the specified FETCH/WRITE connection.
STATUS | OUTPUT | WORD | see following table | Status code For meaning, refer to the table below.

**Condition Codes**

The following table shows the STATUS code that must be evaluated by the user program.

Table 6-4 AG_LOCK Condition Codes

<table>
<thead>
<tr>
<th>STATUS</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>7000</td>
<td>CP is not processing a job</td>
</tr>
<tr>
<td>7001</td>
<td>FETCH active</td>
</tr>
<tr>
<td>7002</td>
<td>WRITE active</td>
</tr>
<tr>
<td>8183</td>
<td>FETCH/WRITE not configured for this connection</td>
</tr>
<tr>
<td>8186</td>
<td>ID number not in permitted range (e.g. 1...64 with S7-400 Industrial Ethernet CPs)</td>
</tr>
</tbody>
</table>
6.4.2 FC8 AG_UNLOCK

Meaning of the Block

Using the AG_UNLOCK function, the external access to system areas on the S7 CPU with FETCH or WRITE on the connection specified by the ID parameter is released.

The next external FETCH/WRITE job to arrive for the CP can then be processed. The AG_UNLOCK follows an access lock with AG_LOCK.

Call

Representation of the AG_UNLOCK Function

```
AG_UNLOCK
ID
LADDR
STATUS
```

Example in STL representation

<table>
<thead>
<tr>
<th>STL</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>call fc 8</td>
<td>//Block call</td>
</tr>
<tr>
<td>ID := DB 100.DBW 2</td>
<td>//Connection ID acc. to configuration</td>
</tr>
<tr>
<td>LADDR := W#16#0100</td>
<td>//LADDR 256 dec. in hardware configuration</td>
</tr>
<tr>
<td>STATUS := DB 100.DBW 4</td>
<td>//Status code</td>
</tr>
</tbody>
</table>

How the Block Works

To release the connection again, the LOCK request bit must be reset by the FC again. The FC also shows the current status using error messages.

Explanation of the Formal Parameters

The following table explains all the formal parameters for the AG_UNLOCK function:
### Parameter Declaration

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>Type</th>
<th>Possible Values</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>INPUT</td>
<td>INT</td>
<td>1,2...16 for S7-300, 1,2...64 for S7-400</td>
<td>The connection number of the connection is specified in the parameter ID. (see Configuration Section 4.3.1)</td>
</tr>
<tr>
<td>LADDR</td>
<td>INPUT</td>
<td>WORD</td>
<td></td>
<td>Module base address When you configure the CP with STEP 7 hardware configuration, the module base address is displayed in the configuration table. Specify this address here.</td>
</tr>
<tr>
<td>STATUS</td>
<td>OUTPUT</td>
<td>WORD</td>
<td>see following table</td>
<td>Status code For meaning, refer to the table below.</td>
</tr>
</tbody>
</table>

### Condition Codes
The following table shows the STATUS code that must be evaluated by the user program.

<table>
<thead>
<tr>
<th>STATUS</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>7000</td>
<td>CP is not processing a job</td>
</tr>
<tr>
<td>7001</td>
<td>FETCH active</td>
</tr>
<tr>
<td>7002</td>
<td>WRITE active</td>
</tr>
<tr>
<td>8183</td>
<td>FETCH/WRITE not configured for this connection</td>
</tr>
<tr>
<td>8186</td>
<td>ID number not in permitted range (e.g. 1...64 with S7-400 Industrial Ethernet CPs)</td>
</tr>
</tbody>
</table>
6.5 FB55 IP_CONFIG for Programmed Communication Connections

Meaning of the Block

Connections can be specified in a DB (configuration DB) and transferred to the CP with an FB.

You can use this variant of programmed communication connections as an alternative to connection configuration with STEP 7.

Depending on the size of the configuration DB, the data may be transferred to the CP in several segments. This means that the FB must continue to be called until the FB signals complete transfer by setting the DONE bit to 1.

Call

Representation ...

Example in STL representation

<table>
<thead>
<tr>
<th>STL</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>call fb 55</td>
<td>//IP_CONFIG block call</td>
</tr>
<tr>
<td>ACT := M 10.0</td>
<td>//Job triggered by memory bit&lt;</td>
</tr>
<tr>
<td>LADDR := W#16#0100</td>
<td>//LADDR 256 dec. in hardware configuration</td>
</tr>
<tr>
<td>CONF_DB := P#db99.dbx10.0 byte 240</td>
<td>//Data block with connection data</td>
</tr>
<tr>
<td>LEN := MW 14</td>
<td>//Length info for connection data</td>
</tr>
<tr>
<td>DONE := M 10.1</td>
<td>//Executed code</td>
</tr>
<tr>
<td>ERROR := M 10.2</td>
<td>//Error code</td>
</tr>
<tr>
<td>STATUS := MW 16</td>
<td>//Status code</td>
</tr>
<tr>
<td>EXT_STATUS := MW 18</td>
<td>//Cause of error in connection data</td>
</tr>
</tbody>
</table>
How It Works

The following diagram illustrates the normal sequence of connection configuration triggered by an IP_CONFIG in the user program.

The job executes as soon as the parameter ACT is transferred with value 1.

Due to the segmented transfer of the CONF_DB, you must repeat the job with ACT = 1 until completion of the job is indicated in the parameters DONE, ERROR, and STATUS.

If you want to transfer a connection configuration again later, the parameter ACT must first be transferred with value 0 in at least one further call.

Please refer to the sample program in the appendix.

Legend:
1) parameter transfer DONE, ERROR, STATUS

Notice

The data transferred with the configuration DB are stored in volatile memory on the CP and must be downloaded to the CP again following a power down!
### Explanation of the Formal Parameters

The following table explains the formal parameters for the call interface of the IP_CONFIG function block:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>Type</th>
<th>Possible Values</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACT</td>
<td>INPUT</td>
<td>BOOL</td>
<td>0, 1</td>
<td>When the FB is called with ACT = 1, the DBxx is sent to the CP. If the FB is called with ACT = 0, only the status codes DONE, ERROR and STATUS are updated.</td>
</tr>
<tr>
<td>LADDR</td>
<td>INPUT</td>
<td>WORD</td>
<td></td>
<td>Module base address When you configure the CP with STEP 7 hardware configuration, the module base address is displayed in the configuration table. Specify this address here.</td>
</tr>
<tr>
<td>CONF_DB</td>
<td>INPUT</td>
<td>ANY</td>
<td></td>
<td>The parameter points to the start address of the configuration data area in a data block.</td>
</tr>
<tr>
<td>LEN</td>
<td>INPUT</td>
<td>INT</td>
<td></td>
<td>Length information in bytes for the configuration data area.</td>
</tr>
<tr>
<td>DONE</td>
<td>OUTPUT</td>
<td>BOOL</td>
<td>0: – 1: new data</td>
<td>The parameter indicates whether the configuration data area was completely transferred. Remember that it may be necessary to call the FB several times depending on the size of the configuration data area (in several cycles) until the DONE parameter is set to 1 to signal completion of the transfer. For the meaning of this parameter in conjunction with the ERROR and STATUS parameters, refer to the following table.</td>
</tr>
<tr>
<td>ERROR</td>
<td>OUTPUT</td>
<td>BOOL</td>
<td>0: – 1: error</td>
<td>Error code For the meaning of this parameter in conjunction with the NDR and STATUS parameters, refer to the following table.</td>
</tr>
<tr>
<td>STATUS</td>
<td>OUTPUT</td>
<td>WORD</td>
<td>see following table</td>
<td>Status code For the meaning of this parameter in conjunction with the NDR and ERROR parameters, refer to the following table.</td>
</tr>
<tr>
<td>EXT_Status</td>
<td>OUTPUT</td>
<td>WORD</td>
<td></td>
<td>If an error occurs in the execution of a job, the parameter indicates which parameter was detected as the cause of the error in the configuration DB. High byte: Index of the parameter field Low byte: Index of the subfield within the parameter field</td>
</tr>
</tbody>
</table>
### Condition Codes

The following table shows the condition codes formed by the DONE, ERROR and STATUS parameters that must be evaluated by the user program.

#### Table 6-6 Condition Codes for FB55 IP_CONFIG

<table>
<thead>
<tr>
<th>DONE</th>
<th>ERROR</th>
<th>STATUS</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0000H</td>
<td>Job completed without errors</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>8181H</td>
<td>Job active</td>
</tr>
</tbody>
</table>

**General codes relating to job execution**

**Errors detected on the interface between CPU and CP.**

<table>
<thead>
<tr>
<th>DONE</th>
<th>ERROR</th>
<th>STATUS</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>80B1H</td>
<td>The amount of data to be sent exceeds the upper limit permitted for this service. (upper limit = 16 Kbytes)</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80C4H</td>
<td>Communication error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The error can occur temporarily; it is usually best to repeat the job in the user program.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>80D2H</td>
<td>Configuration error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The module you are using does not support this service.</td>
</tr>
</tbody>
</table>

**Errors detected in the evaluation of the FB in the CPU or on the interface between CPU and CP.**

<table>
<thead>
<tr>
<th>DONE</th>
<th>ERROR</th>
<th>STATUS</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>8183H</td>
<td>The CP rejects the requested data record number.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8184H</td>
<td>System error or illegal parameter type&lt; F 9&gt;. (data type of the ANY pointers CONF_DB not OK)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(Currently only the byte data type is accepted)</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8185H</td>
<td>The value of the LEN parameter is larger than the CONF_DB less the reserved header (4 bytes) or the length information is incorrect.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8186H</td>
<td>Illegal parameter detected</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The ANY pointer CONF_DB does not point to a data block.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8187H</td>
<td>Illegal status of the FB</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Data in the header of CONF_DB was possibly overwritten.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>or:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The instance DB does not exist.</td>
</tr>
</tbody>
</table>

**Further errors detected on the interface between the CPU and CP.**

<table>
<thead>
<tr>
<th>DONE</th>
<th>ERROR</th>
<th>STATUS</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>8A01H</td>
<td>The status code in the data record is invalid (value is &gt;= 3).</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8A02H</td>
<td>There is no job running on the CP; the FB, however, expected an acknowledgment for a completed job.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8A03H</td>
<td>There is no job running on the CP and the CP is not ready; the FB triggered the first job to read a data record.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8A04H</td>
<td>There is no job running on the CP and the CP is not ready; the FB nevertheless expected an acknowledgment for a completed job.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8A05H</td>
<td>There is a job running, but there was no acknowledgment; the FB nevertheless triggered the first job for a read data record job.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8A06H</td>
<td>A job is complete but the FB nevertheless triggered the first job for a read data record job.</td>
</tr>
</tbody>
</table>
### Condition Codes for FB55 IP_CONFIG, continued

<table>
<thead>
<tr>
<th>DONE</th>
<th>ERROR</th>
<th>STATUS</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>8B01</td>
<td>Communication error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The DB could not be transferred</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8B02</td>
<td>Parameter error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Double parameter field</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8B03</td>
<td>Parameter error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The subfield in the parameter field is not permitted.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8B04</td>
<td>Parameter error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The length specified in the FB does not match the length of the parameter fields / subfields.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8B05</td>
<td>Parameter error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The length of the parameter field is invalid.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8B06</td>
<td>Parameter error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The length of the subfield is invalid.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8B07</td>
<td>Parameter error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The ID of the parameter field is invalid.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8B08</td>
<td>Parameter error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The ID of the subfield is invalid.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8B09</td>
<td>System error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The connection does not exist</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8B0A</td>
<td>Data error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The content of the subfield is not correct.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8B0B</td>
<td>Structure error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A subfield exists twice.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8B0C</td>
<td>Data error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The parameter does not contain all the necessary parameters.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8B0D</td>
<td>Data error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The CONF_DB does not contain a parameter field for system data.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8B0E</td>
<td>Data error / structure error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The CONF_DB type is invalid.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8B0F</td>
<td>System error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The CP does not have enough resources to process CONF_DB completely.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8B10</td>
<td>Data error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Configuration by the user program is not set.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8B11</td>
<td>Data error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The specified type of the parameter field is invalid.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8B12</td>
<td>Data error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Too many connections were specified (either in total or too many for a specific type; for example, only one E-mail connection is possible).</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8B13</td>
<td>CP-internal error</td>
</tr>
</tbody>
</table>

Further errors detected on the program interfaces within the CPU (SFC errors).
Table 6-6  Condition Codes for FB55 IP_CONFIG, continued

<table>
<thead>
<tr>
<th>DONE</th>
<th>ERROR</th>
<th>STATUS</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>8F22H</td>
<td>Area length error reading a parameter (e.g. DB too short).</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F23H</td>
<td>Area length error writing a parameter (e.g. DB too short).</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F24H</td>
<td>Area error reading a parameter.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F25H</td>
<td>Area error writing a parameter.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F28H</td>
<td>Alignment error reading a parameter.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F29H</td>
<td>Alignment error writing a parameter.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F30H</td>
<td>The parameter is in the write-protected first current data block.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F31H</td>
<td>The parameter is in the write-protected second current data block.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F32H</td>
<td>The parameter contains a DB number that is too high.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F33H</td>
<td>DB number error</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F3AH</td>
<td>The target area was not loaded (DB).</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F42H</td>
<td>Timeout reading a parameter from the I/O area.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F43H</td>
<td>Timeout writing a parameter to the I/O area.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F44H</td>
<td>Address of the parameter to be read is disabled in the access track.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F45H</td>
<td>Address of the parameter to be written is disabled in the access track.</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>8F7FH</td>
<td>Internal error</td>
</tr>
</tbody>
</table>

For example, an illegal ANY reference was detected.
6.6 Numeric Data / Resource Requirements of the FCs

Notice
Please note the version information of the blocks. Blocks with other versions have different resource requirements.

Table 6-7 Information for FCs with an S7-400

<table>
<thead>
<tr>
<th>NAME</th>
<th>Version</th>
<th>FC no.</th>
<th>Load memory bytes</th>
<th>Work memory bytes</th>
<th>MC7 Bytes</th>
<th>Local data Bytes</th>
</tr>
</thead>
<tbody>
<tr>
<td>AG_SEND</td>
<td>1.1</td>
<td>5</td>
<td>732</td>
<td>576</td>
<td>540</td>
<td>20</td>
</tr>
<tr>
<td>AG_RECV</td>
<td>1.1</td>
<td>6</td>
<td>656</td>
<td>522</td>
<td>486</td>
<td>20</td>
</tr>
<tr>
<td>AG_LOCK</td>
<td>1.0</td>
<td>7</td>
<td>272</td>
<td>200</td>
<td>164</td>
<td>6</td>
</tr>
<tr>
<td>AG_UNLOCK</td>
<td>1.0</td>
<td>8</td>
<td>256</td>
<td>186</td>
<td>150</td>
<td>6</td>
</tr>
<tr>
<td>AG_LSEND</td>
<td>3.0</td>
<td>50</td>
<td>1044</td>
<td>846</td>
<td>810</td>
<td>52</td>
</tr>
<tr>
<td>AG_LRECV</td>
<td>3.0</td>
<td>60</td>
<td>1190</td>
<td>992</td>
<td>956</td>
<td>58</td>
</tr>
</tbody>
</table>

Table 6-8 Information for FCs / FBs with an S7-300

<table>
<thead>
<tr>
<th>NAME</th>
<th>Version</th>
<th>FC no.</th>
<th>Load memory bytes</th>
<th>Work memory bytes</th>
<th>MC7 Bytes</th>
<th>Local data Bytes</th>
</tr>
</thead>
<tbody>
<tr>
<td>AG_SEND</td>
<td>4.1</td>
<td>5</td>
<td>1916</td>
<td>1610</td>
<td>1574</td>
<td>50</td>
</tr>
<tr>
<td>AG_RECV</td>
<td>4.5</td>
<td>6</td>
<td>1408</td>
<td>1174</td>
<td>1138</td>
<td>40</td>
</tr>
<tr>
<td>AG_LOCK</td>
<td>4.0</td>
<td>7</td>
<td>748</td>
<td>636</td>
<td>600</td>
<td>34</td>
</tr>
<tr>
<td>AG_UNLOCK</td>
<td>4.0</td>
<td>8</td>
<td>712</td>
<td>604</td>
<td>568</td>
<td>32</td>
</tr>
<tr>
<td>IP_CONFIG</td>
<td>1.0</td>
<td>55</td>
<td>2062</td>
<td>1694</td>
<td>1648</td>
<td>52</td>
</tr>
</tbody>
</table>
The NCM S7 Diagnostics described here provides dynamic information on the operating state of the communication functions of online CPs.

This chapter provides a general overview of the individual diagnostic functions.

The following checklist will help you to recognize several typical problems and their possible causes and shows how you can use the NCM S7 for PROFIBUS diagnostics tool to remedy the situation.

Further information is available from the following sources:

- When you are working with the diagnostic tool, the integrated help system provides you with context-related support.
- You will find detailed information on working with STEP 7 programs in the Help on STEP 7, which includes the topic “Diagnosing Hardware”

**Note**

NCM S7 Diagnostics supports not only diagnostics for CPs (communication modules) but also other module types such as the IE/PB Link. In this chapter, the term CP is therefore synonymous with all modules with which you can run NCM S7 diagnostic functions.
7.1 Overview

Diagnostic Options in STEP 7

STEP 7 provides you with a graded concept allowing you to query information about the status of your SIMATIC S7 components and functions and to sort out problems in a variety of different situations. These options cover the following:

- **Hardware Diagnostics and Troubleshooting with STEP 7**
  Hardware diagnostics provides dynamic information on the operating mode of modules including CPs when the S7 station is online.

  You can recognize the existence of diagnostic information for a module by the diagnostics icon in the project window of the SIMATIC Manager. Diagnostic icons show the status of the corresponding module and also the operating mode of CPUs.

  Detailed diagnostic information is displayed in the "module information" that you can open by double-clicking a diagnostic icon in the quick view or the diagnostic view.

- **Communication Diagnostics with NCM S7 Diagnostics**
  The NCM S7 Diagnostics described here provides dynamic information on the operating state of the communication functions of online CPs or modules.

- **HW Config Provides Static Information**
  Static information means the configured communication properties of an online or offline CP and you can display this at any time using the hardware configuration shown by HW Config.

What You Should Already Know

You should be familiar with the basic information in Chapter 2 on the significance of NCM 7 and working with it. This means that you know how to connect the Ethernet CP to the PG and how to control the module using the PG.

Where to Find Further Information

Further information is available from the following sources:

- Information about the communication services is available in the appropriate chapters in this manual.

- When you are working with the diagnostic tool, the integrated help system provides you with context-related support.

- You will find detailed information on working with STEP 7 programs in the Help on STEP 7, which includes the topic “Diagnosing Hardware”.
7.2 Functions of NCM S7 Diagnostics

Functions

The diagnostic functions can be grouped as follows:

- General diagnostic and statistical functions
- Type and mode-dependent diagnostic functions

General diagnostic and statistical functions

Regardless of the configured mode of the Ethernet CP, the following diagnostic functions are possible:

- Querying the operating mode on Ethernet
- Querying the event messages recorded on the Ethernet CP (diagnostic buffer)

Mode-Dependent Functions

Depending on the configured mode of the Ethernet CP, the following diagnostic functions are possible:

- Diagnostics of ISO transport connections
- Diagnostics of ISO-on-TCP connections
- Diagnostics of TCP connections
- Diagnostics of UDP connections
- Diagnostics of E-mail connections
- Diagnostics of TCP connections for PROFINET
7.2.1 Installing and Starting NCM S7 Diagnostics

Installation

NCM S7 Diagnostics is an integrated component of the NCM S7 for Industrial Ethernet optional package.

NCM S7 Ethernet Diagnostics is installed along with NCM S7 for Ethernet on your PG.

There are several ways in which you can start the diagnostic tool:

Alternative 1
- From the standard Start menu of Windows (program group SIMATIC...NCM).

Alternative 2
- From the Properties dialog of the CP within your STEP 7 project.
Structure

In the same way, for example, as the SIMATIC Manager, NCM S7 Diagnostics appears as a separate two-part application window with a menu and toolbar:

- In the **navigation area** on the left-hand side, you will find the hierarchically arranged diagnostic objects.
  
  You have an overview of the available diagnostic functions at all times. The object structure displayed in the navigation area is adapted to the type of CP you are currently checking and the functions and connections configured for the CP.

- In the **content area**, on the right-hand side, you will see the result of the diagnostic function you selected in the navigation area.

Operation

- By selecting a diagnostic object in the navigation area with the mouse, you execute the diagnostic function.

- Using the **menu bar and toolbar**, you control the sequence of the diagnostics with context-sensitive menu commands.
7.2.2 General Menu Commands

Overview
When running diagnostic functions, the following menu commands have general significance. Depending on the context, other functions may be available; for more detailed information refer to the online help for NCM Diagnostics.

Table 7-1 Meaning of the Menu Commands

<table>
<thead>
<tr>
<th>Menu</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagnostics ▶ Open Online Connection...</td>
<td>With this menu command, you can establish a connection to a different CP you want to check without having to quit and restart the diagnostic tool. The current diagnostic connection is closed. If you want to use more than one diagnostic connection at the same time, you can start NCM S7 diagnostics more than once.</td>
</tr>
<tr>
<td>Diagnostics ▶ Close Online Connection...</td>
<td>You can control the CP as follows:</td>
</tr>
<tr>
<td>Operating Mode ▶ Stop a module</td>
<td>Stops the CP.</td>
</tr>
<tr>
<td>Operating Mode ▶ Start a module</td>
<td>Starts the CP if the RUN/STOP switch is set to RUN.</td>
</tr>
<tr>
<td>Reset module memory</td>
<td>With certain CP types, for example the CP 443-1, you can reset the CP memory. This function must be confirmed before it is executed. Following this memory reset, the CP retains the preset MAC address and the retentive parameters. The CP is therefore immediately ready for downloads. The retentive parameters include:</td>
</tr>
<tr>
<td></td>
<td>• IP address and IP parameters</td>
</tr>
<tr>
<td></td>
<td>• A newly set MAC address</td>
</tr>
<tr>
<td></td>
<td>• LAN settings</td>
</tr>
<tr>
<td>Resetting to factory settings</td>
<td>With some modules, it is possible to reset to the factory settings. When you reset to the factory settings, the retentive parameters are also deleted. After this, the module retains only the factory-set MAC address (as shipped).</td>
</tr>
<tr>
<td>View ▶ Update</td>
<td>Each time you activate this menu command, the displayed diagnostic and status information is updated once.</td>
</tr>
<tr>
<td>View ▶ Update Cyclically</td>
<td>Using this menu command, you activate and deactivate the automatic (cyclic off) updating of the displayed diagnostic and status information. You can set the interval between update points with the menu command Options ▶ Customize.</td>
</tr>
</tbody>
</table>
### Table 7-1 Meaning of the Menu Commands

<table>
<thead>
<tr>
<th>Menu</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| Options /C0034 Customize | With this menu command, you set the general parameters for the diagnostic session.  
|               | On Ethernet:  
|               | • Dialog update time  
|               | This sets the interval at which the diagnostic data are updated in a contents area when cyclic updating is selected.                      |  
| Help          | You can obtain help about the current diagnostic function As an alternative, you can also press the F1 key.  
|               | Remember that you can also call up context-related help for some of the diagnostic functions. To obtain help, position the cursor on the output field and press the F1 key. |

### Note

If the connection to the CP is terminated during the diagnostic session, the following message is displayed: “The online connection was terminated”.

You can reestablish the connection to the CP with the corresponding acknowledgment in the dialog. The connection is then automatically reestablished whenever possible.
7.3 Starting Diagnostics

7.3.1 Establishing a Connection to the Ethernet CP

Initial Situation
Establish the physical connection between the PG and the SIMATIC S7 Station. There are two ways of doing this:
- MPI
- Industrial Ethernet (ISO protocol)
- Industrial Ethernet TCP/IP (IP protocol)
- PROFIBUS

Ways of Starting Diagnostics
You can start NCM Diagnostics from the following STEP 7 functions or dialogs:
- CP properties dialog
- Windows Start menu
- Connections properties dialog (NetPro)
- Hardware configuration HW Config
These possibilities are described below.

7.3.2 Starting Diagnostics from the CP Properties Dialog
If the project data are available on your PG/PC, follow the steps outlined below:
1. Select the S7 station in the project and open the hardware configuration (HW Config).
2. Select the CP and open the Properties dialog.
3. Select the “Diagnostics” dialog.
4. Select the “Run” button.
Result:
NCM S7 Diagnostics is opened. The path is set automatically to match the current connection in STEP 7.
7.3.3 Starting Diagnostics from the Windows Start Menu

If there are no configuration data on your PG/PC, follow the steps outlined below to start diagnostics with a connected CP:

1. Open the Windows Start menu and select the command SIMATIC ➤ STEP 7 ➤ Diagnostics

   NCM S7 Diagnostics is started with the message “No online connection to the CP” in the contents area.

2. In the displayed dialog “NCM S7 Diagnostics”, select the interface to match your hardware configuration.

   Depending on the type of network attachment you have, you will be prompted to specify an address:

Table 7-2 Possible Settings for the Online Paths – without Parameters for Internetworking

<table>
<thead>
<tr>
<th>Attachment on Destination Station</th>
<th>Node Address</th>
<th>Location of the Module Rack / Slot</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPI</td>
<td>MPI address of the CP if this has its own MPI address. Otherwise specify the MPI address of the CPU.</td>
<td>Rack/slot no. of the CP to be checked. If you specify the MPI address of the CP, you can simply use the default setting “0/0”. With this setting, the CP whose address was specified as the node address is accessed.</td>
</tr>
<tr>
<td>PROFIBUS</td>
<td>PROFIBUS address of the PROFIBUS CP via which the S7 station is reached.</td>
<td>Rack/slot no. of the CP to be checked.</td>
</tr>
<tr>
<td>Industrial Ethernet</td>
<td>MAC address of the Ethernet CP via which the S7 station is reached. Entered in hexadecimal.</td>
<td>Rack/slot no. of the CP to be checked. If you specify “0/0”, the CP specified with the node address is accessed directly.</td>
</tr>
<tr>
<td>Industrial Ethernet TCP/IP</td>
<td>IP address of the Industrial Ethernet CP via which the S7 station is reached. Entered in decimal. Example: IP address decimal 142.120.9.134</td>
<td>Rack/slot no. of the CP to be checked. If you specify “0/0”, the CP specified with the node address is accessed directly.</td>
</tr>
</tbody>
</table>
Examples of an Online Path without Gateway

Figure 7-1 CP requiring diagnostics can be reached directly

Figure 7-2 The CP requiring diagnostics is accessible indirectly over another CP
7.3.4 Using a Gateway

Case a: One gateway

If the CP you want to check with diagnostic functions can only be reached via a gateway, you must select the device and specify its node address in the local network.

You must also specify the S7 subnet ID of the destination network:

The subnet ID consists of two numbers separated by a dash:
- One number for the project
- One number for the subnet

You will find the subnet ID in the object properties of the subnet in the STEP 7 project. The subnet ID is also printed out with the network configuration.

Figure 7-3 Example of the Parameter Settings for the Online Path with one Gateway
Case b: Several Gateways

If the CP requiring diagnostics can only be reached over several gateways, you only specify the first gateway.

Routing over the other gateways is done automatically.

Figure 7-4 Example of the Parameter Settings for the Online Path with Several Gateways
7.3.5 Using the PC Station – Setting a Gateway with “PC internal”

There is a special situation when you use your PC/PG as a PC station and have therefore set the interface to PC internal (local) in “Setting the PG/PC Interface”. You must then set parameter values for the gateway, even when you do not need to go through any other gateway to reach the target station.

Select the following settings:

- Gateway attachment: MPI/PROFIBUS/AUTO
- Node address (gateway)
  Enter the index of the module here.
  The index is the virtual slot address of the component (can be displayed using the Station Configuration Editor). The index is identical to the slot number selected during configuration of the PC station in STEP 7 HW Config!
- S7 subnet ID of destination network:
  Follow the same steps as described for setting the gateway.

Tip:
You do not need to make these settings for the gateway if you select one of the following options:

- Start NCM Diagnostics from the Properties dialog of the CP.
- When setting up your module, do not select the interface as PC internal (local) in “Set PG/PC Interface”.

Figure 7-5 Example of Settings with “PC internal”
7.3.6 Other Ways of Starting Diagnostics

Starting in the properties dialog of the connections:
1. Select the PLC\Activate Connection Status menu command to activate online access.
2. Select the “Special Diagnostics” button in the “Status Information” tab.

Starting in the hardware configuration tool HW Config:
1. With the S7 station online, select the PLC\Module Status menu command;
2. Select the “Special Diagnostics” button in the dialog that is opened.

Note
To operate several diagnostic connections at the same time, you can start NCM S7 Diagnostics more than once.

You can also start NCM S7 Diagnostics twice with an online connection to the same CP; this can, for example, be useful if you want to monitor the diagnostic buffer at the same time as running diagnostic functions on a connection.

Requirement: You have an online connection available via the LAN (ISO or TCP/IP) on the one hand and an online connection via the communication (K) bus on the other (alternatively via the CPU or via PG channel routing via a further CP).
7.4 How to Use Diagnostics

Procedure

To use diagnostics efficiently, particularly when working with the diagnostic tool for the first time, the following procedure can be recommended.

1. Use the sequence shown below as a basis for using diagnostics:

   Start NCM S7 Diagnostics:
   - Establish the connection to the CP (Section 7.3
   - Set the options (Section 7.2.2)
   - Identify the Ethernet CP

   Query the current status of the CP
   "Operating Mode" diagnostic object

   If the CP is not in the RUN mode
   
   TCP connections
   ISO transport connections/
   ISO-on-TCP connections
   UDP connections

   If anything unusual is displayed for
   - connection status
   - receive status,
   - send status

   View / evaluate the diagnostic buffer to obtain an overview and detailed explanation of diagnostic events.

   If necessary, correct configuration or programming.

   If the CP is in the RUN mode

2. Clarify your problem or task using the check list in Section 7.6 and select the diagnostic function based on the recommendation there.
7.5 Starting Diagnostic Functions Explicitly

The following table shows the diagnostic options that exist in the available functions.

Table 7-3  General Diagnostic and Statistical Functions

<table>
<thead>
<tr>
<th>Diagnostic Functions / Diagnostic Object</th>
<th>Diagnostic Aims</th>
<th>Special Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP information</td>
<td>The aim is to identify the CP to which NCM S7 Diagnostics is connected and to find out the current mode.</td>
<td></td>
</tr>
<tr>
<td>Mode</td>
<td>Here, the aim is to find out the current operating mode of the Ethernet CP as a module in the S7-300/400 and as a node on Industrial Ethernet and, if necessary, to modify the mode (menu command <strong>Operating Mode</strong> &gt; <strong>Stop Module</strong> / <strong>Start Module</strong> / <strong>Reset Memory</strong> / <strong>Reset to Factory Settings</strong>).</td>
<td></td>
</tr>
<tr>
<td>Diagnostic buffer</td>
<td>General error diagnostics using diagnostic buffers</td>
<td>Event messages are recorded on the CP in a ring buffer. The ring buffer can contain up to 50 entries. In NCM S7, on the other hand, up to 500 messages can be saved! All the CP functions can generate event messages. When you call the diagnostic object, the messages are read out and displayed. The latest message is displayed in the top line with the highest consecutive number. If you double-click a previously selected event message, you display a help text explaining the message in greater detail.</td>
</tr>
<tr>
<td></td>
<td>To display and decode event messages recorded on the CP in detail. The diagnostic buffer provides you with detailed information about all the communication services of the CP.</td>
<td></td>
</tr>
</tbody>
</table>
Table 7-4  Mode-Dependent Functions

<table>
<thead>
<tr>
<th>Diagnostic Functions / Diagnostic Object</th>
<th>Diagnostic Aims</th>
<th>Special Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>• Overview of All Connection Types Used</td>
<td>By double-clicking the objects in the contents area, you can display detailed information.</td>
</tr>
<tr>
<td>Connections Type</td>
<td>• Overview of all the communication connections of a particular type, for example all TCP connections; • Information on the connection status</td>
<td></td>
</tr>
<tr>
<td>Connections Type Type connection-n</td>
<td>• Detailed information about the status of a communication connection.</td>
<td></td>
</tr>
</tbody>
</table>

To display and monitor communication connections. You obtain an overview or detailed information in the contents area depending on the diagnostic object you select.
7.6 Checklist for “Typical Problems” in a System

Meaning

The following lists contain several typical problems and their possible causes and how you can use the NCM S7 Ethernet Diagnostics tool to remedy the situation.

The checklists deal with the following topics:

1. Checklist for General CP Functions
2. Communication Connections Checklist

Note

In the column “Identifying the Cause and Remedy”, you will see the diagnostic function recommended for dealing with the problem shown in bold face.
### 7.6.1 Checklist for General CP Functions

Table 7-5  Checklist for Typical Problems When Operating a CP in a System

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Identifying the Cause and Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Ethernet CP will not change to the RUN mode.</td>
<td>Invalid configuration loaded on the Ethernet CP.</td>
<td>Yellow STOP LED and red SF LED lit continuously.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Call up the diagnostic buffer in NCM S7 Ethernet Diagnostics.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example of an entry</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CP STOP due to invalid CP parameter assignment</td>
</tr>
<tr>
<td></td>
<td></td>
<td>What to do:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Correct the configuration of the Ethernet CP.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>What to do:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Change the switch to RUN on the Ethernet CP</td>
</tr>
<tr>
<td>Switch set to STOP on the Ethernet CP.</td>
<td>Query the operating mode in NCM S7 Diagnostics.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Operating mode: STOP, Cause: switch set to STOP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>What to do:</td>
<td>Change the switch to RUN on the Ethernet CP</td>
</tr>
</tbody>
</table>
## 7.6.2 Communication Connections Checklist

Table 7-6 Checklist for Typical Problems with ISO Transport / ISO-on-TCP / UDP Connections

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Identifying the Cause and Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>No data transfer on an ISO transport connection / ISO-on-TCP connection or only in one direction.</td>
<td>AG-SEND and AG-RECV are not called in the user program. or Receive or send buffer too small or incorrect.</td>
<td>Check the user program. Evaluate status bytes in AG-SEND and AG-RECV. What to do: If necessary, configure FC blocks. If necessary, correct ANY pointer.</td>
</tr>
<tr>
<td></td>
<td>The connection is not established.</td>
<td>Evaluate status bytes of the FC blocks or evaluate diagnostic buffer. What to do: Change the address parameters (MAC/IP address, TSAP).</td>
</tr>
<tr>
<td>Data transfer too slow</td>
<td>Receiving device too slow</td>
<td>Evaluate diagnostic buffer.</td>
</tr>
<tr>
<td>The complete data field is not sent on an ISO transport / ISO-on-TCP/UDP connection.</td>
<td>LEN parameter for AG-SEND is set to the wrong value.</td>
<td>What to do: Set the LEN parameter to the required size.</td>
</tr>
<tr>
<td>The complete data field is not sent on an ISO transport / ISO-on-TCP/UDP connection.</td>
<td>The buffer specified with the ANY pointer is too small.</td>
<td>What to do: Correct the LEN parameter and the ANY pointer.</td>
</tr>
</tbody>
</table>
Firmware Loader

This chapter will familiarize you with the uses and handling of the Firmware Loader.

The Firmware Loader allows you to download more recent firmware versions to the SIMATIC NET modules.

For more detailed information on the various load options, refer to the integrated help.
8.1 Application

Firmware

Here, firmware means the system programs in the SIMATIC NET modules.

Uses of the Firmware Loader

The Firmware Loader allows you to download more recent firmware versions to the SIMATIC NET modules. It is used on the following:

- PROFIBUS modules
- Industrial Ethernet modules
- Modules for Gateways (for example, IE/PB Link)

Installation

The firmware loader is available when you have installed NCM S7 on your PG/PC.

Load Files

The Firmware Loader supports the following file types:

- **<file>.FWL**
  
  A file form that contains information that can be displayed in the dialogs of the Firmware Loader in addition to the LAD file form.

- **<file>.LAD**
  
  A file format containing only the system program that can be downloaded to the module.

For detailed information, read the documentation, for example, the README file shipped with the load file.

This information is displayed even after reading in the FWL file into the firmware loader.

Working with the Firmware Loader

Depending on the module type, the downloading is prepared and executed in three or four steps.

For more detailed information, refer to the next section and the dialog boxes themselves.
8.2 Loading Firmware

Starting the Download

Open the Windows Start menu and select the menu command SIMATIC ➤ STEP 7 ➤ NCM S7 Industrial Ethernet ➤ Firmware Loader.

Select the Next button and follow the instructions displayed in the dialog box.

Caution

Make sure that the load file you are using is intended as an update for the version of the firmware contained on your module. If you are in any doubt, contact your local Siemens advisor.

Caution

Remember that interrupting the download can lead to an inconsistent state on the module!

For more detailed information on the various load options, refer to the integrated help.
References

/1/
Product information bulletin / manual SIMATIC NET CP
Supplied with the specific CP
Siemens AG

/2/
NCM S7 for PROFIBUS Primer
Part
– of the documentation package NCM S7 for PROFIBUS
– of the online documentation in the STEP 7 optional package NCM S7 for PROFIBUS
SIEMENS AG

/3/
NCM S7 for Industrial Ethernet Manual
Part
– of the documentation package NCM S7 for Industrial Ethernet
– of the online documentation in the STEP 7 optional package NCM S7 for Industrial Ethernet
SIEMENS AG

/4/
SIMATIC NET , Manual
Commissioning PC Stations
Part
– of the documentation package NCM S7 for Industrial Ethernet
– of the online documentation in the STEP 7 optional package NCM S7 for Industrial Ethernet
Siemens AG
References

/5/
SIMATIC NET IT-CP, manual
Part
– of the documentation package NCM S7 for Industrial Ethernet
– of the online documentation in the STEP 7 optional package NCM S7 for Industrial Ethernet
Siemens AG

/6/
SIMATIC STEP Configuring Hardware and Connections with STEP 7
Part of the standard STEP 7 Documentation Package
Part of the online documentation in STEP 7
SIEMENS AG

/7/
Communication with SIMATIC
Manual
SIEMENS AG

/8/
SIMATIC Programming with STEP 7
Part of the standard STEP 7 Documentation Package
Part of the online documentation in STEP 7
SIEMENS AG

/9/
SIMATIC STEP 7 Reference Manuals with manuals
– LAD / FBD / STL
– System Software for S7-300/400 System and Standard Functions
Part of the online documentation in STEP 7
Siemens AG

/10/
SIMATIC NET Industrial Twisted Pair Networks
SIEMENS AG

/11/
Ethernet, IEEE 802.3
(ISO 8802-3)
References

/12/
SINEC CP 1413
Manuals for MS-DOS, Windows
SIEMENS AG

/13/
SIMATIC S7
S7-300 Programmable Controller
Hardware and Installation
Manual
SIEMENS AG

/14/
SIMATIC NET Manual for Triaxial Networks
SIEMENS AG

/15/
SIMATIC NET Ethernet Manual
SIEMENS AG

/16/
Lokale Netze –
Kommunikationsplattform der 90er Jahre
Andreas Zenk
Addison-Wesley
ISBN 3-89319-567-X

/17/
TCP/IP
Internet-Protokolle im professionellen Einsatz
Mathias Hein
International Thomson Publishing
ISBN 3-8266-400-4
ITP Online-Center: http://www.ora.de

/18/
RFC1006 (Request For Comment)
References

/19/
RFC793 (TCP)

/20/
RFC791 (IP)

/21/
Berger, Hans
Automation with STEP 7
SIMATIC S7-300/400 Programmable Logic Controllers

/22/
For configuring PROFINet components and systems:
Basic help in the SIMATIC iMap engineering tool

/23/
For configuring PROFINet components and systems:
Component based Automation – Configuring Systems with SIMATIC iMap
Manual

/24/
SIMATIC S7
Programmable Controller
S7-400, M7-400
Hardware and Installation

Order Numbers

The order numbers for the SIEMENS documentation listed above can be found in the catalogs “SIMATIC NET Industrial Communication, Catalog IK PI” and “SIMATIC Programmable Controllers SIMATIC S7 / M7 / C7”.
You can obtain these catalogs and any further information you require from your local SIEMENS office or national head office.
Some of the documents listed here are also on the Manual Collection CD supplied with every S7-CP.
## Glossary

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>B.1</td>
<td>General Section</td>
<td>234</td>
</tr>
<tr>
<td>B.2</td>
<td>Industrial Ethernet</td>
<td>238</td>
</tr>
<tr>
<td>B.3</td>
<td>PROFINet</td>
<td>240</td>
</tr>
</tbody>
</table>
B.1 General Section

Baud rate

--> transmission rate

Broadcast

A broadcast is like “calling all stations”: Using one broadcast frame, you can reach all nodes that are prepared to accept broadcast frames.

Bus segment

Part of a --> subnet. Subnets can consist of bus segments and connectivity devices such as repeaters and bridges. Segments are transparent for addressing.

Client

A client is a device or, in general terms, an object that requests a service from a --> server.

Configuration data

Parameters that determine the modes and functions of a --> CP. They are set and downloaded using the NCM S7 configuration tool.

CP

Communications Processor. Module for communications tasks.

CSMA/CD

CSMA/CD (Carrier Sense Multiple Access with Collision Detection); a transmission technique.

Frame

A message from one PROFIBUS/Ethernet station/node to another.

Frame header

A frame header consists of an identifier for the --> frame and the source and destination address.

Frame trailer

A frame trailer consists of a checksum and the end identifier of the --> frame.
Functions (FCs)
STEP 7 code blocks of the type “function”.

Gateway
Intelligent connectivity device that connects local area networks of different types at the ISO Layer 7 level.

Industrial Ethernet
A LAN system complying with IEEE 802.3 (ISO 8802-2)

Multicast
A multicast is like "calling all group stations": Using one multicast frame, you can reach all the nodes that belong to the multicast group and that are prepared to receive frames.

NCM S7 for Industrial Ethernet
Configuration software for configuration and diagnostic functions on an Ethernet CP.

NCM S7 for PROFIBUS
Configuration software for configuration and diagnostic functions on a PROFIBUS CP.

Network
A network consists of one or more interconnected subnets with any number of nodes. Several networks can exist side by side.

PG operation
A mode of the PROFIBUS/Ethernet CP in which the SIMATIC S7-CPU is programmed, configured or diagnosed over PROFIBUS/Ethernet. This mode is handled by the S7 functions.

PROFInet
Standard of the PROFIBUS Users organization defining a heterogeneous communications and engineering model.

Protocol
A set of rules for transferring data. Using these rules, both the formats of the frames and the data flow are specified.
Process image
The process image is a special memory area in the programmable logic controller. At the start of the cyclic program, the signal states of the input modules are transferred to the process input image. At the end of the cyclic program, the process output image is transferred as a signal state to the output modules.

Segment
Synonym for → Bus segment.

Services
Services provided by a communication protocol.

Server
A server is a device, or in general terms, an object that provides certain services. A service is started at the instigation of a → client.

SIMATIC NET
Siemens SIMATIC Network and Communication. Product name for → networks and network components from Siemens. (previously SINEC)

SIMATIC NET Ind. Ethernet
SIMATIC NET LAN system for industrial applications based on Ethernet. (previously SINEC H1)

SINEC
Previous product name for → networks and network components from Siemens. Now: SIMATIC NET

Station
A station is identified by a
- MAC address in the Ethernet network
- PROFIBUS address in the PROFIBUS network
Subnet
A subnet is part of a network whose parameters (for example PROFIBUS) must be matched. The subnet includes bus components and all the attached stations. Subnets can, for example, be connected together by gateways to form a network.

A system consists of several subnets with unique subnet numbers. A subnet consists of several stations with unique PROFIBUS or MAC addresses (Industrial Ethernet).

System
This means all the electrical equipment within a system. A system includes, among other things, programmable logic controllers, devices for operation and monitoring, bus systems, field devices, actuators, supply lines.

Transport layer
The transport layer is layer 4 of the ISO/OSI reference model for open system interconnection. The purpose of the transport layer is to transfer data reliably from device to device. Transport connections can be used for the transmission.

Transport interface
The transport interface of a SIMATIC S5 PLC is the access to the connection-oriented services of the transport layer on the CP. The transport interface presents itself to the control program in the form of handling blocks (HDBs).

TSAP
Transport Service Access Point

Transmission rate
According to DIN 44302, this is the number of binary decisions transmitted per time unit. The unit is bps. The set or selected transmission rate depends on various conditions, for example the distance across the network.

Watchdog
Mechanism for monitoring operability.
B.2 Industrial Ethernet

Base address
Logical address of a module in S7 systems.

- For PROFIBUS
  The PROFIBUS base address is the address starting at which all addresses that are calculated automatically in the project are assigned.

- For Industrial Ethernet
  The base MAC address is the address starting at which all addresses that are calculated automatically in the project are assigned.

Ind. Ethernet station
A station is identified by a MAC address in Industrial Ethernet.

ISO-on-TCP
Transport layer connection (layer 4 communication complying with ISO) simulated on TCP.

On an ISO-on-TCP connection, messages can be exchanged in both directions. TCP provides the data flow communication without segmenting the data into messages. ISO, on the other hand, is message-oriented. With ISO-on-TCP, this mechanism is simulated on TCP. This is described in RFC1006 (Request For Comment).

ISO-on-TCP connections allow program/event-controlled communication via Ethernet from a SIMATIC S7 PLC to

- SIMATIC S7 PLC with Ethernet CP
- SIMATIC S5 PLC with Ethernet CP
- PC/PG with Ethernet CP
- any system
ISO Transport Connection
Communication connection of the transport layer (with the CP/COM 143 previously S5S5 connection).
ISO transport connections allow program/event-controlled communication on Industrial Ethernet between SIMATIC S7 PLCs and
- SIMATIC S7 PLC with Ethernet CP
- SIMATIC S5 with an Ethernet CP (e.g. CP 143 or CP 1430)
- PC/PG with Ethernet CP (for example CP 1613)
- Any system using the ISO transport protocol (ISO 8073)
The transfer of blocks of data on an ISO transport connection is bi-directional.

MAC address
Address to distinguish between different stations connected to a common transmission medium (Industrial Ethernet).

Media Access Control (MAC)
Mechanisms for controlling access by a station to a common transmission medium shared with other stations.

RFC1006
see ISO-on-TCP

S5S5 connection
see ISO transport connection

Subnet mask
The subnet mask specifies which parts of an IP address are assigned to the network number. The bits in the IP address whose corresponding bits in the subnet mask have the value 1 are assigned to the network number.

Subnet number
A system consists of several subnets with unique subnet numbers.
TCP/IP
TCP = Transport Connection Protocol; IP = Internet Protocol

UDP

B.3 PROFInet

Component based Automation
Concept for implementing modular, distributed automation applications on the basis of open standards and data communication.
Component based Automation is an expansion of Totally Integrated Automation (TIA).

Device
In Component based Automation: part of the PROFInet component that contains the hardware-specific data of the PROFInet component. In SIMATIC iMap, a device is the software representation of the physical device for which the PROFInet component was created. It is displayed in the network view of SIMATIC iMap as an object with one or more bus attachments. The following distinction is made according to the communication functionality: → PROFInet devices and → PROFIBUS devices.

Interconnection
General: Logical data connection between two objects. In SIMATIC iMap:
Connection between two technological functions. An output is interconnected with an input of the same type. Interconnections are represented in SIMATIC iMap by lines.

Network view
View of the devices and the networks (Ethernet, PROFIBUS) in SIMATIC iMap.

Plant view
View of the technological functions of the automation system and its interconnections in SIMATIC iMap. One chart is displayed in the plant view.
**PROFIBUS device**
In Component based Automation: A PROFIBUS device has only one PROFIBUS attachment as a slave. It does not take part directly in PROFINet communication but is linked using a proxy PROFINet device.

**PROFINet**
Standard of the PROFIBUS Users organization defining a heterogeneous communications and engineering model.

**PROFINet device**
A device on Ethernet is a PROFINet device. A PROFINet device can also have a PROFIBUS attachment as master and proxy PROFINet device for PROFIBUS devices.

**PROFINet component**
Software representation of a technological module with defined functionality. An automation system is made up of several PROFINet components. A PROFINet component always includes a technological function and the corresponding device.

**PROFINet device, proxy**
A PROFINet device that has the role of the master for PROFIBUS devices. This allows PROFIBUS slaves to be included in PROFINet communication.

**SIMATIC IMap**
Engineering tool from Siemens for Component based Automation. Allows the configuration, commissioning, and monitoring of modular, distributed automation systems based on the PROFINet standard.

**SIMATIC iMap – STEP 7 AddOn**
Software for the SIMATIC IMap interface to STEP 7.
The FETCH and WRITE modes supported on ISO transport connections, TCP, and ISO-on-TCP connections can be used with any other device to access the S7 system memory areas.

To be able to use this type of access, for example for PC applications, you need to know the PDU structure of the jobs. The required S7 or S5 header for request and response frames are 16 bytes long and their structure is described in this chapter.
a) Structure of WRITE Frames

The meaning and values of parameters shown without values in the following table can be found in the section “Parameter Values”.

<table>
<thead>
<tr>
<th>WRITE request frame</th>
<th>WRITE acknowledgment frame</th>
</tr>
</thead>
<tbody>
<tr>
<td>0  System ID</td>
<td>0  System ID</td>
</tr>
<tr>
<td>=&quot;S&quot;</td>
<td>=&quot;S&quot;</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>=&quot;5&quot;</td>
<td>=&quot;5&quot;</td>
</tr>
<tr>
<td>2  Length of header</td>
<td>2  Length of header</td>
</tr>
<tr>
<td>=16d.</td>
<td>=16d.</td>
</tr>
<tr>
<td>3  ID OP code</td>
<td>3  ID OP code</td>
</tr>
<tr>
<td>=01</td>
<td>=01</td>
</tr>
<tr>
<td>4  Length OP code</td>
<td>4  Length OP code</td>
</tr>
<tr>
<td>=03</td>
<td>=03</td>
</tr>
<tr>
<td>5  OP code</td>
<td>5  OP code</td>
</tr>
<tr>
<td>=03</td>
<td>=04</td>
</tr>
<tr>
<td>6  ORG field</td>
<td>6  Ack field</td>
</tr>
<tr>
<td>=03</td>
<td>=0Fh</td>
</tr>
<tr>
<td>7  Length ORG field</td>
<td>7  Length ack field</td>
</tr>
<tr>
<td>=08</td>
<td>=03</td>
</tr>
<tr>
<td>8  ORG ID</td>
<td>8  Error field</td>
</tr>
<tr>
<td>9  DBNR</td>
<td>9  Empty field</td>
</tr>
<tr>
<td>A  Start address</td>
<td>A  Length empty field</td>
</tr>
<tr>
<td>High Byte</td>
<td>=07</td>
</tr>
<tr>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>Low Byte</td>
<td>Free</td>
</tr>
<tr>
<td>C  Length</td>
<td>C</td>
</tr>
<tr>
<td>High Byte</td>
<td>FFh.</td>
</tr>
<tr>
<td>D</td>
<td>D</td>
</tr>
<tr>
<td>Low Byte</td>
<td>F</td>
</tr>
<tr>
<td>E  Empty field</td>
<td>E</td>
</tr>
<tr>
<td>=FFh.</td>
<td>F</td>
</tr>
<tr>
<td>F  Length empty field</td>
<td>=02</td>
</tr>
</tbody>
</table>

Data up to 64 K
**a) Structure of FETCH Frames**

The meaning and values of parameters shown without values in the following table can be found in the section “Parameter Values“.

<table>
<thead>
<tr>
<th>FETCH request frame</th>
<th>FETCH response frame</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>System ID = “S”</td>
</tr>
<tr>
<td>1</td>
<td>“5”</td>
</tr>
<tr>
<td>2</td>
<td>Length of header = 16d.</td>
</tr>
<tr>
<td>3</td>
<td>ID OP code = 01</td>
</tr>
<tr>
<td>4</td>
<td>Length OP code = 03</td>
</tr>
<tr>
<td>5</td>
<td>OP code = 05</td>
</tr>
<tr>
<td>6</td>
<td>ORG field = 03</td>
</tr>
<tr>
<td>7</td>
<td>Length ORG field = 08</td>
</tr>
<tr>
<td>8</td>
<td>ORG ID</td>
</tr>
<tr>
<td>9</td>
<td>DBNR</td>
</tr>
<tr>
<td>A</td>
<td>Start address</td>
</tr>
<tr>
<td>B</td>
<td>High Byte</td>
</tr>
<tr>
<td>C</td>
<td>Length</td>
</tr>
<tr>
<td>D</td>
<td>High Byte</td>
</tr>
<tr>
<td>E</td>
<td>Empty field</td>
</tr>
<tr>
<td>F</td>
<td>Length empty field</td>
</tr>
<tr>
<td></td>
<td>= FFh.</td>
</tr>
<tr>
<td></td>
<td>= 02</td>
</tr>
</tbody>
</table>
### Parameter Values

<table>
<thead>
<tr>
<th>S7 Address Area</th>
<th>DB</th>
<th>M</th>
<th>I</th>
<th>Q</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ORG ID</strong></td>
<td>01&lt;sub&gt;H&lt;/sub&gt;</td>
<td>02&lt;sub&gt;H&lt;/sub&gt;</td>
<td>03&lt;sub&gt;H&lt;/sub&gt;</td>
<td>04&lt;sub&gt;H&lt;/sub&gt;</td>
</tr>
<tr>
<td></td>
<td>Source/dest. data from/to data block in main memory</td>
<td>Source/dest. data from/to flag area</td>
<td>Source/dest. data from/to process image of the inputs (PII)</td>
<td>Source/dest. data from/to process image of the outputs (PIQ)</td>
</tr>
<tr>
<td><strong>DBNR</strong></td>
<td>DB, from which the source data are taken or to which the dest data are transferred</td>
<td>irrelevant</td>
<td>irrelevant</td>
<td>irrelevant</td>
</tr>
<tr>
<td>permitted range</td>
<td>1...255</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Start address</strong></td>
<td>DW number, from which the data are taken or written to</td>
<td>Flag byte no., from which the data are taken or written to</td>
<td>Input byte no., from which the data are taken or written to</td>
<td>Output byte no., from which the data are taken or written to</td>
</tr>
<tr>
<td>permitted range</td>
<td>0...2047</td>
<td>0...255</td>
<td>0...127</td>
<td>0...127</td>
</tr>
<tr>
<td><strong>Length</strong></td>
<td>Length of the source/dest. data field in words</td>
<td>Length of the source/dest. data field in bytes</td>
<td>Length of the source/dest. data field in bytes</td>
<td>Length of the source/dest. data field in bytes</td>
</tr>
<tr>
<td>permitted range</td>
<td>1...2048</td>
<td>1...256</td>
<td>1...128</td>
<td>1...128</td>
</tr>
</tbody>
</table>
### S7 Address Area

<table>
<thead>
<tr>
<th>S7 Address Area</th>
<th>PI/PQ</th>
<th>C</th>
<th>T</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORG ID</td>
<td>05&lt;sub&gt;H&lt;/sub&gt;</td>
<td>06&lt;sub&gt;H&lt;/sub&gt;</td>
<td>07&lt;sub&gt;H&lt;/sub&gt;</td>
</tr>
<tr>
<td>data from/to</td>
<td>data from/to</td>
<td>data from/to</td>
<td>data from/to</td>
</tr>
<tr>
<td>in I/O modules.</td>
<td>in I/O modules.</td>
<td>in counter cells</td>
<td>in timer cells</td>
</tr>
<tr>
<td>With source</td>
<td>With source</td>
<td></td>
<td></td>
</tr>
<tr>
<td>data input</td>
<td>data input</td>
<td></td>
<td></td>
</tr>
<tr>
<td>modules, with</td>
<td>modules, with</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dest data</td>
<td>dest data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>output modules</td>
<td>output modules</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DBNR</td>
<td>irrelevant</td>
<td>irrelevant</td>
<td>irrelevant</td>
</tr>
<tr>
<td>I/O byte no.</td>
<td>Number of the</td>
<td>Number of the</td>
<td></td>
</tr>
<tr>
<td>permitted range</td>
<td>from which the</td>
<td>from which the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>data are taken</td>
<td>data are taken</td>
<td></td>
</tr>
<tr>
<td></td>
<td>or written to</td>
<td>or written to</td>
<td></td>
</tr>
<tr>
<td>Start address</td>
<td>I/O byte no.,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>from which the data</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>are taken</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>or written to</td>
<td></td>
<td></td>
</tr>
<tr>
<td>permitted range</td>
<td>0...127</td>
<td>0...255</td>
<td></td>
</tr>
<tr>
<td></td>
<td>digital I/Os</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>128...255</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>analog I/Os</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Length</td>
<td>Length of the</td>
<td>Length of the</td>
<td></td>
</tr>
<tr>
<td>permitted range</td>
<td>source/dest.</td>
<td>source/dest.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>data field in bytes</td>
<td>data field in</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>words (counter cell =</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 word)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Length of the</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>source/dest.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>data field in</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>words (counter cell =</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 word)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1...256</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>
Document History

This section provides an overview of the previous releases of this manual and the functional expansions in STEP 7 and NCM S7.

New in release 06 / STEP 7 V5.2

- S7 communication over routers (single-ended client and server functionality) via an IE/PB Link or CP.
- Multiprojects
  With the new multiproject functionality, projects can be split up and distributed for engineering and then merged again.

New in Release 05 / STEP 7 V5.1 SP3

- Configuring multicast and broadcast on UDP connections.
  See Chapter LEERER MERKER.
- The blocks AG_SEND and AG_RECV can now be used for "long data packets" with an S7–300. See Chapter 6
- The S7 CPs for Ind. Ethernet are now supplied with a default MAC address allowing configuration data to be downloaded over Ethernet without a “node initialization”.

New in Release 04 / up to STEP 7 V5.1 SP2

- The FETCH/WRITE mode is now supported on TCP connections. See Chapter 4.
- The FETCH/WRITE mode can be coordinated in the user program by the new FCs AG_LOCK and AG_UNLOCK. See Chapter 6
- NCM Diagnostics has a completely revised user interface. See Chapter 7.
  The description of NCM S7 Diagnostics has been restructured. While this manual provides you with an overview and checklists, the online help provides you with detailed information on the diagnostic events.
| A | Access coordination, 191 |
|   | CONF_DB, 198 |
|   | Address parameters |
|   | Broadcast, 136 |
|   | broadcast, 135 |
|   | unspecified ISO-on-TCP connection, 117 |
|   | unspecified TCP connection, 125 |
|   | unspecified UDP connection, 132 |
|   | AS-interface, 16 |
| B | Broadcast, with UDP, 133 |
| C | Communication options, 17 |
|   | Communication services, configuring, 68 |
|   | Configuration data, download to target system, 74 |
|   | Configuration data block, 146, 149 |
|   | Connection, properties, 91 |
|   | Connection configuration, 89 |
|   | Connection ID, 152 |
|   | range of values, 152 |
|   | Connection types, parameter fields for, 152 |
|   | CP address, 164 |
|   | CP configuration data, saving, 75 |
|   | Creating a subnet, 48 |
| D | CSMA/CD, 16 |
| E | DHCP server, 63 |
|   | Displaying network attachments, 55 |
|   | Downloading, 74 |
|   | Dynamic properties, 109 |
| F | E-mail connection, Parameter field for, 156 |
|   | Ethernet, overview, 16 |
|   | Ethernet CP, 57 |
|   | further CP properties, 57 |
|   | installing and starting, 58 |
|   | procedure, 47 |
|   | Firmware Loader, 225 |
|   | application, 226 |
|   | loading firmware, 227 |
|   | FTP connection, Parameter field for, 158 |
|   | Functions |
|   | AG-RECV, 78, 79 |
|   | AG-SEND, 78, 79 |
|   | Functions (FC), typical sequence, 80 |
|   | Functions (FCs) |
|   | AG_LOCK, 193 |
|   | AG_LOCK / AG_UNLOCK, 191 |
|   | AG_RECV / AG_LRECV, 184 |
|   | AG_SEND / AG_LSEND, 174 |
|   | AG_UNLOCK, 195 |
|   | Further functions, 99 |
| H | Hardware configuration, Ethernet CP, 51 |
| I | Industrial Ethernet, overview, 16 |
|   | Industrial Ethernet; user interface to, 25 |
IP access control list, 62
IP access protection, 62
IP address
  in the “Properties – Ethernet Interface” dialog, 63
  obtaining from a DHCP server, 63
  setting in the user program, 63
IP address assignment over DHCP, 97
IP configuration, 63
ISO transport connection, 103
  amount of data and number of connections, 91
  checking, 111
  connection without assignment, 100
  dynamic properties, 109
  printing configured connections, 99
  properties dialog, 103
  addresses, 107
  dynamics, 109
  general, 104
  overview, 111
  save connection, 99
Unspecified connection, 108
ISO-on-TCP connection
  addresses, 115
  checking, 118
  parameter field for, 155
  properties, 112
  specifying the connection partner, 113

J
Job header, 172

M
MAC address, 75
Multicast, with UDP, 133, 136
Multiproject, 33, 38
  configuring connections, 90, 96

N
NCM S7
  general information, 46
  installation, 46
NCM S7 Diagnostics, 61, 205
NCM S7 diagnostics, overview, 206
NCM S7 Diagnostics online path
  examples of an online path with gateway, 215
  Examples of an online path without gateway, 214
NCM S7 diagnostics online path, examples of an online path with "PC internal", 217
Network access, 16
New connection, 94, 95

O
Operator interface devices, 24, 25
Other station, 33, 96
  configuring, 65
  connecting a subnet, 66

P
PC internal, 217
PG communication
  in configured mode, 23
  in PG operation, 23
  with STEP 7 on PROFIBUS, 23
PG operation, with STEP 7 via Ethernet, 21
PG/PC interface, 25
PROFIBUS, 16
PROFIBUS; user interface to, 25
PROFINet communication, 17, 18
Programmed Communication Connections, 145
Programmed connections, 20
Project variant
  1 subnet – 1 project, 35
  1 subnet – more than 1 project, 38
  2 or more subnets – 1 project, 37
  several subnets – several projects, 41
  several subnets several projects, 43
SIMATIC S5 and non-SIMATIC devices, 36

R
Routing, 143

S
S7 communication on Ethernet, 17, 25
S7 communication relay, 17, 25
S7 functions, 17
SEND/RECEIVE interface, 17
  CPU cycle, 82
  data exchange, 78
  overview, 29
  user program, 79
SIMATIC NET, 16
Subfield types, 159
System data, parameter field for, 150
System memory, access using
  FETCH/WRITE, 141

T
TCP Connection, checking properties, 126
TCP connection, 119
  addresses, 123
  parameter field for, 153
  specifying the connection partner, 120
Type of communication, 17

U
UDP
  addresses, 130
  checking, 137
  configuring, 127
UDP connection
  parameter field for, 154
  specifying the connection partner, 128
Unspecified connection, 97
A&D Technical Support
Worldwide, available 24 hours a day:

<table>
<thead>
<tr>
<th>Worldwide (Nuernberg)</th>
<th>United States (Johnson City)</th>
<th>Asia / Australia (Beijing)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical Support</td>
<td>Technical Support and</td>
<td>Technical Support and</td>
</tr>
<tr>
<td>24 hours a day, 365</td>
<td>Authorization</td>
<td>Authorization</td>
</tr>
<tr>
<td>days a year</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phone: +49 (0) 180 5050-222</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fax: +49 (0) 180 5050-223</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E-Mail: <a href="mailto:adsupport@siemens.com">adsupport@siemens.com</a></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GMT: +1:00</td>
<td>Phone: +1 (0) 423 262 2522</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fax: +1 (0) 423 262 2289</td>
<td></td>
</tr>
<tr>
<td></td>
<td>E-Mail: <a href="mailto:simatic.hotline@sea.siemens.com">simatic.hotline@sea.siemens.com</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td>GMT: -5:00</td>
<td></td>
</tr>
<tr>
<td>Europe / Africa (Nuernberg)</td>
<td>Authorization</td>
<td>Asia / Australia (Beijing)</td>
</tr>
<tr>
<td>Local time: Mon.-Fri. 8:00 to 17:00</td>
<td></td>
<td>Technical Support and</td>
</tr>
<tr>
<td>Phone: +49 (0) 180 5050-222</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fax: +49 (0) 180 5050-223</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E-Mail: <a href="mailto:adsupport@siemens.com">adsupport@siemens.com</a></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GMT: +1:00</td>
<td>Phone: +86 10 64 75 75 75</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fax: +86 10 64 74 74 74</td>
<td></td>
</tr>
<tr>
<td></td>
<td>E-Mail: <a href="mailto:adsupport.asia@siemens.com">adsupport.asia@siemens.com</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td>GMT: +8:00</td>
<td></td>
</tr>
</tbody>
</table>

The languages of the SIMATIC Hotlines and the authorization hotline are generally German and English.
Service & Support on the Internet

In addition to our documentation, we offer our Know-how online on the internet at:
http://www.siemens.com/automation/service&support

where you will find the following:

- The newsletter, which constantly provides you with up-to-date information on your products.
- The right documents via our Search function in Service & Support.
- A forum, where users and experts from all over the world exchange their experiences.
- Your local representative for Automation & Drives via our representatives database.
- Information on field service, repairs, spare parts and more under "Services".